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Preface
Flix is a collaborative, visual story-development tool. It allows directors, editors, cinematographers,
storyboard artists, and pre-visualization artists to explore ideas quickly, saving valuable time, and to
easily collaborate on the visual story development of a film. Originally developed at Sony Pictures
Animation and Sony Pictures Imageworks, it has been used on projects that include Hotel
Transylvania, The Smurfs 2, and Cloudy with a Chance of Meatballs 2.

Key Features
Flix was designed from the ground up to be a collaborative tool. It introduces automatic organization,
easy access to the latest updates, and allows artists to work faster. It also links to many applications,
such as Photoshop, that artists use.

Key features within Flix include:

• Automation of many complex steps, removing the need to manually name panels or clean up and
manage files.

• Real-time interaction between director and artist to review or edit a sequence using Flix Connect.

• Wider product functionality that allows you to link to other programs, such as Nuke, Maya, Shotgun
and Photoshop.

• Dialogue management within Flix.

• Retrievable versioning for all changes made to a sequence, and version comparison that allows you
to review and track new or deleted panels within the sequence.

• Notification e-mails to Editorial teams for tracking recent changes.

• Custom scripts that provide metadata for each shot.

About this Guide
This guide provides you with the details of running and using Flix. The first part of the guide walks
you through the various Flix functions, before moving on to detailed workflows later in the guide.

Throughout the User Guide, we assume you have a basic knowledge of pre-visualization and
storyboarding, as well as proficiency with the operating system for which Flix is installed.
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Getting Help
Flix features several forms of help, in a variety of locations.

Viewing Tooltips
Most controls offer concise instructions in the form of tooltips. To display the tooltips, move your
mouse pointer over an interface control or a node parameter.

Help page
If you can’t find what you need in this Online Help, there are other sources of help available to you for
all aspects of Flix and its operation.

To access the different video tutorials and other online resources go to the Help page:

1. Click on the Flix Project Browser button.

The Project Browser dialog opens.

2. Click on the Help button.

The Help page displays. You can now access the different guides, video tutorials, and online
resources.

About Flix
To access the About Flix information, go to the Help page:

1. Click on the Flix Project Browser button.

The Project Browser dialog opens.

2. Click on the Help button.

The Help page displays the About Flix information.
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Contacting Customer Support
Should questions arise that the documentation fails to address, you can contact Customer Support
directly by e-mail at flix-support@thefoundry.co.uk or through the Support Portal at the following
address: https://supportportal.thefoundry.co.uk.

You can also contact the Customer Support team directly through Flix on the Help page. To send an
e-mail to Support, do the following:

1. Click on the Flix Project Browser button.

The Project Browser dialog opens.

2. Click on the Help button.

The Help page displays.

3. Click on Contact Support to send an e-mail.

The Support page displays.

4. Fill out the following fields:

• My Email - enter your e-mail address.

• Email CC - enter the address of who you want to Copy in.

• Summary - enter the subject of your e-mail.

• Description - enter a detailed description of the problem you encountered.

• Urgent - check the box if this is an urgent matter.

5. Click on Submit.

Your e-mail has been sent to flix-support@thefoundry.co.uk, and anyone you included in the CC
field.

NOTE: The logs are automatically sent along with your e-mail.

GETTING HELP | CONTACTING CUSTOMER SUPPORT
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System Requirements
Each operating system has its own system requirements for Flix. Additionally, there are system
requirements for the external software that Flix relies on for full functionality.

To check any of the system requirements, see:

• Windows

• Linux

• Mac OS X

• Other Software Requirements

Windows
The following are the system requirements for running Flix on Windows:

• Windows 7 64-bit or Windows 8 64-bit

• x86-64 processor, such as Intel Pentium 4 or AMD Athlon, with SSE3 instruction set support (or
newer)

• 5 GB disk space

• 8 GB RAM

• Display with 1280 x 1024 pixel resolution and 24-bit color

• Graphics card with at least 512 MB of video memory and driver support for OpenGL 2.0

Linux
The following are the system requirements for running Flix on Linux:

• Linux 64-bit (Fedora 12 or Red Hat Enterprise Linux 5.4)

• x86-64 processor, such as Intel Pentium 4 or AMD Athlon, with SSE3 instruction set support (or
newer)

• 5 GB disk space

• 8 GB RAM

• Display with 1280 x 1024 pixel resolution and 24-bit color

• Graphics card with at least 512 MB of video memory and driver support for OpenGL 2.0

12
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Mac OS X
The following are the system requirements for running Flix on Mac OS X:

• Mountain Lion 10.8, Mac OS X Mavericks 10.9, or Mac OS X Yosemite 10.10

• x86-64 processor, such as Intel Core 2 Duo or later

• 5 GB of disk space

• 8 GB of RAM

• Display with at least 1280 x 1024 pixel resolution and 24-bit color

• Graphics card with at least 512 MB of video memory and driver support for OpenGL 2.0

Other Software Requirements
If you choose to use Flix in conjunction with other programs, follow the system requirements below
for each application:

• The Foundry Nuke or NukeX System Requirements

• Adobe Photoshop CS6, and later or Creative Cloud System Requirements

• Final Cut Pro 7 System Requirements

• Autodesk Maya 2011-2014 System Requirements

• Chrome version 24.0 or Safari 6

NOTE: Chrome is the default browser for running Flix. On Mac OS X machines, Flix attempts
to launch using Chrome first. If Chrome is not installed, it launches with Safari instead.

NOTE: For more information on applications' dependencies, refer to Appendix D:
Application Dependencies.

SYSTEM REQUIREMENTS | MAC OS X
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Workspaces
This section is designed to help you learn how to use Flix’s interface.

Flix has three workspaces, the Edit Workspace, Dialogue Workspace, and Pitch Workspace. By
default, Flix opens in the Edit workspace.
Additionally, the Menu Bar and Status Bar along with the Viewer Controls, which all appear in both
the Edit and Dialogue workspaces, are covered in this section. You can manage file imports into your
sequences through the Panel Libraries. You can also use the Flix Options Context Menu to open Flix,
the Flix Editorial UI, and the Status page in new tabs. Customizing the Interface to suit your
preferences is an option as well.

Edit Workspace
The default Edit workspace allows you to edit your sequence with various tools.

The Edit workspace contains several toolbars, panes, and the Viewer:

14
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1. Menu bar - select your project, sequence, version, and branch (if applicable), send to Editorial,
save, and switch between workspaces. See Menu Bar

2. Workspace toolbar - select tools for editing panels in your selected sequence or send them to
other applications, such as Photoshop. You can also select the Maya tools and export your
sequence in different formats.

3. Sequence Editor pane - displays all the panels in a sequence, allowing you to move, edit, and
version them individually.

4. Viewer - displays a preview of the selected panel.

5. Viewer Controls pane - displays controls for editing and playing animated panels. See Viewer
Controls

6. Panel Libraries - displays imported libraries and allows you to filter which panels are visible in
the library.

7. Status bar - displays information and warning messages related to your project or selected
panels. You can access the Help section and open the Flix Project Browser as well. Through the
status bar, you can also install or update scripts. Toggling between the View and Editmodes, and
connecting to Flix channels are also accessible from the status bar. See Status Bar

The following controls are available on theWorkspace toolbar for the Edit workspace:

Control Action

Undo Undoes the last action. For more information about the
undo action, please see Managing Storyboard Panels.

Redo Redoes the last action. For more information about the
redo action, please see Managing Storyboard Panels.

New Panel Creates a new panel.

Add Marker Adds a new marker.

Delete Panel Deletes the selected panels.

Cut Panel Cuts the panel from the sequence and places it on the
clipboard.

Copy Panel Copies the panel from the sequence and places it on the
clipboard.

Paste Panel Pastes the cut or copied panel into the sequence directly
downstream of the selected panel.

WORKSPACES |
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Control Action

Duplicate Panel Duplicates the selected panel and places it directly
downstream.

Duplicating panels freezes all toolbar actions until the
duplicate or duplicates are created.

Version Up Versions up the selected panel(s), regardless of whether it
has been edited or not.

Animate Animate Panel Converts the selected panels to animated panels.

Split Split Panel Splits animated panels into two separate panels in the
sequence.

Create PDF of
Sequence

Creates a .pdf file of the sequence with snapshots of all the
panels and associated dialogue. Panels are tagged with a
New icon if they haven't been published since the last
saved version. When the PDF is created, a preview also
opens in a new web browser tab.

NOTE: The PDF button is dynamic and the
number on the button changes to show which
PDF setting is being used. Click the button until
the list of PDF settings appears in a dropdown
menu and select the setting you want. See
Creating Sequence PDF Files

Search bar Searches for panel IDs or partial panel IDs and highlights
panels that fit the search parameters, one at a time. To
cycle through all search results, press Enter.

Play QuickTime Plays QuickTime movies received from Editorial. If the
sequence has changed since the QuickTime file was
updated, you can choose to play the movie from the last
version or cancel the action.

Compare Edit Compares the sequence to that of any version and marks
panels that have been added or deleted.

WORKSPACES |
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Control Action

Add Note Adds a note to the selected panels and highlights the
selected panels in orange to indicate that they have notes
on them.

Shift+click the button to open the panel in Photoshop and
add a note to it directly in Photoshop.

Resize Panels Resizes the panels. Dragging the slider to the left makes
the panels smaller, while dragging it to the right makes
them larger.

Editing Plug-In Group

Control Action

Select a plug-in
from the Editing
Plug-in Group.

• Clicking or double-clicking on a single panel sends
the selected panel to Photoshop for editing.

• Photoshop (Layer Comps) sends multiple selected
panels to Photoshop as layer comps.

• Photoshop (Timeline) sends multiple selected panels
to Photoshop in the timeline.

• StoryBoard Pro - Opens the StoryBoard Pro project
the selected panel(s) originally came from.

• TVPaint - Sends the selected panel to TVPaint
Animation for editing.

• Original Files - Opens the selected panel in a file
browser on your machine.

• Split PSD Layers to Clips - Exports selected panel(s)
as layered PSD(s) to a Premiere .xml file.

• Maya Data - Sends the Maya transform attributes
metadata of the selected panels to Maya for editing.

NOTE: Click the Editing plug-in Group button until
the list of plug-ins appears in a dropdown menu
and select the plug-in you want.

WORKSPACES |
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Maya Plug-In Group

Control Action

Select a plug-in
from the Maya
Plug-in Group.

Sets whether you want to export the sequence using any of
the following plug-ins:

• Maya Sequencer

• Maya Sequencer Imageless

• Maya Data Only

• Maya Shots

NOTE: Click the Maya plug-in Group button until
the list of plug-ins appears in a dropdown menu
and select the plug-in you want.

Export Plug-In Group

WORKSPACES |
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Control Action

Select a plug-in
from the Export
Plug-in Group.

• Export Dialogue - Exports dialogue to a specified
location.

• Export Audio - Exports audio to a specified location.

• Export JPGs - Export panels as .jpg files to a specified
location.

• Export PSDs - Export panels as .psd files to a
specified location.

• Export to CSV - Exports the whole sequence as a .csv
file to a specified location.

• Shotgun Import - Imports shots from Shotgun into
your sequence.

• To Movie - Exports the whole sequence as a .mov file
(QuickTime).

• Refresh Images - re-create the image if you
encounter a problem with your panel.

• Open in Nuke - Opens a selected panel in Nuke.

NOTE: Click the Export plug-in Group button until
the list of plug-ins appears in a dropdown menu
and select the plug-in you want.

DialogueWorkspace
The Dialogue workspace is primarily for adding dialogue to panels in sequential order when only a
thumbnail is needed for reference. Unlike adding dialogue to panels while in Edit workspace, this
workspace allows you to add dialogue in a manuscript-like manner.

The Dialogue workspace contains several toolbars, panes, and the Viewer:

WORKSPACES | DIALOGUE WORKSPACE
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1. Menu bar - select your project, sequence, version, and branch (if applicable), send to Editorial,
save, and switch between workspaces. See Menu Bar

2. Workspace toolbar - resize the panel thumbnails.

3. Sequence Editor pane - displays all the panel thumbnails in a list format with dialogue entry
boxes.

4. Viewer - displays a preview of the selected panel.

5. Viewer Controls pane - displays controls for editing and playing panels and animated panels.
See Viewer Controls

6. Status bar - displays information and warning messages related to your project or selected
panels. You can access the Help section and open the Flix Project Browser as well. Through the
status bar, you can also install or update scripts. Toggling between the View and Editmodes, and
connecting to Flix channels are also accessible from the status bar. See Status Bar

The following controls are available on theWorkspace toolbar for the Dialogue workspace:

Control Action

Resizes the panels. Dragging the slider to the left makes the panels smaller, while
dragging it to the right makes them larger.

WORKSPACES | DIALOGUE WORKSPACE
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Pitch Workspace
The Pitch workspace is the final workspace mode on the menu bar.

Switching to the Pitch workspace automatically displays Flix as a full screen Viewer that allows you
to use hotkeys to step through or play the sequence, including any dialogue and audio tracks that
may be included. You can also edit the duration of each panel of the sequence by recording a new
duration manually while you pitch the sequence. For a full list of Pitch mode hotkeys, please refer to
Appendix A: Keyboard Shortcuts.

The Pitch workspace contains two toolbars and the Pitch full screen Viewer:

• Workspace toolbar - click on the buttons to navigate through the sequence, exit the Pitch full
screen Viewer, and record new panel duration with or without audio.

• Timer Mode bar - displays the panel index, the panel ID, as well as the Time and Duration timers.

• Pitch full screen Viewer - displays all the panels in a sequence.

WORKSPACES | PITCH WORKSPACE
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The following controls are available for the Pitch workspace:

Control Action

Plays from the current panel through to the end of the sequence.

Pauses the sequence playback.

Moves forward one panel.

Moves backward one panel.

Jumps to the first panel in the sequence.

Jumps to the last panel in the sequence.

Exits the full screen mode.

The following controls are available for the Pitch workspace when the Timer Mode is active:

Control Action

Activates the Timer mode.

Deactivates the Timer mode.

Starts panel duration recording.

Stops panel duration recording.

Selects a microphone to record panel duration with audio. (The button is white in
the UI. For the purposes of this guide, white icons appear gray.)

Indicates that a microphone is selected.

Indicates that there is no microphone on your machine.

WORKSPACES | PITCH WORKSPACE



23

Control Action

Enables the audio playback while recording panel duration. (The button is white in
the UI. For the purposes of this guide, white icons appear gray.)

The audio playback is enabled.

Indicates that there is no audio in the sequence.

NOTE: The toolbar disappears if you don't move the pointer around. To have the toolbar
displayed at all times, leave the pointer on the toolbar.

Menu Bar
The menu bar, which appears in both the Edit and Dialogue workspaces, includes these controls:

Control Action

Select the project, sequence, version, and branch (if applicable) from the Project
Browser dialog that appears.

The Flix Project Browser button updates to display the current sequence and
version number as the button name when a sequence is loaded into Flix.

Saves changes as a new entry in the version dropdown menu.

Enter comments in the entry box when saving edits made to a sequence.

WORKSPACES | MENU BAR
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Control Action

The Editorial Plug-in Group is used to send the current version of the sequence to
Editorial using any of the following plug-ins:

• Avid

• Premiere/FCP7 (Final Cut Pro 7)

• Split PSD Layers to Clips

• StoryBoard Pro

• Nuke Studio

• SG - Shotgun Publish

NOTE: Click the Editorial plug-in Group button until the list of plug-ins
appears in a dropdown menu and select the plug-in you want.

Edit Switches to the Edit workspace.

Dialogue Switches to the Dialogue workspace.

Pitch Switches to the Pitch workspace.

Viewer Controls
The Viewer Controls pane is accessible from every workspace except for Pitch and allows you to
adjust the Viewer options for animated panels, play the sequence, mask the Viewer, and to use the
Draw tools.

WORKSPACES | VIEWER CONTROLS
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NOTE: The Animation Player controls only display when an animated panel is selected in
your sequence.

NOTE: The Audio Cue controls are hidden during playback and when the sequence doesn't
contain audio.

Control Action

Duration Adjusts the duration of the selected panel.

Dialogue Toggles whether or not the dialogue is displayed in the Viewer.

Mask Toggles whether or not a mask is displayed in the Viewer.

Draw Toggles whether or not the Draw tools are displayed in the Viewer.

Toggle this to add, edit, delete , or view notes already added to the panel.

Brings up a slider to adjust the sound level when hovering over the button.
Clicking on the button mutes audio. To unmute the audio, click on the button
again.

Shot Label Displays the name of the selected shot. You can rename shots, see Shots

NOTE: This option only appears when you have shots in your sequence.

Sequence Player controls

Preload Preloads the panels that you want to play in the Viewer so that the sequence
doesn’t pause during playback to buffer. It also loads all panels in a sequence so
that scrolling through them in the Sequence Editor pane doesn’t require waiting
for them all to load individually.

Plays the sequence in the Viewer, starting from the selected panel. This includes
the dialogue and any audio accompanying the sequence.

Displays where in the sequence the Viewer is paused. Scrubbing the slider selects
the panel in the Sequence Editor pane, updates the Viewer, and displays the
new frame number.

Displays the frame number of the selected panel. If the sequence has been
paused while it was playing through the sequence, it displays the frame number
in the sequence where it was paused.

WORKSPACES | VIEWER CONTROLS
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Control Action

Audio Cue controls

Mutes the audio of the selected panel(s) by setting the Audio Cue point to -1.

Modify the audio offset (start point) for a single panel in the Sequence Editor
pane. Scrubbing the slider also changes the frame number in the associated entry
box.

Alters the audio cue by typing a value or using the up and down arrow to step the
value up or down. The value -2 indicates no cue and the value -1mutes the audio.

Clicking the Mute button also sets the value to -1.

Animation Player controls

Speed Adjusts the speed the selected animated panel runs at when playing the entire
sequence.
The default speed set by Editorial is 1.0.

Alters the mark In and Out points by typing a value or using the up and down
arrows to step the value up or down.
The In and Out points set which section of the selected animated panel to play in
the Viewer.

Alters the mark In and Out points by dragging the In and Out point arrows.

Preload Preloads the selected animated panel that you want to play in the Viewer, so that
it doesn’t pause during playback to buffer.

Plays the selected animated panel in the Viewer.
This includes the dialogue and any audio accompanying the animated panel.

Displays where in the animated panel the Viewer is paused.
Scrubbing the slider selects the frame, updates the Viewer, and displays the new
frame number.

Specifies where the animated panel should be split. See Splitting Storyboard
Panels.

WORKSPACES | VIEWER CONTROLS
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Panel Libraries
The Panel Libraries pane is located on the right-hand side of Flix, directly beneath the Viewer
Controls pane. In addition to the thumbnails contained in the library, it also consists of an Import
button (see Importing and Exporting), libraries Display, and a search bar. You can also resize the
thumbnails, so you can control how many can be seen at any given time.

The thumbnails are organized in the Panel Libraries according to their ID numbers, and not based
on their order in the sequence. You cannot re-order the thumbnails manually, however, you can
select which are seen in the Panel Libraries by selecting one of the options in the Display dropdown:

• AllLoaded,

NOTE: The All Loaded option doesn't necessarily display all the panels in the sequence.
Unless you view the relevant libraries (a, m, p, ref, rlo, s, and so on) first, there may not be
any panels visible in All Loaded. Only those libraries that have been viewed in the current
session are displayed.

• None,

• a (animated),

• m (master),

• p (panel),

• ref (reference),

WORKSPACES | PANEL LIBRARIES
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• rlo (rough layout), and

• s (staging).

Status Bar
The status bar, which appears in both the Edit and Dialogue workspaces at the bottom of the
interface, includes the following:

Control Action

Server Status Shows whether the server is running or not.

Install/Update
scripts

Updates or installs Photoshop, Maya, and TVPaint scripts,
installs the Flix executable launchers and updates the local
Flix version to the master location version.

• Install Photoshop scripts

• Install TVPaint scripts

• Install Maya scripts

• Install Flix Launchers

• Update the current Flix version

NOTE: The Update the current Flix version
plug-in is only relevant to remote users and
studios.

Resync service Shows whether Flix is busy syncing files over to the master
studio locations, remote studio locations, and remote user
locations.

Connect Users Allows other users to join a channel to view your sequence
in real-time and make notes on panels.

View Mode Toggles View and Editmodes. View is primarily used for
reviewing sequences.

WORKSPACES | STATUS BAR
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Control Action

Help Opens the Flix Project Browser from where you can access
the Help section to find Flix guides, video tutorials, online
resources, and About Flix information.

You can also directly contact support from the Help
section.

A loading progress message is also displayed on the status bar. For instance, when switching between
workspaces, the message Processing is shown.

In the center of the status bar, information is provided about all the panels in your sequence. This
includes the total number of panels and frames in the sequence, and the panel ID of the panel that's
currently selected. In the case where multiple panels are selected, the number of panels selected is
displayed instead of the panel ID.

Flix Options Context Menu
If the Flix launchers are installed on your machine, you have access to the Flix Options context menu
either from the task or menu bar depending on the platform you're using. To display the menu
options, click on the Flix Options context menu button.

This menu contains the following options:

Control Action

New Flix Tab Opens Flix in a new tab.

New Editorial Tab Opens Flix Editorial UI in a new tab.

Status Opens the Status page to find out which services
are running and which services might be down.

Quit Shuts down the Flix service.
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Customizing the Interface
There are parts of the interface that can be resized to improve viewing and usability. Some of these
components are described below.

Resizing your Workspace

Panes, including the Viewer, can be resized by dragging on the splitter bars. Additionally, you can
double-click on any of the pane's dividers to maximize, minimize, or reset the pane. Double-click
once to maximize the pane, double-click a second time to minimize it, and double-click a third time
to reset the pane back to its default position and size.

Resizing Panels

You can resize panels in the Viewer by dragging the slider on theWorkspace toolbar. Dragging the
slider to the left makes the panels smaller, so that more can be fit in the Sequence Editor pane
without needing to scroll down through the sequence. Dragging the slider to the right makes the
panels larger. Resizing panels can be done in every workspace except Pitch.

NOTE: If Flix has been resized so that not all of the icons in theWorkspace toolbar can fit
across the top of the Sequence Editor pane, then the toolbar is moved to a vertical location
along the left-hand side of the Sequence Editor.

Interchanging Panel ID and Panel Index

You can swap between panel IDs and panel indices depending on your preference when reviewing
shots. To do so, in the Edit workspace, right-click and select Swap Panel Labels from the dropdown
menu.
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Panel ID focus Panel index
focus

Choosing Panel Indices Display

You can choose whether to display panel indices based on their position in the sequence or their
position in the shots.

NOTE: By default, panels indices are displayed based on their position in the sequence.

To display panel indices as per their position in the shots, in the Edit workspace, right-click and select
Turn Panel Index based on Markers On. The panel indices are displayed as per their position in the
shots.
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Managing Projects
This section guides you through the management steps for Flix projects such as Logging In and
Logging Out of Flix, Loading Projects, Managing Projects and Sequences, and Versioning Your Work.

You can open or edit any project or sequence that has already been set up by your Flix administrators
or project leads, providing that you have the correct permissions to view and edit these projects.
Projects can be shows or episodic shows depending on the format you are using.

Logging In
To log in Flix, do the following:

1. Launch Flix.

The login page displays.

2. Enter your username and password.

3. Click on Login or press Enter.
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 After successful authentication, you are logged in Flix. The Project Browser dialog opens and
displays the projects you've been assigned to.

Loading Projects
You can load shows or episodic shows, sequences, and versions, as well as changing branch.

TIP: While you're navigating in the Project Browser dialog, you can go back to a previous
selection at any time by clicking on the project name in the top-left corner of the Project
Browser.

Loading a Show

After you've logged in to Flix, the Project Browser dialog opens. To open a show, follow the steps
below:

Click on a show from the list, or search for a show by typing the name in the search bar.
After you've clicked on a show, the dialog updates to show you the available sequences for that show.
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Loading a Sequence
1. Open the Project Browser and select a show, or search for a show by typing the name in the

search bar.

After you've clicked on a show, the dialog updates to show you the available sequences for that
show.

2. Click on a sequence from the list, or search for a sequence by typing the name in the search bar.
Alternatively, Ctrl/Cmd+click two or more sequences and click Merge Latest Edits to combine
them into a single sequence.

If you click on a sequence, the dialog updates to show you the available versions for the sequence
and any branches, if applicable.
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If you click onMerge Latest Edits, the dialog updates to show you the available versions. Select a
version from the list to continue.

Changing Branch

Flix allows you to organize the areas of your project into branches, for instance an editorial branch
can be separate to your artist's main branch. To change branch:

1. Open the Project Browser and select a show and then a sequence.

The dialog updates to show you the available versions for the sequence and any branches, if
applicable.
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2. If you are working on a specific branch, click on the Branch dropdown menu and select one from
the list before selecting a version.
By default, if there are multiple branches, the main branch is always selected first.

NOTE: All previous versions are stored in the version list, in chronological order, with the
current version at the top of the list. The version number, modifier’s name, date, and time
are included in the list in the following format:
v1[modifier name][date saved][time saved][comment]

Loading a Version
1. Open the Project Browser and select a show and then a sequence.

The dialog updates to show you the available versions for the sequence and any branches, if
applicable.

2. Select a version of the sequence, by either:

• clicking on the version in the version list to automatically load that version,

• clicking on the Load Latest Version button to load whichever version is the latest, regardless of
user, or by

• clicking on Start A Clean Version button to create a new version and open it for editing.

Versions displayed in white belong to the current user. Versions displayed in orange belong to
Editorial. All other colors belong to unique users, and are assigned a color from the bottom of the
list to the top, to prevent user color from changing from version to version.
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Where a P is listed after the comments it means the edit has been published to Editorial. When a
Q is listed after the comments it means the edit comes from Editorial and therefore has a
QuickTime movie. You can click on Q to open the movie directly in QuickTime Player.

3. After you've selected a version, or clicked on either of the version buttons in the Project Browser
dialog, that version of the sequence is loaded into Flix.

WARNING: Versions cannot be deleted from this menu by users. If a version appears to be
missing, please check that it was not removed by your Flix administrators.

Loading Episodic Shows, Episodes, Sequences, and Versions

NOTE: To manage episodes within Flix, you have to create an episodic show type
beforehand. Please refer to the Flix Technical Guide, in the Setting Parameters chapter.

After you've logged in Flix, the Project Browser dialog opens. To open an episodic show, episode,
sequence, and version, follow the steps below:

1. Click on an episodic show from the list, or search for an episodic show by typing the name in the
search bar.

When you click on an episodic show, the dialog updates to show you the available episodes for
that episodic show.
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If you click on New Episodes, the dialog updates to show you an empty episode name space.
Type the name of the episode into the space provided and click Create Episode. If you want to
create multiple episodes at once, type the name of each new episode on separate lines, pressing
Enter to create new lines.

NOTE: You can use up to 10 alphanumeric characters to name episodes.

2. Click on an episode from the list, or search for an episode by typing the name in the search bar.

When you click on an episode, the dialog updates to show you the available sequences for that
episode.

3. To continue with the sequences, versions, merged edits, follow the steps described in Loading a
Sequence, Changing Branch, and Loading a Version.

Managing Projects and Sequences
You can create shows or episodic shows, sequences, branches, and versions, as well as changing the
sequence details.

TIP: While you're navigating in the Project Browser dialog, you can go back to a previous
selection at any time by clicking on the project name in the top-left corner of the Project
Browser.
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Creating a Show

To create a new show, do the following:

NOTE: You need a Flix license for any show you intend to create. Refer to the Flix Technical
Guide in the Installation and Licensing chapter for more information.

1. Open the Project Browser and click on New Show.

The dialog updates to show you the show details you need to provide.

2. Type the name of the show, as it appears on the Flix license, into the field provided.

NOTE: Show names are case-sensitive and can contain up to 10 alphanumeric characters
and underscores (_).

3. Select an aspect ratio from the list.

4. Specify if your show is episodic by enabling the Episodic show box.

5. Select the Frame rate.

6. Click Create Show.

The show is created and displays in the Project Browser. If the show does not display, it means
you don't have a license for that show.

Creating a Sequence

To create a new sequence without any existing panels, do the following:

1. Open the Project Browser and select a show, or search for a show by typing the name in the
search bar.

After you've clicked on a show, the dialog updates to show you the available sequences for that
show.

2. Click on New Sequences.

The dialog updates to show you an empty sequence name space.

3. Type the name of the sequence into the space provided and click Create Sequence.
If you want to create multiple sequences at once, type the name of each new sequence on
separate lines, pressing Enter to create new lines.
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Editing Sequence Details

You can edit the sequence details to choose the display order in the Flix Project Browser. To edit the
sequence details, follow the steps below:

1. Open the Project Browser and select a show, or search for a show by typing the name in the
search bar.
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After you've clicked on a show, the dialog updates to show you the available sequences for that
show.

2. Click Edit details, then change the Tracking index, the Act number, or the Description of the
sequence.

• If you want the Act # to appear in the Project Browser, set the Act # between 1 and 3.
When the Act # is set to 1, the sequence details are displayed at the top in the Project Browser.
When the Act # is set to 2, the sequence details are displayed below the sequence details whose
ACT # is set to 1. When the Act # is set to 3, the sequence details are displayed below the
sequence details whose ACT # is set to 2.

For instance, if you set the Act # to 1, the flx sequence details appear as show below:

• By default, the Act # is set to 9. The Act # detail does not appear and the sequence appears at
the end of the list in the Flix Project Browser.

• To hide a sequence, set the Act # detail of the required sequence to 0.

NOTE: The Act # detail does not appear when the Act is set to 4,5,6,7,8, or 9. But they are
sorted accordingly, 4 showing before 5, 6 showing before 7, and so on.
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3. To apply the changes, click Save details.

To undo the changes you've just made, either click the undo button or press Ctrl/Cmd+Z.

NOTE: The undo button appears for each sequence you've modified.

Creating a Branch

To create a new branch, do the following:

1. Open the Project Browser and select a show and then a sequence.

The dialog updates to show you the available versions for the sequence and any branches, if
applicable.
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2. Click on the + button.

The dialog updates to show you an empty branch name space.

3. Type the name of the branch into the space provided and click Create Branch.
If you want to create multiple branches at once, type the name of each new branch on separate
lines, pressing Enter to create new lines.

NOTE: You can use up to 10 alphanumeric characters to name branches.
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Editing Comments of a Sequence Version

To edit sequence version comments, follow the steps below:

1. Open the Project Browser and select a show and a sequence.

After you've clicked on a sequence, the dialog updates to show you the available versions and the
comments for that show.

2. Click on Edit Comments.

3. Edit the required comments and click Save Comments.

NOTE: These comments should be kept as short as possible as there is not as much space to
display them in the Version dropdown menu. There is a limit of 50 characters.

Logging Out
To log out of Flix, do the following:

1. Click on the Flix Project Browser button.

The Project Browser dialog opens.

2. Click on the Logout: [username] button.

You are logged out of Flix.
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Managing Storyboard Panels
In this chapter, the focus is primarily on the editing tools that can be found within the Edit workspace.

There are several ways to edit panels in Flix. You can opt to simply re-order the panels within a
sequence, draw notes on the panels, or round-trip files between Flix and other applications, such as
Photoshop, Maya, and so on. Panel editing happens in the Edit workspace.

NOTE: Any action that changes the state of a sequence causes Flix to autosave your work,
unless a previous action caused an autosave in the last 5 minutes. Flix keeps track of up to
10 autosave snapshots, after which the oldest is overwritten by the next autosave.

Creating Storyboard Panels
The simplest way to create a new panel is to click on the New button on theWorkspace toolbar. This
creates a blank panel that you can edit in Photoshop and update or version in Flix. However, you can
also import files into a Flix sequence from another program, or import existing panels from other
Flix projects or sequences to create new panels in your sequence.

Deleting Storyboard Panels
At any time, you can delete panels from your sequence. Unless the panel is locked for editing,
deleting a panel removes it from your version of the sequence and notifies Editorial of the deletion
when sending changes.

To delete a panel, do the following:

Select a panel and click on the Delete button or right-click on a panel and select Delete from the
dropdown menu.

NOTE: Deleting a panel only removes it from the current edit. You can still access the
deleted panel from the Libraries.
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NOTE: If you want to temporarily remove the panel from your sequence, you can also cut
the panel and paste it back into the sequence at a later point, so long as you haven’t cleared
the clipboard.

Splitting Storyboard Panels
If you have animated panels in the Sequence Editor pane, you can split them by doing the following:

1. In the Viewer Controls pane, scrub the slider to select the frame where you want the animated
panel to be split.

2. In the Edit Workspace, on theWorkspace toolbar, click on the Split button.

The animated panel is split into two animated panels.

First animated panel containing
frames 1 to 16.

Second animated panel containing
frames 17 to 39.

NOTE: A yellow triangle tag appears in the upper right-hand corner of both animated panels
as they share the same panel ID.

Duplicating Storyboard Panels
Duplicating a panel creates a copy of the panel that isn’t instanced. This ensures that the duplicate
panel is completely separate from the original, and any changes made to the original don’t affect the
duplicate. Click Duplicate on theWorkspace toolbar to insert a copy directly downstream from the
original panel.
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NOTE: Duplicating panels freezes all toolbar actions until the duplicate or duplicates are
created.

Locating Original Files on Your Machine
You can also locate the source file in a browser on your machine by right-clicking on a panel and
selecting Reveal Original in Finder (Reveal Original in File Browser in Windows and Linux) from
the dropdown menu. You can also open the selected panel in a file browser by clicking on the
Original Files button on theWorkspace toolbar, in the Edit workspace. This is particularly useful
if, for any reason, a panel has several amendments and you want to bring the original back into the
sequence without creating a new version of the panel.

NOTE: The Editing Plug-in Group button is dynamic. If the button isn't set to the correct
plug-in option, it might appear on theWorkspace toolbar, in the Edit workspace, as
Photoshop button. To change it, click the button until the list of plug-ins appears in a
dropdown menu and select the Original Files plug-in.

Creating Dialogue
You can add dialogue to panels in either the Edit or Dialogue workspaces. For more information
about how to add, edit, or delete dialogue in either of these views, please see Managing Dialogue.

Instancing Storyboard Panels
Instancing panels is very similar to creating duplicates, but instead of simply copying the selected
panels, the duplicates are linked to the originals. Any changes to the dialogue or notes of a panel
affects all the linked panels and you can instance as many as you want. Changes made in Photoshop
or another program creates a new version of the panel. You can instance panels with the Copy and
Paste buttons and shortcuts.

Undoing and Redoing Actions
Editorial and dialogue actions you commit in Flix, such as removing a panel from a sequence or
editing the dialogue associated with a panel, can be undone by clicking the Undo button.

TIP: You can also use Ctrl/Cmd+Z to undo actions on supported browsers.
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If you've undone an action and then decide you want to put it back the way it was, click the Redo
button to quickly reinstate the change. Both of these icons can be found on theWorkspace toolbar
in the Edit workspace.

Adding and Removing Panels
Follow the steps below to add panels to or remove panels from Flix:

1. Add a new panel to a sequence in Flix by either:

• Clicking the New button on theWorkspace toolbar, or

• Dragging a panel (a, m, p, ref, rlo, s, and so on) from the Panel Libraries pane.

Alternatively, you can hover your cursor over the upper-left corner of the Panel Libraries panels
when the display is set to a, p, or All Loaded. Hovering over this location brings up a + button.
Click this to add an existing panel from the library to the Sequence Editor.

NOTE: To add multiple panels to a sequence from the Panel Libraries pane, Shift + select
the panels you want to add and click on the + button.

2. If you created a new, blank panel, it’s inserted into the sequence downstream of the selected
panel in the Sequence Editor pane.

The blank panel is displayed in both the Sequence Editor pane and in the Panel Libraries. Any
changes made to the panel refreshes the thumbnail in both locations.

Below the panel, there are two different numbers, one is the panel ID and the other one is the
panel index.

TIP: You can swap between panel IDs and panel indices. To do so, in the Edit workspace,
right-click and select Swap Panel Labels from the dropdown menu.
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You can overwrite blank panels by either replacing them with other panels or by exporting them
out to another application to edit before reimporting them. For more information on exporting
panels to other applications, see Importing and Exporting.

3. If you added a panel from the Panel Libraries, you can reorder the panels within the sequence,
edit it in Flix or another application, or drag the panel over another blank panel to replace it.

4. Delete panels from your sequence by selecting the panels that you want to delete and either:

• clicking the Delete button, or

• pressing Delete on your keyboard, or

• right-clicking on a panel and selecting Delete from the list.

Rearranging Sequences
Panels do not have to be fixed in place in the Viewer. If you want to rearrange panels to change how
a scene is laid out, there are a few ways to do this:

Drag-and-Drop
1. Select the panel and drag it to a new location in the Sequence Editor pane.

A yellow line appears between the panels where the selected panel is to be inserted.

2. Drop the panel. It now appears in its new place.
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Keyboard

If you want to move only a single selected panel within the sequence, press Alt+arrow to move the
panel in the direction of the arrow you pressed. You can only move one panel at a time with this
method.

Cut, Copy, and Paste
1. Select the target panel(s) and either:

• Click the Cut button, or

• Press Ctrl/Cmd+X on your keyboard.

Or, select the panel(s) that you want to copy and either:

• Click the Copy button, or

• Press Ctrl/Cmd+C on your keyboard.

NOTE: Copying and pasting a panel into the sequence also instances it to the original. If you
don’t want to instance the panel, consider duplicating it instead. For more information on
instanced panels, please see Instancing Panels

2. Select the panel upstream of where you want to insert the cut panel and either:

• Click the Paste button, or

• Press Ctrl/Cmd+V on your keyboard.

NOTE: Selecting multiple panels in a specific order before you cut or copy them allows you
to paste them in the order they were selected instead of in the order they are in the
sequence.

NOTE: You can also right-click on one or several panels and select Cut, Copy, Paste, Delete,
and Select All from the dropdown menu.

Instancing Panels
Follow the steps below to instance panels within Flix:

1. Select the panel you want to instance and copy it by either:

• Clicking the Copy button, or

• Pressing Ctrl/Cmd+C on your keyboard.

2. Select the location in the sequence where you want to paste the panel and paste it by either:
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• Clicking on the Paste button, or

• Pressing Ctrl/Cmd+V on your keyboard.

Instanced panels are indicated by a yellow triangle tag in the upper right-hand corner of the panel.
Hovering your mouse over the tag displays which panel indices are instanced.

To instance panels by replacing one panel with another:

1. Drag a panel over another in the Sequence Editor pane.

When the mouse is in the correct position to drop and replace the panel, a yellow circle appears
around the cursor.

2. Drop the panel on the one beneath it.
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Dropping a panel onto another preserves the original panel but replaces the one underneath the
drop. This creates an instance to the original panel.

NOTE: Editing an instanced panel does not version up the other instances of that panel.

Uninstancing Panels

To uninstance a panel without losing all the changes you’ve made, duplicate either panel and cut or
delete the original from the sequence. Alternatively, if you are making changes to the panel within
Photoshop, the link is automatically broken.

Editing Existing Panels
To replace the image of an existing panel without adjusting the timing, dialogue, or duration:

1. Open Flix and select the panel you want to replace.

2. Open Photoshop and navigate to File > Automate > Flix New Template [aspect ratio].

The numbers represent the aspect ratio of each template. For example, the template 177 is
equivalent to an aspect ratio of 1.77.

A blank template opens. Create the new panel, as you want it to appear in Flix.

3. When you are finished drawing the new panel, navigate to File > Automate > Flix Replace
Current Image.

The panel is sent to Flix and versions up the existing panel, maintaining all the dialogue and
timing of the original.

You can also create a master file to replace an existing panel. The master file preserves elements of a
panel, such as layers, groups, or layer comps. Sending master files to Flix is useful for sharing master
files with the Editorial department or other artists. To create a master file from an existing panel:

1. Open Flix and select the panel you want to update with the master file.

2. Export the panel to Photoshop using one of the methods described in Flix to Photoshop.

3. In Photoshop, navigate to File > Automate > Flix Master Image.

The current project in Photoshop is used to create the master file and is imported into Flix
libraries.

If you select the Flix Master Image option a second time, Flix versions up the master file and
import it in the Panel Libraries.

4. From the Panel Libraries, import the master file in your sequence to replace the existing panel.
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NOTE: You can change the panel selection in the current sequence through Photoshop
without having to go to Flix. To select another panel before sending the new panel to Flix,
click on Flix Select Next or Flix Select Previous in Photoshop.

NOTE: For more information on how to re-import changes into Flix from Photoshop, see
Photoshop to Flix.

Editing in Photoshop andMaya

If you want to make changes to your panels, or to the panel metadata, you can export the selected
panels straight into Photoshop or Maya. So long as you have a copy of the application on the machine
you are using or on the network you are connected to, when you export the panels, they open within
the application automatically. Changes can then be imported back into Flix as subsequent versions.

NOTE: For more information on how to export panels to other applications, see Flix to
Photoshop and Maya.
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Managing Markers and Shots
This chapter is designed to help you learn how to use markers to manage your shots.

In the Edit workspace, you can add markers in a sequence. You can use markers to specify where
each shot starts and ends. For instance, in a sequence of 30 panels, if you select the panels 1, 10, and
20, and add markers to these panels, you indicate that there are 3 shots in your sequence. In the

example, the first shot is from panels 1 to 9, the second shot is from panels 10 to 19, and the third
shot is from panels 20 to 30. You can then improve the management of a sequence by renaming,
moving, duplicating the shots, and changing their status.

A marker is displayed as a gray square located at the top-left of the panel you added it to, which is the
first panel of a shot. The number inside the marker is the shot label. The number displayed
immediately below the shot label indicates the marker ID number.

Below, you can see that the marker of a shot is selected:

Below, you can see that an entire shot is selected:
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Markers

Turning Markers On/Off

Turning Markers On

To add, move, and delete markers, or perform any actions using the shots, you need to turn the
markers on. To turn the markers on, right-click anywhere in the Edit workspace and from the
dropdown menu click on Turn Markers On.

The markers are now activated and the Add Marker button in the menu bar is enabled. You can
now manage markers and shots in the sequence.

NOTE: Once the markers are activated, they remain activated until you turn them off, no
matter which sequence you are working on within Flix.

Turning Markers Off

To turn the markers off, right-click anywhere in the Edit workspace and from the dropdown menu
click on Turn Markers Off.

The markers are now deactivated and the Add Marker button in the menu bar is disabled. The
markers disappear from the sequence (if you added any previously).

NOTE: Turning the markers off doesn't delete them. Simply turn the markers on again to
have them displayed in the sequence.

Adding Markers

To add a marker, do the following:

1. Ensure you turn the markers on.

2. Select the panel where you want the shot to start.

3. Click on the Add Marker button in the menu bar.

The marker is added to the panel you selected. The shot starts from the panel you selected and
ends at the last panel of the sequence.
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NOTE: To add multiple markers, simply Ctrl/Cmd+click on the panels where you want each
shot to start and click on the Add Marker button in the menu bar.
The markers are added to each of the panels you selected. The number of markers equals
the number of shots in the sequence, the markers indicating where each shot starts.

Deleting Markers

To delete markers from the sequence, do the following:

1. Ensure you click on the marker (gray square) itself and not on the panel.

The marker is highlighted in beige indicating that it is selected.

2. Click on the Delete button in the menu bar.

The marker is now deleted from the sequence.

NOTE: You can delete as many markers as you need at once in a sequence. Simply
Ctrl/Cmd+click on any of the markers you want to delete and click on the Delete button in
the menu bar.

Moving Markers

After you've added markers in the sequence, you can still move them if you decide that you want to
cut the sequence at different places. You can move markers forward and backward in the sequence.
To move markers, click and hold on the marker you want to move, and drag it on the panel you want
to set the marker on.

The marker is now set on the panel you dragged it on.

NOTE: You can move only one marker at a time.

Shots

Renaming Shots

By default, the shots are given a 3 digit name, for instance 001, but you can rename them. To rename
a shot, do the following:

1. Click on any panel of the shot.

The Shot Label field appears under the Viewer.
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2. Change the existing name by entering a new name for the shot in the Shot Label field.

3. Press Enter to apply the name change.

The shot label is now updated. It is displayed at the top-left of the shot, above the first panel.

NOTE: You can use alphanumeric characters to name shots.

Managing Shot Status

You can change the status of your shots to have a better visibility on the edit progress. You can set
one of the following statuses:

Status icon Status description

Ready To Start

In progress

Awaiting Approval

Approved

Final

Blocked

Omitted

On Hold

Unapproved
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Choosing Panel Indices Display

You can choose whether to display panel indices based on their position in the sequence or their
position in the shots.

NOTE: By default, panels indices are displayed based on their position in the sequence.

To display panel indices as per their position in the shots, in the Edit workspace, right-click and select
Turn Panel Index based on Markers On. The panel indices are displayed as per their position in the
shots.

Changing Shot Status

To change the status of a shot, do the following:

1. Click on the first panel of the shot.

2. Click on the Ready To Start button to reveal the dropdown menu with the status options.

3. Select a status from the list.
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The shot status is now changed and the status icon is displayed.

Moving Shots

After you've indicated where the shots start and end by adding markers on panels, you can move the
shots in the sequence to re-order them. You can move shots forward and backward in a sequence.

To move shots, do the following:

1. Select the entire shot by clicking above any of the panels of the shot, and make sure you did not
select just one panel or the marker of the shot.

The entire shot is highlighted in beige indicating that it is selected.

2. Click and hold the shot you want to move and drag it where you want to move it in the sequence.

The shot is now placed where you dragged it in the sequence.

NOTE: You can move the shot anywhere in the sequence, even in the middle of another
shot. You can move only one shot at a time.

Duplicating Shots

To duplicate shots, do the following:

1. Select the entire shot by clicking above any of the panels of the shot, and make sure you did not
select just one panel or the marker of the shot.

The entire shot is highlighted in beige indicating that it is selected.

2. Click the Duplicate button in the menu bar.

The shot is now duplicated and is placed directly after the shot you duplicated it from.
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NOTE: You can duplicate as many shots as you need at once. Simply Ctrl/Cmd+click on as
many shots as you want to duplicate, and click on the Duplicate button in the menu bar.

Deleting Shots

To delete the shots in a sequence, do the following:

1. Select the entire shot by clicking above any of the panels of the shot, and make sure you did not
select just one panel or the marker of the shot.

The entire shot is highlighted in beige indicating that it is selected.

2. Click on the Delete button in the menu bar.

The shot is now deleted from the sequence.

NOTE: You can delete as many shots as you need at once. Simply Ctrl/Cmd+click on as many
shots as you want to delete and click on the Delete button in the menu bar.
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Managing Dialogue
Adding dialogue to your panels is a necessary step in creating more complete sequences. Dialogue
helps put a sequence into context and lends more story information to the panels. Dialogue can be
added and amended in both the Edit and Dialogue workspaces, and can also be displayed in the
Pitch workspace when presenting a sequence.

Dialogue in Edit Workspace
Within the Edit workspace, you can both view and edit the dialogue for accompanying panels. The
dialogue is not displayed with the panel in the Sequence Editor pane. Instead, the dialogue can be
found within the Viewer. If you select multiple panels before updating the dialogue, the update is
applied to all selected panels, but the Viewer only displays the last panel you selected.

Additionally, panel dialogue can be instanced. Instancing makes it easier to edit dialogue snippets for
all instanced panels. For more information about instancing, see Instancing Panels.

Dialogue in DialogueWorkspace
The Dialogue workspace is set out a little differently to the Edit workspace. Instead of displaying
panels in the Sequence Editor pane with dialogue appearing below the Viewer, the Sequence
Editor pane is populated with tiles that show both the image thumbnail and the dialogue entry box.

You can still view the dialogue within the Viewer, so long as the Dialogue button is active, however, it
is easier to see which panels have dialogue and which don’t simply by scrolling through the list in this
workspace.

Though you can still edit the dialogue as described in Editing Dialogue, you can also write or paste
text into the entry box directly in the Sequence Editor pane. As with the Viewer dialogue box, you
can use the same cut, copy, and paste functionality for adding, changing, or removing text.

When making changes to dialogue, ensure that you click Save on theWorkspace toolbar before
closing Flix. You can still switch between workspaces, and your changes in the Dialogue workspace
are retained, but save often to prevent any lost work, should something go wrong.
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Dialogue in Pitch Workspace
The only options for dialogue in the Pitch full screen Viewer is whether the dialogue is visible or not
and whether it appears on the top or the bottom of the screen. Refer to the chapter on Pitching
Sequences for more details on displaying dialogue in Pitch workspace, and the Pitch hotkeys.

Reviewing Dialogue
1. To view existing dialogue, ensure that the Dialogue button in the Viewer Controls pane is active.

You can tell if this button is active because it appears dark gray and a dialogue box appears
beneath the image in the Viewer.

2. Select a panel from the Sequence Editor panel.

The image in the Viewer is updated and if there is any dialogue associated with the panel, this
appears in the dialogue box in the lower portion of the Viewer.

NOTE: If there is no dialogue for the selected panel, the dialogue box still appears with the
Viewer but there is no dialogue included within it. This allows you to go back and add
dialogue at any time.

MANAGING DIALOGUE | DIALOGUE IN PITCH WORKSPACE



63

Adding Dialogue

Adding Dialogue in Edit Workspace
1. Select the panel to which you want to add dialogue.

The panel is displayed in the Viewer.

TIP: If you select multiple panels before adding dialogue, the dialogue is added to all
selected panels, but the Viewer only displays the last panel you selected.

2. Ensure that the Dialogue button in the Viewer Controls pane is active.

You can tell if it’s active because the button appears darker gray and dialogue appears beneath
the panel in the Viewer.

3. Either press Tab or click on the dialogue entry box, directly beneath the displayed panel in the
Viewer.

The cursor flashes in the dialogue entry box to notify you that you can begin typing.

4. Type new dialogue or paste text from the clipboard if you have cut or copied text from another
source.

NOTE: If you cannot click in the dialogue box, or the cursor does not flash when you press
the Tab key, the dialogue on that particular panel may be locked against editing.
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NOTE: In Edit workspace, when editing dialogue, press Shift+Return to go to the next
panel's dialogue box. Similarly, press Ctrl/Cmd+Left/Right to switch to the previous/next
panel’s dialogue box.

Adding Dialogue in DialogueWorkspace
1. Select the panel tile to which you want to add dialogue.

The panel is displayed in the Viewer and the cursor is automatically moved to the dialogue entry
box on the tile.

2. Begin typing in the dialogue tile entry box or paste text from the clipboard if you have cut or
copied text from another source. Alternatively, you can type in the entry box beneath the Viewer,
as you would to add dialogue in the Edit workspace.

You can enter multiple lines of dialogue within the same space. Simply press Enter to begin a new
line within the dialogue box.

NOTE: You can only navigate through text in the dialogue box by moving the cursor location
with your mouse. If you attempt to use the arrow keys to move the cursor, Flix interprets this
as attempting to select another panel for dialogue.
You can also press Tab to move to the next dialogue box.

NOTE: As with adding dialogue in the Edit workspace, if you can't click in the dialogue box
on the panel tile, the dialogue on that particular panel may be locked against editing.

Editing Dialogue
1. Ensure that the Dialogue button in the Viewer Controls pane is active.

You can tell if it’s active because the button appears darker gray and dialogue appears beneath
the panel in the Viewer.
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2. To edit existing dialogue, select a panel from the Sequence Editor pane.

NOTE: If you select multiple panels before editing the dialogue, the edits are applied to all
selected panels, but the Viewer only displays the last panel you selected.

The image in the Viewer is updated and existing dialogue is displayed in the dialogue box.

3. Either click in the dialogue box or press Tab on the keyboard.

4. Begin typing or paste text from the clipboard into the dialogue box.

5. You can cut, copy, or paste dialogue by either:

• right-clicking in the dialogue box and selecting Cut, Copy, or Paste from the dropdown menu,
or

• selecting the dialogue and pressing Ctrl+X to cut, Ctrl+C to copy, or Ctrl+V to paste.

TIP: You can double-click on a word to select it or triple-click on a word to select all the text
at once.

6. If you simply want to remove existing dialogue, select what you want to remove, right-click, and
select Delete from the dropdown menu or press the Backspace button on your keyboard.

Viewing Pitch Dialogue
To toggle the visibility of dialogue in the Pitch full screen Viewer, click on the Dialogue button in the
Viewer Controls pane. To adjust where it appears on the full screen Viewer when dialogue is active,
press Tab within the Pitch view. This toggles it between the top and the bottom of the Viewer.

NOTE: For more information about the Pitch workspace or controls in full screen mode, see
Pitching Sequences.

Exporting Dialogue
You can export dialogue from Flix to a specified location as a .txt file. For more information about
how to export dialogue, refer to Exporting Dialogue as a Text File.
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Importing and Exporting
Flix provides the option to import and export content. Importing and exporting content can be used
to update panel versions.

Importing new content into Flix is a very important function that provides many people involved in
the storyboarding process the ability to contribute to a sequence. Whether they are using other
programs to create images, dialogue, or audio files, or want to import files from another Flix
sequence or project, you want as much flexibility as possible in the pre-visualization process. Flix
allows you to import these files, and version them the same as you would with any other storyboard
component.

Imported images or audio files are kept within the Panel Libraries. These imports consist of libraries,
which can be panels, animated panels, staging, audio files, or reference files. Import brings new
libraries into Flix. You can choose to add these to the sequence or leave them in the Panel Libraries
until you are ready to use them. New, copied, or duplicated panels added to the Sequence Editor
pane are automatically added into the Panel Libraries as well.

From Flix, you can export different types of contents such as dialogue to a .txt file, audio to an .mp3
or .wav file, sequence to a .mov file, sequence information to a .csv file, or the sequence's panels to
.jpg or .psd files.

Importing Drawings
To import still panels into the Panel Libraries:

1. Start Flix and load your project, sequence, version, and branch.

2. In the Edit workspace, click on the Import button in the Panel Libraries.

The Choose Files To Import dialog launches a file browser.

3. Select the file or files you want to import within the file browser and press Open.

The panel is added to the sequence after the current selected panel and is displayed in the Panel
Libraries as well. If you cannot see the panel in the Panel Libraries, switch to All Loaded in the
Display dropdown menu.

NOTE: Importing a drawing causes Flix to autosave your work, unless a previous action
caused an autosave in the last 5 minutes. Flix keeps track of up to 10 autosave snapshots,
after which the oldest is overwritten by the next autosave.
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4. Select an option from the Display dropdown menu to filter which libraries are shown in the Panel
Libraries pane. The options for the display are:

• All Loaded,

NOTE: The All Loaded option doesn't necessarily display all the panels in the sequence.
Unless you view the relevant libraries (a, m, p, ref, rlo, s, and so on) first, there may not be
any panels visible in All Loaded. Only those libraries that have been viewed in the current
session are displayed.

• None,

• a (animated),

• m (master),

• p (panel),

• ref (reference),

• rlo (rough layout), and

• s (staging).

NOTE: If you want to import more than one panel at once, select multiple files in the file
browser before pressing Open.

To import animated panels into the Panel Libraries:

1. Start Flix and load your project, sequence, version, and branch.

2. In the Edit workspace, Shift+click on the Import button in the Panel Libraries.

The Choose Files To Import dialog launches a file browser.

3. Select the files you want to import as an animated panel. The still panels you select are grouped
into a single animated panel in the Panel Libraries. Press Open.

The animated panel is added to the sequence after the current selected panel and is displayed in
the Panel Libraries as well. If you cannot see the panel in the Panel Libraries, switch to All
Loaded in the Display dropdown menu.
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NOTE: Animated panels are marked with an indicator at the bottom left corner of the panel.

4. Select an option from the Display dropdown menu to filter which libraries are shown in the Panel
Libraries pane. The options for the display are the same as the options shown above, for
importing only one panel.

NOTE: You cannot import more than one animated panel at once, as selecting multiple files
is how Flix knows what to include in the animated panel.

Importing Audio
Flix allows you to import audio to play it back with a sequence.

To import audio into the Panel Libraries:

1. Start Flix and load your project, sequence, version, and branch.

2. In the Edit workspace, click on the Import button in the Panel Libraries.

The Choose Files To Import dialog launches a file browser.

3. Select the audio file you want to import within the file browser and press Open.

When the import has finished, the message "Successfully imported audio" appears.

NOTE: Flix can only import .mp3 files.

Importing MOV Files
Flix allows you to import reference .mov files.

To import .mov files into Flix:

1. In the Edit workspace, click on the Import button in the Panel Libraries.

The Choose Files To Import dialog launches a file browser.

2. Select the .mov file you want to import within the file browser and press Open.

The .mov file is imported in Flix as an animated panel.

NOTE: Flix can also import .mp4 files.

NOTE: If you want to import more than one .mov file at once, select multiple .mov files in
the file browser before pressing Open.
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Importing Shotgun Shots
Flix allows you to import shots directly from Shotgun.

NOTE: Make sure you have a show and sequence set up in Shotgun, in which shots have
previously been published.

NOTE: Make sure the Shotgun parameters are set up. Refer to the Flix Technical Guide in the
Setting Parameters section.

To import shots from Shotgun:

1. Start Flix and load your project and sequence corresponding to the project and sequence in
Shotgun.

2. In the Edit workspace, from the Export plug-in group, select the Shotgun Import plug-in.

The Shotgun import dialog opens.

3. Select the shots you want to import and press Submit.

When the import has finished, the message "Executed Shotgun Import Plugin Successfully"
appears.
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Exporting Selected Panels as PSDs
Exporting panels you selected as .psd files is done by clicking on the Export PSDs button on the
Workspace toolbar, in the Edit workspace. Exporting the selected panels as .psd files allows you to
open the files in other programs, or to send them to other locations or users.

To export the selected panels using the Export PSDs plug-in:

1. Save the sequence in Flix to ensure that you don't lose any recent changes.

2. Select the panels you want to export as .psd files.

3. Click the Export PSDs button on theWorkspace toolbar in the Edit workspace.

The Choose a folder dialog displays.

NOTE: The Export Plug-in Group button is dynamic. If the button isn't set to the correct plug-
in option, it might appear on theWorkspace toolbar, in the Edit workspace, as Export
Dialogue . To change it, click the button until the list of plug-ins appears in a dropdown
menu and select the Export PSDs plug-in.

4. Choose a location in the file browser, and select Save.

The selected panels in the sequence are saved as .psd files in sequential order to the specified file
location.

Exporting as a QuickTime
You can export a saved version of a sequence as a .mov file using the QuickTime To Movie plug-in
on theWorkspace toolbar in the Edit workspace.

To export a sequence using the QuickTime plug-in:

1. Save the sequence in Flix to ensure that you don't lose any recent changes.

2. Click on the QuickTime To Movie button on theWorkspace toolbar, in the Edit workspace.

The .mov file and .nk script are rendered out to the show's editorial fleMov folder, which can be
found at:

/flixProjects/<show>/<sequence.story>/flix/editorial/fleMov.

NOTE: The Export Plug-in Group button is dynamic. If the button isn't set to the correct plug-
in option, it might appear on theWorkspace toolbar, in the Edit workspace, as Export
Dialogue . To change it, click the button until the list of plug-ins appears in a dropdown
menu and select the To Movie plug-in.
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NOTE: By default, Flix export toMPEG-4 format. You can modify the format in the
parameters.yml file. The supported codecs are documented in the paramaters.yml file.

Exporting Audio
NOTE: To set which format to export to, refer to the Flix Technical Guide in the Setting
Parameters section.

To export audio from Flix to a specified location as an .mp3 or .wav file:

1. Save the sequence in Flix to ensure that you don't lose any recent changes.

2. Click on the Export Audio button on theWorkspace toolbar, in the Edit workspace.

A file browser appears.

NOTE: The Export Plug-in Group button is dynamic. If the button isn't set to the correct plug-
in option, it might appear on theWorkspace toolbar, in the Edit workspace, as Export
Dialogue . To change it, click the button until the list of plug-ins appears in a dropdown
menu and select the Export Audio plug-in.

3. Choose a location for the .mp3 or .wav file to be saved to.

Once the audio has been exported, the location where the .mp3 or .wav file was saved to is
opened and Flix notifies you that the plug-in exported successfully.

Exporting Selected Panels as JPGs
Exporting panels you selected as .jpg files is done by clicking on the Export JPGs button on the
Workspace toolbar, in the Edit workspace. Exporting the selected panels as .jpg files allows you to
open the files in other programs, or to send them to other locations or users.

To export the selected panels using the Export JPGs plug-in:

1. Save the sequence in Flix to ensure that you don't lose any recent changes.

2. Select the panels you want to export as .jpg files.

3. Click the Export JPGs button on theWorkspace toolbar in the Edit workspace.

The Choose a folder dialog displays.
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NOTE: The Export Plug-in Group button is dynamic. If the button isn't set to the correct plug-
in option, it might appear on theWorkspace toolbar, in the Edit workspace, as Export
Dialogue . To change it, click the button until the list of plug-ins appears in a dropdown
menu and select the Export JPGs plug-in.

4. Choose a location in the file browser, and select Save.

The selected panels in the sequence are saved as .jpg files in sequential order to the specified file
location.

Exporting Dialogue as a Text File
To export dialogue from Flix to a specified location as a .txt file:

1. Save the sequence in Flix to ensure that you don't lose any recent changes.

2. Click on the Export Dialogue button on theWorkspace toolbar, in the Edit workspace.

A file browser appears.

NOTE: The Export Plug-in Group button is dynamic. If the button isn't set to the correct plug-
in option, click the button until the list of plug-ins appears in a dropdown menu and select
the Export Dialogue plug-in.

3. Choose a location for the .txt file to be saved to.

Once the dialogue has been exported, the location where the .txt file was saved to is opened and
Flix notifies you that the plug-in exported successfully.

The .txt file is saved with the name of the sequence and version number.

Exporting as a CSV File
You can export a saved version of a sequence as a .csv file using the Export to CSV plug-in on the
Workspace toolbar in the Edit workspace. The .csv file contains information about the whole
sequence and each of its panels.

To export a sequence using the Export to CSV plug-in:

1. Save the sequence in Flix to ensure that you don't lose any recent changes.

2. Click on the Export to CSV button on theWorkspace toolbar, in the Edit workspace.

The Choose a folder dialog displays.

3. Choose a location in the file browser, and click on Select Folder.

The sequence is saved as a .csv file to the specified file location.
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The .csv file contains information about the whole sequence and applies to every panel in the
sequence, not just the selected panel.

NOTE: The Export Plug-in Group button is dynamic. If the button isn't set to the correct plug-
in option, it might appear on theWorkspace toolbar, in the Edit workspace, as Export
Dialogue . To change it, click the button until the list of plug-ins appears in a dropdown
menu and select the Export to CSV plug-in.
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Editing in Third Party
Applications

Flix gives you the possibility to edit your panels and sequences in many applications such as
Photoshop, Maya, Shotgun, Storyboard Pro, and TVPaint Animation.

NOTE: To see the applications' dependencies, refer to Appendix D: Application
Dependencies.

Photoshop
Flix links to Photoshop so you can edit your panels directly in Photoshop and send them back to Flix.

NOTE: To see the supported versions of Photoshop, refer to the Appendix D: Application
Dependencies section.

Installing/Updating Photoshop Scripts

If you have full read, write, and execute permissions, you can update the Photoshop scripts by
clicking on the Install/Update Scripts button at the bottom left of the Flix interface and selecting
Install Photoshop scripts.

NOTE: If you don't have full read, write, and execute permissions, you need to install and
upgrade the scripts manually. Refer to the Flix Technical Guide, in the Enabling the Third-Party
Applications section.

Flix to Photoshop

Open either a single panel to Photoshop or multiple panels at once, depending on your needs. Follow
the steps for each process below:
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Opening One Panel in Photoshop

To send one panel to Photoshop from Flix:

1. Select the panel that you want to open in Photoshop.

2. In the Edit workspace, either:

• Click the Photoshop button on theWorkspace toolbar,

• Press Ctrl/Cmd+Enter while the panel is selected,

• Double-click the panel, or

• Right-click the panel and select Edit Image from the dropdown menu.

The selected panel opens in Photoshop automatically.
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If the panel is a .psd file, all layers are preserved and displayed in Photoshop. If the file is a .jpg,
you can add layers when making your changes within Photoshop.

Opening Multiple Panels in Photoshop

To send several panels from Flix to Photoshop as layer comps or in a timeline:

1. Select the panels that you want to open in Photoshop.

2. In the Edit workspace, on theWorkspace toolbar, click the Editing plug-in Group button until
the list of plug-ins appears in a dropdown menu.
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3. Select Photoshop (layer comps) to send the selected panels to Photoshop as layer comps.

OR

Select Photoshop (timeline) to send the selected panels to Photoshop in the Timeline.

4. In the Edit workspace, either:

• Click on the Photoshop button,

• Press Ctrl/Cmd+Enter while the panels are selected, or

• Right-click one of the selected panels and select Edit Image from the dropdown menu.

If you clicked on Photoshop (layer comps), the selected panels open as layer comps in
Photoshop.

The selected panels open in Photoshop’s Timeline tab, if you clicked on Photoshop (timeline).
This splits up the images so that you can edit them individually.

NOTE: If you can't see the Timeline or Layer Comps tabs in Photoshop, on the Photoshop
menu bar, navigate toWindow > Layer Comps or Timeline to display them.

NOTE: The Editing Plug-in Group button is dynamic. If the icon isn't set to the correct plug-in
option, click the button until the list of plug-ins appears in a dropdown menu and select the
required Photoshop plug-in.

Multiple panels in the Timeline tab.
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Multiple panels in a layer comp.

As with editing a single panel in Photoshop, if multiple files are .psd, all layers are preserved and
displayed in Photoshop. If the panels are .jpg files, you can add layers when making your changes.

Changes to multiple panels in the Timeline tab.

Changes to multiple layers in a layer comp.
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Exporting Panels as PSDs

See Exporting Selected Panels as PSDs

Creating Panels Using Templates

You can create a panel using a blank Photoshop template with a choice of aspect ratios provided. Edit
this template in Photoshop and export it to Flix as a new panel. To set up a template:

1. In Photoshop, navigate to File > Automate and select any of the following:

• Flix New Template 177

• Flix New Template 185

• Flix New Template 235

• Flix New Template 239

The numbers represent the aspect ratio of each template. For example, the template 177 is
equivalent to an aspect ratio of 1.77.

2. Make any desired edits in Photoshop.

3. Export your template to Flix by navigating to File > Automate > Flix Current Image.

The edited template appears as a new panel in Flix.

NOTE: For additional export options from Photoshop, see Photoshop to Flix.

Photoshop to Flix

If you want to round-trip a panel and replace the older version directly in Flix, follow the steps below.
If you don’t want to replace an older version, but import changes as a new file within Flix, refer back
to the instructions on Importing Drawings.

Once you’ve finished making changes to the panel in Photoshop:

1. Ensure that you have both Photoshop and Flix open.

2. To save your changes as a new version of the panel, either:

• Select File > Save within Photoshop, or

• Press Ctrl/Cmd+S.

Once you’ve saved your changes, the updated panel appears in Flix with a new version number.
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If you are reimporting multiple files from Photoshop:

1. Ensure that you have both Photoshop and Flix open.

2. Once you’ve made your changes to all the panels in the Timeline tab or layer comps, either:

• Select File > Save within Photoshop, or

• Press Ctrl/Cmd+S.

Once you’ve saved, the updated panels appear in Flix with new version numbers.

You don’t necessarily need to save your files in Photoshop. If you want to re-import your changes
directly into Flix and save yourself the trouble of saving the file in Photoshop, there are several
options for reimporting using custom Flix commands.

To re-import the current image into Flix from Photoshop:

1. Ensure that you have both Photoshop and Flix open, and that you have the correct panels in Flix
selected.

2. Within Photoshop, select File > Automate > Flix Current Image from the dropdown menu.

The panel is sent to Flix as a new panel added to the sequence.

3. If you don’t want to save the file, you can close it in Photoshop once you have re-imported the
panel back into Flix.

NOTE: If you choose to save the file in Photoshop, it saves the panel and replaces it in Flix as
a new version. You can go back to any version of the panel within Flix, so none of your
previous changes are ever lost.

There are more options for importing panels into Flix from Photoshop, depending on what
components of the image you wish to import. The options within the File > Automate menu include:
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Option Description

Flix Selected
Layer

Re-imports only the selected layers of the image as a new panel.

Flix Each Frame Re-imports each frame in the Timeline as a separate panel. This is only available
if you are using the animation timeline workflow.

Flix Each Layer Re-imports each visible layer in an image as a separate panel.

Flix Each Layer
+ BG

Flix Each Layer + BG- re-imports each visible layer in an image as a separate
panel but keeps the background the same for each one.

Flix Each Layer
+ FG/BG

Re-imports each visible layer in an image as a separate panel but keeps the
background and foreground the same for each one.

Flix Each Layer
Comp

Imports or re-imports each layer comp as a separate panel with all the visible
layers from the individual layer comp.

Flix Selected
Layer Comp

Re-imports all selected layer comps.

Flix Cropped
Current Image

Exports the cropped selection to a new Flix panel.

Flix Animation Exports an animated timeline from Photoshop to Flix.

Flix version Displays the current script version.

Flix Master
Image

Exports the current .psd file as a master image to Flix's Panel Libraries.

Flix Select
Previous

Selects the previous panel in the Flix current sequence from within Photoshop.

Flix Select Next Selects the next panel in the Flix current sequence from within Photoshop.

NOTE: To re-import an image from Photoshop using one of the options above, follow the
same steps you would to re-import Flix Current Image.

Maya
This section is designed to help you manage the Maya tools when working with Flix.

EDITING IN THIRD PARTY APPLICATIONS | MAYA



82

Installing/Updating Maya Shelves

If you have full read, write, and execute permissions, you can install or update the Maya shelves
directly in Flix. Click on the Install/Update Scripts button at the bottom left of the Flix interface and
select Install Maya scripts, then select the location where to install or update the shelves.

NOTE: If you don't have full read, write, and execute permissions, you need to install and
upgrade the shelves manually. Refer to the Flix Technical Guide, in the Enabling the Third-Party
Applications section.

Maya to Flix

After the Maya shelves have been installed, a Flix shelf appears in Maya with several options to send
data from Maya to Flix. This is how the Flix shelf looks inside Maya:

Below is a description of what each of these icons do:

WARNING: The Flix-Maya server is unable to start if Flix is not running on your machine.

Flix Control in
Maya UI

Action

Start the Flix-Maya Server

When sending data between Maya and Flix, the Flix-Maya server needs to be
running.

Send Still as New Panel

Sends a still from the current Maya camera as a new panel in Flix.

NOTE: By default, new panels coming from Maya are created in Flix as
s panels, for staging.
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Flix Control in
Maya UI

Action

Send Still to Replace Current Panel

Replaces the currently selected panel in Flix by a still taken from the current
camera in Maya.

Send Playblast as New Panel

Sends a playblast from the current Maya camera to Flix as a new animated
panel.

Send Playblast to Replace Current Panel

Replaces the first currently selected panel in Flix by a playblast taken from the
current camera in Maya.

Send Shot Playblast as New Panel

Sends a playblast of the current Maya camera sequencer shot as a new panel in
Flix.

Send Shot Playblast to Replace Current Panel

Replaces the first currently selected panel in Flix by a playblast taken from the
current camera sequencer shot in Maya.

Send Sequencer Playblast as New Panel

Creates new panels in Flix for each of the shots in the current Maya
scene/camera sequencer.

Send Sequencer Playblast as New Edit

Creates a new Flix version for each of the shots in the current Maya
scene/camera sequencer.
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Flix Control in
Maya UI

Action

Make Selected Nodes Capturable

Marks the selected nodes in Maya as capturable by Flix. In the case where
nothing is selected, it creates a new capturable transform.

The Flix Capturable option allows you to save the Maya transform attributes
metadata.

To stop capturing the Maya transform attributes metadata, in Maya navigate to
Attribute Editor > [node] > Extra Atttributes and uncheck Flix Capturable.

Create Audio Shot

Creates a single shot audio for the currently-selected sequencer shots in Maya
based on the audio imported from Flix.

Flix to Maya

Panel's Metadata

To send one panel to Maya from Flix (if it was created in Maya):

1. Select a panel with metadata that you want to export to Maya.
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2. In the Edit workspace, click on the Maya button on theWorkspace toolbar.

The selected panel metadata is copied to the clipboard.

3. Paste the copied panel metadata into a Python module in Maya.

Pasting the metadata resets the camera and scene in the Maya file so that it matches the look of
the file in Flix.

Alternatively, start with panels in Maya and create your scene and cameras before importing them
into Flix using the instructions in Importing Drawings.

Even if panels have been changed and versioned up, you can still export them to Maya, so long as it
contains the same CG elements and metadata.

NOTE: If you attempt to export a panel that does not have metadata, a warning dialog is
displayed saying No Metadata Found. The panel is not exported to Maya.

Maya Plug-in Group

The Maya plug-in offers different options to export data from Flix to Maya. Below are the available
options from the Maya plug-in dropdown menu:

WARNING: The Flix-Maya server needs to be running in order to send data between Flix and
Maya. To start the server, refer to the table in the Maya section.

• Maya Sequencer - sends the entire current Flix edit to the Maya sequencer. Adds an Image Plane
for each panel or shot as rendered images.

• Maya Sequencer Imageless - sends the entire current Flix edit to the Maya sequencer without any
of the Image Planes.

• Maya Data Only - only sends the metadata from the current Flix edit to Maya.

• Maya Shots - creates separate Maya shots for each shot from the current Flix edit and opens a file
browser for you to specify a location on disk to export these shots.

Nuke
WARNING: Nuke needs to be installed for the export to work.

To send one panel to Nuke from Flix:

1. Select a panel in your sequence.

2. In the Edit workspace, click on the Open in Nuke button on theWorkspace toolbar.

Nuke launches and displays the selected panel in the Viewer and its comp in the Node Graph.

EDITING IN THIRD PARTY APPLICATIONS | NUKE



86

NOTE: The Export Plug-in Group button is dynamic. If the button isn't set to the correct plug-
in option, it might appear on theWorkspace toolbar, in the Edit workspace, as Export
Dialogue . To change it, click the button until the list of plug-ins appears in a dropdown
menu and select the Open in Nuke plug-in.

Shotgun
You can publish your shots to Shotgun directly from Flix. Shotgun is a pipeline tool that allows
managers, artists, and pipeline teams to keep track of their projects. For example, artists can publish
their work to Shotgun and update the production status.

WARNING: Shotgun Publish needs to be setup in Flix’s parameters, see the Flix Technical
Guide, in the Shotgun Parameters section for more information.
Before exporting shots to Shotgun, a project along with a sequence must be created in
Shotgun.

Exporting Shots to Shotgun

NOTE: If there is no shot in your sequence, the whole sequence is published to Shotgun as a
single shot.

To export shots to Shotgun, do the following:

1. Ensure your sequence has been saved.

This creates a new version of the sequence.
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2. Click on the Editorial Plug-in Group button in the menu bar. The button is dynamic and provides
other options for exporting to other editorial applications. To export to Shotgun, click the button
until the list of plug-ins appears in a dropdown menu and select SG to open the Publishing to
Editorial dialog.

The Publishing to Editorial dialog opens.

3. If you want to add comments to the sequence before sending it to Shotgun, type them into the
Comment entry box on the right of the dialog. There is a limit of 50 characters for your
comments.

4. Click on Don't Compare.

NOTE: The Compare option does not work for Shotgun Publish at the moment.

5. Click on Publish to continue.

The shots, along with your comments if you added any, are published to Shotgun.
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NOTE: If the export seems to be taking longer than expected, you can track the progress of
the export on the status bar. When the export has finished, the message Executed plugin
successfully appears.

Viewing Your Shots in Shotgun
1. In Shotgun, click on the Projects tab in the menu bar.

2. Select a project from the dropdown menu.

The project displays in the Overview tab.

3. Scroll down to see all the shots that you published.

NOTE: For more information about how to use Shotgun, go to
support.shotgunsoftware.com.

Storyboard Pro
You can export directly from Storyboard Pro into Flix, including timing and markers information.
After import, you can publish from Flix to a suite of supported plug-ins such as Avid, Premiere, and
Nuke Studio, revise edits, and then send back to Flix, and publish the updated sequence back to
Storyboard Pro.

Storyboard Pro to Flix

Once you've worked on your panels, you can either export the entire project or the edited panels only
to Flix.

NOTE: Camera moves added in Storyboard Pro are preserved in Flix and are imported as
animated panels. Animating a panel in Storyboard Pro that was originally sent as a still to
Flix and sending it back to Flix replaces the original still by an animated one to reflect the
Storyboard Pro changes.

NOTE: When exporting a project to Flix containing multiple audio tracks, metadata is
preserved to reconstruct the tracks as accurately as possible when you export back to
Storyboard Pro.

NOTE: With Storyboard Pro 4.2 build 10.2.2 (10521) or above, you can export dialogues and
action notes into Flix. To do so, make sure to select the Export Captions option in the
Conformation/Export Project settings dialog.
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Exporting the Entire Project (all the panels)
1. Make sure the right sequence is open in Flix.

2. When your Storyboard Pro project is ready to be exported, click on File > Conformation > Export
Project…

3. Navigate to flix in your home folder:

• Windows: C:\Users\[user]\flix

• Mac/Linux: ~/flix

If the flix folder does not exist, you need to create it.

4. In the Options panel, make sure the Export one image per layer option is unchecked to export
all layers of each panel at once.

5. If it’s the first time you export to Flix, check the Export markers at scene beginning checkbox
for the Storyboard Pro scenes to come in as shots in Flix.

NOTE: When you export a project that contains multiple scenes back to Flix, the scenes are
imported as different shots by creating markers in Flix.

6. Check the Notify Flix option if you want to be able to export to any location.

If you don't check the Notify Flix option, Flix starts importing directly instead of importing after
Storyboard Pro has finished exporting.

If unchecked, make sure to export in the right directory, by default:

• Windows: C:\Users\[user]\flix

• OS X/Linux: ~/flix

NOTE: The Notify Flix option is only available from Storyboard Pro 5 onwards.

7. Click on Export.

All the panels are imported in Flix. The existing panels are versioned up, even if they haven’t been
edited.

Exporting Only the Edited Panels

NOTE: The following steps are only relevant if the project has already been exported to Flix
before.

1. Make sure the right sequence is open in Flix.

2. Before you start working on your Storyboard Pro project, make sure the Auto Tracking Mode is
on. To turn the Auto Tracking Mode on, click on Storyboard > Track Changes > Auto Tracking
Mode.
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3. When your Storyboard Pro project is ready to be exported, click on File > Conformation > Export
Tracked Panels…

4. Navigate to flix in your home folder:

• Windows: C:\Users\[user]\flix

• Mac/Linux: ~/flix

If the flix folder does not exist, you need to create it.

5. In the Options panel, make sure the Export one image per layer option is unchecked to export
all layers of each panel at once.

6. Click on Export.

The new and edited panels are imported in Flix. The existing panels are versioned up.

Flix to Storyboard Pro
1. Click on the Editorial Plug-in Group button in the menu bar and select StoryBoard Pro plug-in.

The Publishing to Editorial dialog opens.

NOTE: The Editorial Plug-in Group button is dynamic. If the button isn't set to the correct
plug-in option, it might appear on theWorkspace toolbar, in the Edit workspace, as Avid .
To change it, click the button until the list of plug-ins appears in a dropdown menu and
select the StoryBoard Pro plug-in.

2. If you want to add comments to the sequence before sending it to Storyboard Pro, type them into
the Comment entry box on the right of the dialog. There is a limit of 50 characters for your
comments.

3. Click on Don't Compare.

NOTE: The Compare option does not work for Storyboard Pro at the moment.

4. Click on Publish to continue.

The sbp dialog displays and an .xml file is created in the flix/editorial/sbp folder. The path to the
.xml file is automatically added to your clipboard.

5. Launch Storyboard Pro.

6. Open your Storyboard Pro project.

7. Click on File > Conformation > Import Animatic Project…

8. Click on the field to enter the path and press Ctrl+V to paste the path to the XML, and make sure
to remove the extra spaces at the end of the path.

9. Click on Import.

Your Flix project is imported in Storyboard Pro.
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NOTE: When you publish to Storyboard Pro, a new .xml file, called [show]_[sequence]_
[version]_extra_data.xml, is created in the flix/editorial/sbp folder. This .xml file has
information about tracks and audio effects that were previously imported from Storyboard
Pro so that the Storyboard Pro project is reconstructed as accurately as possible. The other
.xml file still has the flat .mp3 file that corresponds to the audio you have in Flix.

Opening Storyboard Pro Projects From Flix

To open the Storyboard Pro project containing your selected panel(s), do the following:

1. Select the panel(s) in your sequence.

2. Click on the Editing Plug-in Group button in the menu bar and select the StoryBoard Pro plug-
in.

Storyboard Pro opens the project your selected panel(s) originally come from.

NOTE: The Editing Plug-in Group button is dynamic. If the button isn't set to the correct
plug-in option, it might appear on theWorkspace toolbar, as Photoshop . To change it,
click the button until the list of plug-ins appears in a dropdown menu and select the
StoryBoard Pro plug-in.

TVPaint Animation

Installing/Updating TVPaint Scripts

To install or update TVPaint scripts, do the following:

1. Click on the Install/Update Scripts button at the bottom left of Flix and select Install TVPaint
scripts.

TVPaint opens along with a dialog.

2. Click Next>>.

3. If you are installing the scripts for the first time, click OK, otherwise check Force Reinstall and
then click OK.

The Flix window appears In TVPaint displaying the scripts.

NOTE: If the Flix window gets closed, you can re-open it by clicking on Custom Panels > Flix.

EDITING IN THIRD PARTY APPLICATIONS | TVPAINT ANIMATION



92

TVPaint Animation to Flix

The following options display in TVPaint to send panels to Flix:

• Current Frame: Sends the current frame to Flix as a new panel.

• Version Up Selected: Replaces the currently selected panel in Flix with the current frame.

• All Frames: Sends all the current frames from your TVPaint sequence to Flix as new panels.

• Mark In/Out: Sends all the current frames between the In and Out points of your TVPaint sequence
to Flix as new panels.

• Master Image: Sends all the current frames to Flix as Master panels.

• Toggle Camera View: Applies to all the scripts. When using Camera View, only the area viewed by
the camera is sent over to Flix. When using Full View, the whole image is sent over to Flix.

Flix to TVPaint Animation

You can open panels in TVPaint Animation for editing using the TVPaint plug-in on the
Workspace toolbar in the Edit workspace.

To open panels using the TVPaint plug-in:

1. Select one or several panels in your sequence.

2. Click on the TVPaint button on theWorkspace toolbar, in the Edit workspace.

The panel opens in TVPaint Animation.

NOTE: The Editing Plug-in Group button is dynamic. If the button isn't set to the correct
plug-in option, it might appear on theWorkspace toolbar, in the Edit workspace, as
Photoshop . To change it, click the button until the list of plug-ins appears in a dropdown
menu and select the TVPaint plug-in.

NOTE: If the panel comes from a TVPaint Animation project, the original project opens in
TVPaint Animation. If the original panel is a .psd file, Flix loads the .psd file.
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Flix for Editorial
When the artists are done working on a sequence, they need to send it to Editorial for them to review
their work. The editors review their work in Avid, Premiere, or Nuke Studio and then need to publish
the sequence back to Flix for the artists to see the changes and comments they've made. This chapter
covers all the steps to accomplish these tasks.

Publishing to Editorial
As an artist, when you're done working on your sequence, you need to send it to Editorial for them to
review your work. If you are publishing to Avid, you need to publish your sequence using first the Flix
UI, and then import the AAFs using the Flix Editorial UI. To publish your sequence using Flix, do the
following:

1. Ensure that your sequence is in the correct order and ready to send.

2. Click Save in the menu bar.

This creates a new version of the sequence.

3. Click on the Editorial Plug-in Group button next to the Save button in the menu bar.
The button is dynamic and provides other options for exporting to other editorial applications. If
you want to select another plug-in than the one by default, click the Editorial plug-in Group button
until the list of plug-ins appears in a dropdown menu and select the plug-in you want to open the
Publishing to Editorial dialog.

The Publishing to Editorial dialog opens.
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4. If you want to add comments to the sequence before sending it to Editorial, type them into the
Comment entry box on the right of the dialog. There is a limit of 50 characters for your
comments.

5. By default, publishing your sequence to Editorial allows you to select a version to which you want
to compare your sequence. If you don't want to compare it to any other version, click on Don't
Compare. Otherwise, you can choose a version from the list, or click Auto Select Version to
select the last version that came into Flix from Editorial or the last one that was published to
Editorial.

6. When you're ready to publish the sequence to Editorial, click on Publish to continue.

7. If you published to Avid, please go to From Flix to Avid. If you published to Premiere/FCP or Nuke
Studio, you can simply import the generated XML in your Premiere/FCP or Nuke Studio project.
The media reconnects automatically.

NOTE: If you are publishing using the Premiere / FCP7 plug-in, panels open as HD .jpg files
in Premiere and if you are publishing with the Split PSD Layers to Clips plug-in, panels open
as .psd files in Premiere.
If the .psd files don't exist in the poses folder, Premiere opens whatever is in the folder
(.png, HD .jpg, low res .jpg files and so on).
The Split PSD Layers to Clips plug-in only publishes an .xml file with the selected panels and
not the entire sequence as opposed to the other Editorial plug-ins.

NOTE: When exporting a project from StoryBoard Pro to Flix containing multiple audio
tracks, metadata is preserved to reconstruct the tracks as accurately as possible when you
export back to Premiere and FCP.

NOTE: If the export seems to be taking longer than expected, you can track the progress of
the export on the status bar. When the export has finished, the message Executed plugin
successfully appears before Flix opens the file browser or finder.

From Flix to Avid
After you've published your sequence to Avid using the Flix UI, you need to import the newly created
AAF files to Avid using the Flix Editorial UI.
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To import the newly created AAF files to Avid, do the following:

1. Click on Flix Editorial launcher.

The Flix Editorial interface opens.

2. Click on the To Avid tab.

3. Click on the Flix Project Browser button to open the sequence you published from Flix.

The Project Browser dialog opens.

4. Click on a project from the list, or search for a project by typing the name in the search bar.
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Once you click on a project, the dialog updates to show you the available sequences for that
project.

5. Click on a sequence from the list, or search for a sequence by typing the name in the search bar.

The Project Browser dialog closes.

The Flix Editorial interface now shows in the left pane the available versions that have been
published. The right pane displays the panels for which there are new AAF files to import.

The most recent version of the sequence is displayed in the left pane at the top and is selected by
default.
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6. Click on To Folder and select the directory where you want to import the AAF files, then click on
Select Folder.

7. Click on Import.

A window opens displaying the selected directory with the following:

• the AAF files imported in a directory called [sequence]_shotEdit_v[version].xml under the
directory you selected in the Flix Editorial UI,

• an ALE file, containing dialogue changes and information on panel order, imported in the
directory you selected in the Flix Editorial UI, and

• amarker.txt file, if you had markers in your Flix sequence, imported in an importExtras
directory under the directory you selected in the Flix Editorial UI.

8. Close the Flix Editorial interface.

In Avid

TIP: We recommend you use two bins for the following steps, one for the sequence (ALE bin)
and one for the media (AAF bin).

1. From the directory, where the AAF, ALE and markers.txt files were imported, drag the imported
ALE file to the ALE bin.

Offline clips (no media) are created in Avid.

2. In the ALE bin, use the Sort column so that the offline clips appear in the same order as in Flix.

FLIX FOR EDITORIAL | FROM FLIX TO AVID



98

3. Select all the offline clips created by the ALE file and Alt+drag them to the Record monitor in the
Composer window.

A sequence is created using all the offline clips.

4. Rename your newly created sequence if necessary.

5. Drag the AAF files to the AAF bin.

The media is created in Avid.

6. Drag your sequence from the ALE bin to the AAF bin.

7. Select all items from the AAF bin, which means the AAF files and the sequence, right-click and
select Relink...

The Relink dialog opens.

8. Set the following parameters:

• Selected items in ALL open bins.

• Source Name set to Name.

9. Click on OK.

The offline media in your sequence is linked to the media created by the AAF files.

If you had markers in your Flix edit, do the following:

1. On the main menu bar, navigate to Tools >Markers.

The Markers dialog opens.

2. Click on the button at the bottom left of the Markers dialog.

3. Click on Import Markers.

The Import Markers dialog opens.

4. Select the markers.txt file and click on Open.

The markers from your Flix sequence are imported in your Avid sequence.

Publishing From Editorial to Flix
Importing files back into Flix can be done from both within the application and using the Flix Editorial
UI, and depends entirely on which method you are using.
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Preparing the MOV and EDL

NOTE: Flix can use FFmpeg or GStreamer to decode movies from Editorial. FFmpeg
supports a much wider range of video and audio codecs than GStreamer. If you are using
GStreamer, you need to use the DNxHD or Photo JPEG video codecs, and the audio needs to
be uncompressed.

Using Avid (8.2 and older) with FilmScribe

Within Media Composer, do the following:

1. Select Output > Filmscribe.

Filmscribe opens.

2. Navigate to File > Open.

The bin containing your sequence opens.

3. Double-click the sequence.

The sequence opens within the Cut List Tool dialog.
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4. In the Tracks panel, select the video tracks you want to import in to Flix and make sure the audio
tracks aren’t selected.

5. In the Lists panel, click on Global.

The Global Options appear on the right side of the dialog.

6. Make sure the following Global Options use the following settings:

• Template - Columnar

• Picture Conforming - A Roll (Single Strand)

• Using - KN Start

• Sound Conforming - lnk

• Running Footage as - 35mm 4p

• Master Durations - Frames

• Source Durations - Frames

• Master TC Track - TC1

Make sure the Icons option isn't selected.
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NOTE: If you want to use locators with Flix and Avid, make sure the Show event, show
locators parameter is set.

7. In the Lists panel, select the Assemble option and make sure to only highlight theMaster TC,
Name and Start TC fields.

8. In the Lists panel, select the Optical option. Click on the Same as Assemble List button and make
sure the following options are not checked:

• Key Frames,

• Optical Footage, and

• Page Breaks Between Opticals.
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Using Avid (8.3 and newer) with List Tool

Within Media Composer, do the following:

1. Select Output > List Tool.

Avid's List Tool opens.
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2. In the Input tab, select your sequence, and click Load…

3. In the Tracks panel, select the video tracks you want to import in Flix, and make sure the audio
tracks aren’t selected.

4. In the Formatting tab, make sure the following options use the listed settings:

• Output Format - Columnar

• Running As Mode - 35mm 4p

• Master Duration - Frames

• Source Duration - Frames

• Master TC Track - TC1

Make sure that the Show Icons option isn’t selected.
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NOTE: If you want to import markers from Avid to Flix, make sure the Shot events, show
markers parameter is set.

5. In the List Options tab, make sure the Assemble and Optical options are selected.
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6. Select the Assemble option and make sure the Include Opticals option is selected.

7. Make sure to only highlight theMaster TC, Name and Start TC fields.

8. Select the Optical option. Click on the Same as Assemble List button and make sure the
following options are not selected:

• Key Frames,

• Optical Footage, and

• Page Breaks Between Opticals.
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Using Premiere

Once you've finished making changes within Premiere and you are ready to publish the version back

FLIX FOR EDITORIAL | PUBLISHING FROM EDITORIAL TO FLIX



108

to Flix, follow the steps below:

1. In Premiere, with the sequence selected, navigate to File > Export > Final Cut Pro XML.

The Save Converted Project As dialog opens.

2. Save the sequence to a location on your machine or network.

3. In Premiere, with the sequence selected, navigate to File > Export >Media.

The Export Settings dialog opens.
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4. Select the Video tab.

5. Set the Video Codec to Photo - JPEG or Avid DNxHD.
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WARNING: The default 1080i/59.94 DNxHD 220 10-bit is not supported. Make sure to select
the codec corresponding to your sequence's resolution and framerate.

NOTE: The only supported video codecs are Photo - JPEG and Avid DNxHD.

6. Select the Audio tab.
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7. Set the Audio Codec to Uncompressed.

NOTE: The only supported audio codec is Uncompressed.
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8. Once you have set all the options above, click Export.

The Mov is created.

Publishing Back to Flix

Once you've reviewed the artists' work in Avid, Premiere, or Nuke Studio, you need to publish the
sequence back to Flix for them to see the changes and comments you've made.

NOTE: If the Flix launchers are installed on your machine, click on the Flix Options context
menu and select New Editorial Tab, see Flix Options Context Menu

To publish back to Flix using the Flix Editorial UI, do the following:

1. Click on Flix_Editorial launcher.

The Flix Editorial interface opens.

2. Click on the To Flix tab and click on the Flix Project Browser button to open the sequence you
want to publish your edited sequence back into.

The Project Browser dialog opens.
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3. Click on a project from the list, or search for a project by typing the name in the search bar.

Once you click on a project, the dialog updates to show you the available sequences for that
project.

4. Click on a sequence from the list, or search for a sequence by typing the name in the search bar.

The Project Browser dialog closes and the Flix Editorial interface opens.

5. Click onMovie and/or EDL button and select the required MOV and EDL.

The MOV path is populated in the top field and the EDL path is populated in the bottom field.
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NOTE: If the MOV and EDL files are stored in two different locations, click onMovie and/or
EDL button to select the MOV then click again onMovie and/or EDL button and select the
EDL.
If you are using Nuke Studio or Premiere, the EDL is an .xml file. If you are using Avid, the
EDL is a .txt or .ctl file.

6. Use the following parameters if required:

Control Action

Comment Adds a note to the version. ’From Editorial’ is automatically appended to
this by default.

To Branch Selects the branch to publish the sequence into.

Sets the published version to have restricted access. Only users who are
on the list of restricted users are able to see this version within Flix.

As Stills Sets the option for files with no recognizable file extension to be imported
as still images.

Unchecking this option imports all frames of the movie file and convert
them to .jpg files.

To Shotgun Publishes the sequence to Shotgun after it's been imported as a new
version in Flix.

7. Click on the To Flix button to publish the sequence back into Flix.

Once the publish is complete, the message Imported in Flix appears along with the following
information:

• Whether a panel comes in as a ref or relinks to an existing panel.

• In the case of a ref, whether it is a still or animated panel.

• The frame range for each panel.

• In the case of a ref, the existing panels to which the refs are related to.

• In the case of a ref, why it comes in as a ref and not as an existing Flix panel.

The new version of the sequence published from Editorial is displayed in your Project Browser.

NOTE: When an effect is added to a panel in Editorial, sending it back to Flix creates a ref
panel. To find the original panel to which a ref is related, use the Related control pop-up.
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Versioning Your Work
In this chapter, the topic of versioning panels and sequences is discussed in more detail, including
setting permissions for who can edit or access certain versions of a sequence.

Versioning
In collaborative workflows, versioning your work becomes extremely important. At any time,
someone else may be working on the same sequence you are working on and you need to keep
changes apart until they are sent to Editorial.

Versioning in Flix takes on many aspects. Edits to sequences are versioned by using the Save button.
Storyboard and animated panels are versioned by editing them in an external program then saving
them or using the Version Up button in the Edit workspace.

Dialogue can be added to panels without incrementing the version number. Simply click Save button
in the Dialogue workspace after adding dialogue to your panels.

NOTE: Versioning up a panel causes Flix to autosave your work, unless a previous action
caused an autosave in the last 5 minutes. Flix keeps track of up to 10 autosave snapshots,
after which the oldest is overwritten by the next autosave.

Permissions for Versioning
As you might expect, some shows don’t require every artist’s input and Editorial may decide to limit
who can see or change certain parts of a project at a certain time. This not only helps prevent
unnecessary amendments, but also allows project leads to better control what sequences are being
worked on, and by whom.

Managing permissions is something that is controlled by Flix administrators at your studio, the
Editorial department, or project leads. If you cannot make changes to a version, please refer to one of
these departments first to find out if you have the correct permissions.
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Version Control
Keeping versions of your work separate from other versions of the project is the first step in
maintaining an efficient collaborative workflow. Flix allows you to work on existing versions and to
create new versions of a sequence from existing versions. You can also send version changes to
Editorial, with or without comments. Comparing versions is also useful when making drastic changes
to a sequence or reviewing a sequence that has had many versions in a short space of time.

Accessing Previous and Current Versions
To access previous and current versions of a sequence in your project, follow the steps in Loading
Projects. If you want to create a new version for a sequence from an existing version, follow the steps
in Saving a New Version.

To reload the current version of the sequence:

1. With a sequence open in Flix, click on the Flix Project Browser button on the menu bar.

The Project Browser dialog opens to the version selection screen.

2. Either click the same version from the list, or click the Reload button.

Saving a New Version
If you want to create a new version before you start editing the sequence:

1. Open the Project Browser dialog.

2. Select the project and sequence you want to work on. Further instructions can be found in
Loading Projects.

3. Click the Start A Clean Version button from the version selection area of the dialog.

A clean, empty version of the sequence is opened.

If you want to save changes to a sequence you've already opened as a new version:

1. Navigate to the menu bar and click on the Save button.

You can only click Save if you've made changes since opening or last saving the version. If you
haven't made any changes, Save appears grayed out.

2. The sequence is saved under your login ID name with an incremented version number, the date,
and the time. The entry also appears in white to denote that the version was created by you.
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NOTE: If another user is attempting to save a new version of the same sequence that you are
working on, you may be given a different version number than you expected. Whichever user
saved their work first receives the next incremented version number.

Saving a Version of a Sequence to Another Branch
To save a version of your sequence from one branch to another, do the following:

1. Load the version of the sequence you require.

2. Click on the Flix Project Browser button.

The Project Browser dialog opens.

3. Click on the Branch dropdown menu and select a branch from the list.

4. Click on the Save To This Branch button.

Your sequence version is saved to the branch you selected.

Choosing Panel Versions
Individual panel versions can be incremented. When changes are made to a panel, the panel is
automatically versioned up. To version up a selected panel without editing it, click on the version up

button on the Edit Workspace toolbar.

If you know there are multiple versions of a single panel, indicated in the panel ID (for example 1022-
5 is version 5 of the panel 1022), and you want to revert the panel back to an older version:

1. In the Edit workspace, click on the bottom of the panel.

The Versions control pop-up appears.

2. Select the version of the panel you want from the thumbnails dropdown list.
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The Related control pop-up shows you the related panels of the selected panel. For instance, if an
effect has been added by Editorial to an existing Flix panel, the reference panel from Editorial is
related to this original one, or if a panel is generated from a Master .psd file and is imported in Flix.

Click on the + in the Related column to add the related panel to your sequence. Click on the Editing
Plug-in Group to open the related panel in Photoshop, StoryBoard Pro, Premiere, TVPaint Animation,
or your File Browser.

NOTE: The Related control pop-up shows the master panel, with the creation time closest to
the selected panel, at the top of the Related column. As for ref panels, the most recent
version appears at the top of the Related column.

Comparing Version Edits
Flix allows you to compare the version of the sequence you are working on with other versions. This
allows you to see, at a glance, whether individual panels have been added or deleted. To compare
versions, follow the instructions below.

1. In the Edit workspace, click on the Compare Edit button on theWorkspace toolbar.

The Compare Edit dialog appears.
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2. Select the version from the Compare to Edit dropdown menu and click Compare.

All of the panels in the sequence are reloaded in the Sequence Editor pane. Some may have
green or red icons. Green icons indicate that the panels are new, whereas red icons indicate that
the panels have been deleted from the compared version. These icons are displayed in the lower-
left corner of the panel. Panels that have not been added or deleted are not shown with an icon.

3. To remove the comparison icons, simply click the Compare Edit button again. The icons are
removed and the Sequence Editor pane appears as it does by default.

4. If you want to compare a different version, follow steps 1 and 2 again, selecting a different version
from the dropdown menu.

If you already have a version comparison active, you must first remove the compared version
icons, by following step 3, before you can select a new version.
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Reviewing Panels
Notes are pictographic representations of changes you or other users want made to a panel. Instead
of writing out notes about what needs to be changed, you can draw notes straight onto a panel in the
Viewer and save them for later. If you still want to discuss a panel with other users in-person, you
can highlight a panel to alert others that it needs to be changed, even if no specific note has been
drawn on the panel.

Draw Tools
The Draw tools in Flix allow you to add or review pictographic notes for selected panels. Once panels
are selected, and you can see one of the panels in the Viewer, you can add notes in any of the
workspaces except for Pitch by selecting the Draw button in the Viewer Controls pane. If a note has
already been added, you can also view or edit it, erase parts of it, or delete the notes entirely by
clicking on the buttons in the Draw toolbar.

Panel Highlights
Panel highlights simply flag panels in the Sequence Editor pane, and do not have any notes drawn
on the panel. The highlights can only be added or removed, there are no other states for this form of
note. Any changes made to highlighted panels, also removes the note highlight but it can be
preserved if the panel is versioned up before changes are made.

Comments
Comments help alert other users, including Editorial, what has changed in a version of the sequence.
These comments are not applied to specific panels, but to a sequence version as a whole. Comments
can also be added to the notification e-mail that the Editorial department receives when new versions
of a sequence are published.

Unlike notes, comments are actually written out and can be attached to the version of a sequence.
These can be used to notify other users of elements they may need to be aware of, such as important
changes, comments for the Editorial department, and whether or not aspects of the sequence are
final.
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Toggling the Draw Tools
You can use the Draw tools to add notes to panels.

• To toggle on the Draw tools, do the following:

In the Viewer Controls pane, click on the Draw button.

The Draw toolbar appears in the Viewer and the Viewer is partially grayed out. You can now
add notes on panels.

The Draw toolbar has three buttons on it:

• the Pencil button for drawing,

• the Eraser button for erasing parts of a note, and

• the Trash button to delete the note.

You can move the toolbar around wherever you want within the Viewer.

• To toggle off the Draw tools, do the following:

In the Viewer Controls pane, click on the Draw button again.

The Draw toolbar disappears from the Viewer. The notes you added to panels, if any, are just
hidden.

NOTE: If you close the Draw toolbar and need to get it back again, ensure that you still have
the Draw button in the Viewer Controls pane active, then right-click in the Viewer and
select Draw Tools from the dropdown menu.
The Draw toolbar opens in its last position before it was closed.

Adding Notes to a Panel in Flix
Follow the steps below to use the Draw tools for making notes in Flix:

1. Ensure the Draw tools are toggled on. See Toggling the Draw Tools.

2. Click on the Pencil button and draw directly onto the panel in the Viewer.
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3. When you are finished making notes to the panel, click on the Draw button again.

The note seems to disappear, but it’s actually only hidden. The panel is also marked with an
orange highlight in the Sequence Editor to notify other users that there is a note attached to this
panel.

NOTE: If you select multiple panels and open the Draw tools to draw on several panels at
once, the note appears on all selected panels, regardless of the context of the note. This also
works when erasing or deleting notes on multiple panels.

Adding Notes to a Panel in Photoshop
Follow the steps below to add notes on a panel in Photoshop:

1. Select the panel you want to add a note on.

2. Shift+click on the Add Note button.
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The panel opens in Photoshop.

3. Use Photoshop tools to add a note to the panel and save the panel.

The panel displays with an orange highlight in the Sequence Editor.

NOTE: To display the note in the Viewer, the Draw tools need to be toggled on in the
Viewer Controls pane. See Toggling the Draw Tools.

4. When you are finished adding notes to the panel, click on the Draw button again.

The note seems to disappear, but it’s actually only hidden.

NOTE: Select multiple panels and open them in Photoshop to draw on several panels at
once. The note appears on all selected panels, regardless of the context of the note. This also
works when erasing or deleting notes on multiple panels.

Deleting Notes
To delete a note, select the required panel and then click on the Trash button in the Draw toolbar.

Once you delete a note, or make changes to the panel so that the note is erased, the orange highlight
disappears from the panel in the Sequence Editor pane.

WARNING: When deleting notes from panels, make sure that you use the Trash button
on the Draw toolbar, and not the Trash button on theWorkspace toolbar, in the Edit
workspace, or else the panel itself is deleted.

Highlighting a Panel
To highlight a panel for later discussion, follow the steps below:

1. To highlight a panel without adding a note using the Draw tools, ensure that you are in the Edit
workspace, and select the panel.

2. Click the Add Note button.

The panel is highlighted in orange.

3. To remove the highlight, click on the Draw button in the Viewer Controls pane, and click on the
Trash button.

Alternatively, any changes made to the panel removes the highlight and resets the notes. If you
want to preserve the highlight, you can version up the panel before making any changes.
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NOTE: You can highlight multiple panels and remove highlights from multiple panels by
selecting all the relevant panels in the Sequence Editor pane before clicking on the Add
Note button on theWorkspace toolbar, in the Edit workspace, or the Trash button in
the Draw tools respectively.

Adding Comments
To add comments to a sequence, follow the steps below:

1. Click on the Comments entry box on the menu bar.

2. Type the comments you want appended to the version and click Save to save a new version with
your comments.

Comments that you've added to other versions are also saved in the comment dropdown list.
Before you save again, you can either write out a new comment or select one from those you've
previously saved.

3. To send your comments to Editorial, export your sequence using the method described in
Publishing to Editorial then type your comments in the comment entry box in the Publishing to
Editorial dialog that appears.

When the sequence is sent to Editorial, the comments are included in the e-mail notification that’s
sent with the changes.

NOTE: Remember, these comments should be kept as brief as possible, as there is not as
much space to display them in the Version dropdown menu. There is a limit of 50
characters.

If you want your comments to be appended to the version, and you want to send the comments
to Editorial as well, the comments need to be saved and sent to Editorial separately. Sending the
comments as part of the e-mail to Editorial does not automatically add them to the version.

NOTE: To edit comments, refer to Editing Comments of a Sequence Version.
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Creating Sequence PDF Files
Flix allows you to create a .pdf file of an entire sequence, with accompanying dialogue. This .pdf file is
useful for offline review and collaboration, or for keeping notes on changes you want to make to a
sequence when you don’t have access to Flix.

NOTE: You can also customize .pdf files for your studio, to include company logos, fonts,
and so on.
For more details on how to customize .pdf files, refer to the Flix Technical Guide in the Setting
Parameters section.

Creating PDF Files
With a project, sequence, and version loaded in Flix:

1. In the Edit workspace, click the PDF button in theWorkspace toolbar.

The .pdf file is compiled and created. If you are working on a long sequence, this may take a few
minutes. A progress dialog appears to notify you when the .pdf has finished.

To change how many panels you want to display per page in the .pdf file, refer to Changing PDF
Settings.

2. When the .pdf file is completed, it opens in a new browser tab and in a file browser on your
machine.

The sequence that opens in a new browser tab gives you a preview of the .pdf file, labeled with
the project, sequence, and version information.

The file browser that opens displays the .pdf file saved to your machine under FLIX_
ROOT/show/seq.sequence.story/flix/editorial/pdf/.The .pdf file is created from the name of
the project, sequence, and version, as well as the number of panels per page.

NOTE: If a .pdf with the same number of panels per page has already been created for the
sequence, a new file isn't generated. Instead, the existing file is opened.

3. Open the .pdf file as you would with any other to review the sequence, or send the file out to
others.

Regardless of whether you are viewing the generated files in the browser tab or by opening the
.pdf file, panels that are marked as New are the ones that haven't been published yet.
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Changing PDF Settings
By default, the PDF button creates .pdf files that display the sequence 9 panels per page,
regardless of how they are sized in the Sequence Editor pane. This is indicated by the 9 on the PDF
button. To change how many panels appear per page:

1. Click PDF button until the list of the dropdown menu appears.

The dropdown menu shows options for printing 1, 3, 4, or 9 panels per page. Depending on the
length of your sequence, this dictates how many pages long the generated .pdf file is.

2. Select the option you want.

3. Once you have selected a new number of panels, the number on the PDF button changes to
reflect this, and you can click the button to create the .pdf file with the selected number of panels
per page. The number of panels is also appended to the .pdf file name in order to differentiate it
from any other generated files of the same sequence.
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Connecting to Flix Channels
Flix offers the ability for multiple people to connect in channels to review changes within Flix that are
being made on the fly. Notes can be added in the channel while you work in full visibility of everyone
in the channel.

Creating a Channel
There are two ways to use the Flix Connect functionality: you can create a channel and invite others
to join you, or you can join an existing channel that someone else has created. Creating a channel
makes you the host of the channel and sets your Flix browser as the host that others view when they
join the channel.

Connecting to a Channel
If a connect channel has already been created by another user, you can join them by selecting their
channel from the Flix Connect channel selection dropdown menu. Everyone who is part of a channel
is able to view the host Flix browser, and both the host and invited users can interact with the Flix
browser to make notes or changes.

NOTE: You can switch sequences while in Flix Connectmode, however if you switch shows,
the connection is lost.

Setting Up a Channel
To set up a Connect channel and invite others to join you, do the following:

NOTE: To create a new channel, you must first select a show.

1. Click on the Flix Project Browser button.

The Project Browser dialog opens.

2. Click on the Connect button.

OR

On the status bar, click on Connect.
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The Flix Connect dialog displays.

3. Type the name of the channel you want to create in the entry box and click New.

The channel is created and you are automatically added to it. The Connect button on the status
bar turns green to indicate that you have connected to a channel.

4. Click on the Connected button in the Project Browser dialog or on the status bar again to view
the channel status.

The Flix Connect dialog displays the name of the channel you are in and lists the artists currently
in the channel.

5. You can leave the channel at any time by clicking Disconnect in the Flix Connect dialog.

NOTE: If you are the creator of the channel and you disconnect from Flix Connect, the
channel continues to stay active until everyone using it leaves the channel.

Anyone can join your channel once it has been created. To understand how they can do this, or to
learn how to join an existing channel, please see Joining a Channel.
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Joining a Channel
To join an existing Flix Connect channel, follow the steps below:

1. Click on the Flix Project Browser button.

The Project Browser dialog opens.

2. Click on the Connect button.

OR

On the status bar, click on Connect.

The Flix Connect dialog displays.

3. Click on a channel from the list.

NOTE: If there are no channels listed, then there are currently no active channels available.
To create your own channel, see Setting Up a Channel for more information.

4. Click on the Join button in the dialog.

You join the selected connect channel. The Connect button changes to a green
Connected button on the status bar to indicate that you have connected to a channel.

5. Click on the Connect button in the Project Browser dialog or on the status bar again to view the
channel status. The Flix Connect dialog displays the name of the channel you are in and lists the
artists currently in the channel.

You can leave the channel at any time by clicking Disconnect in the Flix Connect dialog.
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Pitching Sequences
Periodically, you may want to pitch a sequence to others involved in the project. For this, you want to
pull together the latest versions of your panels, all the dialogue, and all audio files to create a
complete sequence for presentation.

The Pitch View
When you enter the Pitch workspace, the Viewer is expanded to full screen. In the Pitch workspace,
the entire sequence is contained in the Viewer, including panels, dialogue, and audio files.

The sequence begins with the panel that was selected when in one of the other workspaces. The
order of the sequence in the Pitch workspace matches that shown in the Sequence Editor pane in
the Edit workspace. Even unsaved changes to the panel order are shown in the Pitch workspace. This
allows you to preview the order of the panels within a sequence before saving your changes to a new
version.

When you are in the Pitch workspace, you don’t have to enable the dialogue or audio files separately.
Once you begin playing the sequence in the Pitch workspace, the dialogue and audio files
accompanying the panels play as well, as long as they are set up correctly.

In the Pitch workspace, you can also edit the duration of each panel of the sequence by recording a
new duration manually while you pitch the sequence.
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Displaying Dialogue
When in full screen mode, the dialogue is displayed on either the top or the bottom of the Viewer.
You can toggle between these two locations by pressing Tab at any time when in the Pitch view.

To remove dialogue, so that it doesn’t appear in the Pitch view:

1. Ensure that you are in any of the other workspaces, other than Pitch view (Edit or Dialogue).

2. In the Viewer Controls pane, click on the Dialogue button if it’s active.
When the Dialogue button is active, the button appears darker and dialogue is displayed below
the panel in the Viewer.
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3. After the Dialogue button is inactive, switch to the Pitch view.

Dialogue associated with the sequence does not appear in the Viewer and pressing Tab now has
no affect.

Using Full Screen Controls

Making the Viewer Full Screen

Switching to the Pitch workspace, automatically puts Flix in full screen mode. You won’t have to do
anything more than switch workspaces. You can leave full screen mode at any time by pressing the
Esc keyboard hotkey. Leaving full screen mode returns you to the previous workspace you were using
before switching to Pitch.

Using Pitch UI Controls

There are controls at the bottom of the screen for playing a sequence or stepping through the panels
manually in full screen mode, and to record panel duration while pitching the sequence.
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Pitch Mode Controls

Controls Actions

Plays from the current panel and plays through to the end of the sequence.

Pauses the sequence playback.

Moves forward one panel.

Moves backward one panel.

Jumps to the first panel in the sequence.

Jumps to the last panel in the sequence.

Exits the full screen mode.

TimerMode Controls

When Timer Mode is active, the following controls are available:

Controls Actions

Activates the Timer mode.

Deactivates the Timer mode.

Starts panel duration recording.

Stops panel duration recording.

Selects a microphone to record panel duration with audio. (The icon is white in the
UI. For the purposes of this guide, white icons appear gray.)

Indicates that a microphone is selected.
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Controls Actions

Indicates that there is no microphone on your machine.

Enables the audio playback while recording panel duration. (The icon is white in the
UI. For the purposes of this guide, white icons appear gray.)

The audio playback is enabled.

Indicates that there is no audio in the sequence.

NOTE: The toolbar disappears if you don't move the pointer around. To have the toolbar
displayed at all times, leave the pointer on the toolbar.

Using Keyboard Shortcuts

You can play a sequence or step through the panels manually in full screen mode, and you can record
panel duration while pitching the sequence. To do this, use the keyboard shortcuts.

To play a sequence, press Spacebar on the keyboard. The sequence begins playing from the currently
selected panel and plays through to the end of the sequence. To pause sequence playback, press the
Spacebar again, or press any of the other step through controls.

If you prefer to step through the sequence one panel at a time, use the following controls:

• Press the right arrow key to move forward one panel,

• Press the left arrow key to move backward one panel,

• Press the up arrow key three times in quick succession to jump to the first panel in the sequence,

• Press the down arrow key three times in quick succession to jump to the last panel in the
sequence,

• Press A to add an audience to the Viewer, or

• Press Esc to exit full screen mode.
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While stepping through the sequence, pressing N toggles the panel ID on or off. If the panel ID is
active, it appears in the upper left corner of the screen. However, if the sequence is played through,
the panel ID is automatically disabled.

To record panel duration, use the following controls:

• Press the T key to activate the Timer mode,

• Press the R key to start the panel duration recording,

• Press the P key to enable the audio playback while recording panel duration, or

• Press theM key to display the microphones available for recording audio.

NOTE: For a full list of keyboard shortcuts in Flix, please refer to Appendix A: Keyboard
Shortcuts.

Editing Panel Duration in Pitch Mode
Flix allows you to edit the duration of the panels by letting you record a new duration for each panel
while you pitch a sequence. There are three recording options, you can record without audio, you can
also record with the existing audio of the sequence, and you can record with audio to add your own
comments for instance.
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Recording Duration with No Audio

You can record the duration of each panel with no sound at all.

To record without audio, do the following:

1. Switch to the Pitch workspace and click on Allow to switch to the full screen Viewer.

The Pitch full screen Viewer is on.

2. Click on the Timer button in the bottom toolbar or press the T key on your keyboard to
activate the Timer mode.

The Timer mode is now active, and the recording buttons appear in the toolbar.

3. Click on the Start Recording button or press the R key to start recording.

The recording starts.

In the red bar at the top of the screen, the Time and the Duration timers are running.

4. As soon as you reach the required duration, either click on the Forward button or press the
right arrow key to move to the next panel.

Simply by switching to the next panel, you stop the recording for the current panel and start the
recording for the next one.

5. Keep recording the duration for each panel until the end of the sequence or click on the Stop

Recording button to stop the recording, then click on the Exit button or press Esc key to
exit the Pitch full screen Viewer.

The panel duration is now edited.
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NOTE: The No Audio icon indicates that there is no audio in the sequence.

NOTE: You can check the new recorded duration of each panel in any other workspace (Edit
or Dialogue) in the Viewer Controls pane.

Recording Duration with Existing Audio

You can record the duration of each panel along with the existing audio.

To record with the existing audio, do the following:

1. Switch to the Pitch workspace and click on Allow to switch to the full screen Viewer.

The Pitch full screen Viewer is on.

2. Click on the Timer button in the bottom toolbar or press the T key on your keyboard to
activate the Timer mode.

The Timer mode is now active, and the recording buttons appear in the toolbar.

3. Click on the Enable Audio button or press the P key to enable the audio playback.

The Audio icon is displayed in the Timer mode bar at the top of the screen indicating that the
audio playback is now enabled.

4. Click on the Start Recording button or press the R key to start recording.

The recording starts.

In the red bar at the top of the screen, the Time and the Duration timers are running.

5. As soon as you reach the required duration, either click on the Forward button or press the
right arrow key to move to the next panel.

Simply by switching to the next panel, you stop the recording for the current panel and start the
recording for the next one.

6. Keep recording the duration for each panel until the end of the sequence or click on the Stop

Recording button to stop the recording, then click on the Exit button or press the Esc key
to exit the Pitch full screen Viewer.

The panel duration, along with the existing audio, is now edited.

NOTE: The No Audio icon indicates that there is no audio in the sequence.

NOTE: You can check the new recorded duration of each panel in any other workspace (Edit
or Dialogue) in the Viewer Controls pane.
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Recording Duration with New Audio

You can record the duration of each panel along with audio, such as your own voice.

To record with audio, do the following:

1. Switch to the Pitch workspace and click on Allow to switch to the full screen Viewer.

The Pitch full screen Viewer is on.

2. Click on the Timer button in the bottom toolbar or press the T key on your keyboard to
activate the Timer mode.

The Timer mode is now active, and the recording buttons appear in the toolbar.

3. Click on the Select Microphone button or press theM key and select a microphone from the
list.

The Selected Microphone icon turns green in the bottom toolbar and is displayed in the Timer
Mode bar at the top of the screen indicating that the microphone is ready to record audio.

WARNING: When you click on the Select Microphone button, Flix might not show the list
of available devices. To allow Flix to access your microphones, do the following:

1. Click on the Select Microphone button, in the Microphone list, click on the location
where the first device should be displayed, and start recording.
A dialog pops up at the top of your screen.
2. Click on Allow.
3. Stop recording, exit the Pitch mode, and go back to the Pitch mode again.

The Microphone Select Microphone icon now lists every available microphone.

4. Click on the Start Recording button or press the R key to start recording.

The Overwrite audio track dialog opens.

5. Click on Start Recording.

The recording of the duration, along with the audio, starts.

In the red bar at the top of the screen, the Time and the Duration timers are running.

6. As soon as you reach the required duration, either click on the Forward button or press the
right arrow key to move to the next panel.

Simply by switching to the next panel, you stop the recording for the current panel and start the
recording for the next one.
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7. Keep recording the duration for each panel until the end of the sequence or click on the Stop

Recording button to stop the recording, then click on the Exit button or press the Esc key
to exit the Pitch full screen Viewer.

The panel duration, along with the newly recorded audio, is now edited.

NOTE: The No Microphone icon indicates that there is no microphone on your machine.

NOTE: You can check the new recorded duration of each panel in any other workspace (Edit
or Dialogue) in the Viewer Controls pane.
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Resync Service
This chapter explains how Flix's Resync service works. It allows remote studios and studios working
with remote artists to have a better understanding of which files have been synced and which ones
still need to be copied over to the master studio locations, remote studio locations, and remote user
locations.

Resync Service Status
The Resync service button at the bottom left of the Flix status bar shows whether Flix is busy syncing
files over to the master studio locations, remote studio locations, and remote user locations:

Icon Icon description Status Description

White and
rotating

Syncing: nn remaining (where nn is any number greater than zero).

Gray There are no files syncing.

Red File syncing has failed.
Please contact your system administrator to make sure the File and
Resync services are set up and running.

Syncing Information
If you click the Resync service button when it is resyncing, a pop-up displays with a list of files waiting
to be resynced. To close the pop-up, click anywhere outside the pop-up. The list is automatically
closed when the next check returns no filenames. The pop-up list has five columns:

• File size

• Filename

• User

• Server Name

• Company
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You can hover over any file to display its full file path. If the filename is too long to fit, the name is
truncated and an ellipsis is shown at the end of the file name column for that filename. If the
filename is truncated, just hover over the filename column to see the full filename.

NOTE: All the files that Flix failed to resync after three attempts are listed in an e-mail sent to
your internal support team, using the [emailSupport] parameter, refer to the Flix Technical
Guide in the Setting Paramaters section.

RESYNC SERVICE |
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Appendix A: Keyboard
Shortcuts

General Project

Open panel in
Photoshop

Ctrl/Cmd+Enter Save Ctrl/Cmd+S

Reveal Original in
Finder

(Reveal Original in File
Browser for Windows
and Linux)

Ctrl+R Undo Ctrl/Cmd+Z

Pitch Edit

Next Panel Right arrow Cut Panels Ctrl/Cmd+X

Previous Panel Left arrow Copy Panels Ctrl/Cmd+C

Jump to Beginning of
Sequence

Up arrow pressed
three times in quick
succession

Paste Panels Ctrl/Cmd+V

Jump to End of
Sequence

Down arrow pressed
three times in quick
succession

Move Panels Alt+arrow

Play Sequence Spacebar Go to the next panel's
dialogue box

Shift+Return
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Pitch Edit

Toggles Dialogue from
Top to Bottom

Tab Switch to the
previous/next panel’s
dialogue box

Ctrl/Cmd+Left/Right

Toggle Panel ID N

Add an Audience to the
Viewer

A

Exit Full Screen Mode Esc

Activate the Timer
mode

T

Start the panel
duration recording

R

Enable the audio
playback while
recording panel
duration

P

Display the
microphones

M

APPENDIX A: KEYBOARD SHORTCUTS |
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Appendix B: Supported File
Formats

The following table lists the supported file formats in Flix. The extensions listed under “Extension” let
you specify the file format; use these as the actual filename extensions or the prefix to indicate
output format.

Format Bit Depths Read/Write Extension Notes

EXR Compression

EXR file metadata contains a compression key/value pair detailing the compression type used to
write the .exr file. The value is expressed as the name of the compression type or an integer
referencing the compression used:

0 - no compression

1 - RLE compression, run length encoding

2 - Zip compression, one scan line at a time

3 - Zip compression, in blocks of 16 scan lines

4 - PIZ-based wavelet compression, in blocks of 32 scan lines

5 - PXR24 compression, lossy 24-bit float

6 - B44 compression, lossy 4-by-4 pixel block, fixed rate

7 - B44A compression, lossy 4-by-4 pixel block, flat fields are compressed more

FPI obsolete

JPEG 8 read and
write

jpg, jpeg Adjust compression levels using the quality
slider in the Write node’s properties panel.

Maya IFF 8 and 16 read only iff
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Format Bit Depths Read/Write Extension Notes

OpenEXR

and

OpenEXR
2.0

16 and 32 read and
write

exr OpenEXR handles 16- and 32-bit float. This 16
is also called "half float" and is different from
the 16-bit integer that all the other formats
that support 16-bit use.

Note: To read and write scanline deep
OpenEXR 2.0 files, use the DeepRead and
DeepWrite nodes.

PNG 8 and 16 read and
write

png (8-bit)

png16 (16-
bit)

PSD 8 and 16 read only psd While Flix reads standard Photoshop® blend
modes, it doesn't read layer comps or
recognize group blend modes. Layers are
read into separate Flix channel sets and
anything that doesn't map into that is ignored.

Q
uickTime

n/a read and
write

mov QuickTime is only supported by default on
Windows and Mac OS X. To use QuickTime
files on Linux, you need to use the prefix
ffmpeg: before the file path and file name, for
example,
ffmpeg:\z:\job\FILM\IMG\final_comp_
v01.####.mov. When working with Write
nodes, you can also choose ffmpeg from the
file type dropdown menu and use mov as the
file extension. This way, Flix will use its
reader/writer that is based on the FFmpeg
open source library to decode/encode
QuickTime files.

Radiance 16 read and
write

hdr, hdri This format stores an 8-bit mantissa for each
of r, g, and b and an additional 8-bit exponent
that is shared by all three, which packs the
floating point RGB triplet into 32 bits per
pixel.

APPENDIX B: SUPPORTED FILE FORMATS |
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Format Bit Depths Read/Write Extension Notes

SGI 8 and 16 read and
write

sgi, rgb,
rgba (8-bit
sequences)

sgi16 (for
16-bit
sequences)

SoftImage
®

PIC

8 read and
write

pic

TIFF 8, 16, and
32

read and
write

tif, tiff (8-
bit
sequences)

tif16, tiff16
(16-bit
sequences)

ftif, ftiff
(32-bit
sequences)

If utilized, the compression schema on
imported TIFF sequences must be LZW®.

T
ruevision
® TARGA

8 read and
write

tga, targa

APPENDIX B: SUPPORTED FILE FORMATS |
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Appendix C: External Software
This appendix lists third-party libraries and versions used in Flix along with their licenses.

Third-Party Library Versions

Library Version Library Version

Advanced Authoring
Format (AAF)

1.1.6 libMXF++ 1.0.3

AlivePDF 2012.2 libPNG 1.6.3

Avid DNxHD 1.4.2 Mako 0.9.0

bmx 0.1.2 Avid MetaFuze 2.1.2

CherryPy 3.2.0 pyamf 0.5.3

GLib 2.32.0 Python 2.6.8

GStreamer Core and
Plug-ins

1.2.1 Python requests 1.2.3

LAME 3.99.5 PyYAML 3.10

Libffi 3.0.0 stdlib.js 1.5

Libjpeg v9 transformations.py 2012.01.01

libMXF 1.0.3 uriparser 0.7.9

147



148

Third-Party Licenses

Library Description License

Advanced
Authoring Format
(AAF)

SDK library AAF SDK PUBLIC SOURCE LICENSE AGREEMENT
Version 2.0
November 2008

For the Advanced Authoring Format license, see Advanced
Authoring Format SDK Public Source License Agreement on
page 178.

AlivePDF Client-side
ActionScript3
PDF generation

The MIT License (MIT)
Copyright (c) 2007 Thibault Imbert

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall
be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY
OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF
OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

APPENDIX C: EXTERNAL SOFTWARE | THIRD-PARTY LICENSES
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Library Description License

Avid DNxHD HD codec Avid Technology, Inc.
Avid DNxHD Codec Source Code
End-User License Agreement (EULA) V1.0

For the full EULA and copyright notice, see Avid DNxHD
Codec Source EULA.

APPENDIX C: EXTERNAL SOFTWARE | THIRD-PARTY LICENSES
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Library Description License

bmx Library for the
Broadcast
Media Exchange
format
supporting MXF
files

Copyright (C) 2013, British Broadcasting Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of the British Broadcasting Corporation
nor the names of its contributors may be used to endorse
or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

APPENDIX C: EXTERNAL SOFTWARE | THIRD-PARTY LICENSES
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Library Description License

CherryPy Python web
framework

Copyright (c) 2004-2011, CherryPy Team
(team@cherrypy.org) All rights reserved. Redistribution and
use in source and binary forms, with or without
modification, are permitted provided that the following
conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of the CherryPy Team nor the names of its
contributors may be used to endorse or promote products
derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

APPENDIX C: EXTERNAL SOFTWARE | THIRD-PARTY LICENSES
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Library Description License

GLib Gnome Core
library

This software uses code from GLib licensed under the
LGPLv2.28.

For the LGPL, see GNU Lesser General Public License on
page 166.

GStreamer Core
and Plug-ins

Library for
constructing
graphs of
media-handling
components

This software uses code from GStreamer licensed under the
LGPLv2.1. If you wish to receive a copy of the source code
used, please contact Customer Support directly through the
Support Portal at the following address:
https://supportportal.thefoundry.co.uk

For the LGPL, see GNU Lesser General Public License on
page 166.

LAME MP3 encoder This software uses code from LAME licensed under the
LGPLv2.1.

For the LGPL, see GNU Lesser General Public License on
page 166.
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Library Description License

Libffi Foreign
Function
Interface library

Copyright (c) 1996-2012 Anthony Green, Red Hat, Inc and
others.

See source files for details.

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall
be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY
OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF
OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

APPENDIX C: EXTERNAL SOFTWARE | THIRD-PARTY LICENSES
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Library Description License

Libjpeg Joint
Photographic
Experts Group
library

The authors make NOWARRANTY or representation, either
express or implied, with respect to this software, its quality,
accuracy, merchantability, or fitness for a particular
purpose. This software is provided "AS IS", and you,its user,
assume the entire risk as to its quality and accuracy.

This software is copyright (C) 1991-2013, Thomas G. Lane,
Guido Vollbeding.

All Rights Reserved except as specified below.

Permission is hereby granted to use, copy, modify, and
distribute this software (or portions thereof) for any
purpose, without fee, subject to these conditions:

(1) If any part of the source code for this software is
distributed, then this README file must be included, with
this copyright and no-warranty notice unaltered; and any
additions, deletions, or changes to the original files must be
clearly indicated in accompanying documentation.

(2) If only executable code is distributed, then the
accompanying documentation must state that "this software
is based in part on the work of the Independent JPEG
Group".

(3) Permission for use of this software is granted only if the
user accepts full responsibility for any undesirable
consequences; the authors accept NO LIABILITY for
damages of any kind.

These conditions apply to any software derived from or
based on the IJG code, not just to the unmodified library. If
you use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author's
name or company name in advertising or publicity relating
to this software or products derived from it. This software
may be referred to only as "the Independent JPEG Group's
software".

We specifically permit and encourage the use of this
software as the basis of commercial products, provided that
all warranty or liability claims are assumed by the product
vendor.
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Library Description License

The Unix configuration script "configure" was produced with
GNU Autoconf. It is copyright by the Free Software
Foundation but is freely distributable. The same holds for its
supporting scripts (config.guess, config.sub, ltmain.sh).
Another support script, install-sh, is copyright by X
Consortium but is also freely distributable.

The IJG distribution formerly included code to read and
write GIF files. To avoid entanglement with the Unisys LZW
patent, GIF reading support has been removed altogether,
and the GIF writer has been simplified to produce
"uncompressed GIFs". This technique does not use the LZW
algorithm; the resulting GIF files are larger than usual, but
are readable by all standard GIF decoders.

We are required to state that "The Graphics Interchange
Format(c) is the Copyright property of CompuServe
Incorporated. GIF(sm) is a Service Mark property of
CompuServe Incorporated."

libMXF Material
Exchange
Format library

Copyright (C) 2013, British Broadcasting Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.
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Library Description License

Neither the name of the British Broadcasting Corporation
nor the names of its contributors may be used to endorse
or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

libMXF++ MXF library
wrapper for C++

Copyright (C) 2013, British Broadcasting Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.
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Library Description License

Neither the name of the British Broadcasting Corporation
nor the names of its contributors may be used to endorse
or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Library Description License

libPNG Library for
Portable
Network
Graphics

This copy of the libpng notices is provided for your
convenience. In case of any discrepancy between this copy
and the notices in the file png.h that is included in the
libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices
immediately following this sentence.

This code is released under the libpng license.

libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18,
2013, are Copyright (c) 2004, 2006-2013 Glenn Randers-
Pehrson, and are distributed according to the same
disclaimer and license as libpng-1.2.5 with the following
individual added to the list of Contributing Authors: Cosmin
Truta.
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Library Description License

libpng versions 1.0.7, July 1, 2000, through 1.2.5 - October 3,
2002, are Copyright (c) 2000-2002 Glenn Randers-Pehrson,
and are distributed according to the same disclaimer and
license as libpng-1.0.6 with the following individuals added
to the list of Contributing Authors: Simon-Pierre Cadieux,
Eric S. Raymond, Gilles Vollant, and with the following
additions to the disclaimer:

There is no warranty against interference with your
enjoyment of the library or against infringement. There is no
warranty that our efforts or the library will fulfill any of your
particular purposes or needs. This library is provided with
all faults, and the entire risk of satisfactory quality,
performance, accuracy, and effort is with the user.

libpng versions 0.97, January 1998, through 1.0.6, March 20,
2000, are Copyright (c) 1998, 1999 Glenn Randers-Pehrson,
and are distributed according to the same disclaimer and
license as libpng-0.96, with the following individuals added
to the list of Contributing Authors: Tom Lane, Glenn
Randers-Pehrson, Willem van Schaik.

libpng versions 0.89, June 1996, through 0.96, May 1997, are
Copyright (c) 1996, 1997 Andreas Dilger

Distributed according to the same disclaimer and license as
libpng-0.88, with the following individuals added to the list
of Contributing Authors: John Bowler, Kevin Bracey, Sam
Bushell, Magnus Holmgren, Greg Roelofs, Tom Tanner.

libpng versions 0.5, May 1995, through 0.88, January 1996,
are Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42, Inc.

For the purposes of this copyright and license, "Contributing
Authors" is defined as the following set of individuals:
Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul
Schmidt, Tim Wegner.
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Library Description License

The PNG Reference Library is supplied "AS IS". The
Contributing Authors and Group 42, Inc. disclaim all
warranties, expressed or implied, including, without
limitation, the warranties of merchantability and of fitness
for any purpose. The Contributing Authors and Group 42,
Inc. assume no liability for direct, indirect, incidental,
special, exemplary, or consequential damages, which may
result from the use of the PNG Reference Library, even if
advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and
distribute this source code, or portions hereof, for any
purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be
misrepresented.
2. Altered versions must be plainly marked as such and
must not be misrepresented as being the original source.
3. This Copyright notice may not be removed or altered
from any source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically
permit, without fee, and encourage the use of this source
code as a component to supporting the PNG file format in
commercial products. If you use this source code in a
product, acknowledgment is not required but would be
appreciated.

A "png_get_copyright" function is available, for convenient
use in "about" boxes and the like:

printf("%s",png_get_copyright(NULL));

Also, the PNG logo (in PNG format, of course) is supplied in
the files "pngbar.png" and "pngbar.jpg (88x31) and
"pngnow.png" (98x31).

Libpng is OSI Certified Open Source Software. OSI Certified
Open Source is a certification mark of the Open Source
Initiative.

Glenn Randers-Pehrson
glennrp at users.sourceforge.net
July 18, 2013
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Library Description License

Mako Mako
Templates for
python module

This is the MIT license:
http://www.opensource.org/licenses/mit-license.php

Copyright (C) 2006-2013 the Mako authors and contributors
<see AUTHORS file>.

Mako is a trademark of Michael Bayer.

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall
be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY
OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF
OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

Avid MetaFuze MXF encoder Can not distribute but free to download at
http://www.avid.com/US/industries/workflow/MetaFuze
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Library Description License

pyamf File format
support

Copyright (c) 2007-2010 The PyAMF Project. All rights
reserved.

Arnar Birgisson
Thijs Triemstra
Nick Joyce

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated
documentation files (the “Software”), to deal in the Software
without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall
be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY
OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF
OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

Python Source code
language

Copyright © 2001, 2002, 2003, 2004 Python Software
Foundation; All Rights Reserved.

Python requests This software uses code from Python Requests licensed
under the Apache License, Version 2.0.

For the Apache license, see Apache License, Version 2.0 on
page 174.
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Library Description License

PyYAML Python YAML
library

Copyright (c) 2006 Kirill Simonov

Permission is hereby granted, free of charge, to any person
obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to
whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall
be included in all copies or substantial portions of the
Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY
OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE WARRANTIES OF MERCHAN ABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF
OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.

stdlib.js JavaScript
functions

This software uses code from xtools licensed under the
LGPLv2.1.

For the LGPL, see GNU Lesser General Public License on
page 166.
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Library Description License

transformations.py Homogeneous
Transformation
Matrices and
Quaternions

Copyright (c) 2006-2012, Christoph Gohlke
Copyright (c) 2006-2012, The Regents of the University of
California

Produced at the Laboratory for Fluorescence Dynamics
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of the copyright holders nor the names of
any contributors may be used to endorse or promote
products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Library Description License

uriparser liburiparser
library

uriparser - RFC 3986 URI parsing library

Copyright (C) 2007, Weijia Song <songweijia@gmail.com>
Copyright (C) 2007, Sebastian Pipping
<webmaster@hartwork.org>
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of the <ORGANIZATION> nor the names of
its contributors may be used to endorse or promote
products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS
AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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GNU Lesser General Public License

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 51 Franklin Street, Fifth Floor, Boston, MA
02110-1301 USA Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library
Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By
contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and
change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software
packages--typically libraries--of the Free Software Foundation and other authors who decide to use it.
You can use it too, but we suggest you first think carefully about whether this license or the ordinary
General Public License is the better strategy to use in any particular case, based on the explanations
below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public
Licenses are designed to make sure that you have the freedom to distribute copies of free software
(and charge for this service if you wish); that you receive source code or can get it if you want it; that
you can change the software and use pieces of it in new free programs; and that you are informed
that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights
or to ask you to surrender these rights. These restrictions translate to certain responsibilities for you
if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the
recipients all the rights that we gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must provide complete object files to the
recipients, so that they can relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this
license, which gives you legal permission to copy, distribute and/or modify the library.
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To protect each distributor, we want to make it very clear that there is no warranty for the free library.
Also, if the library is modified by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's reputation will not be affected by
problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to
make sure that a company cannot effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that any patent license obtained for a
version of the library must be consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License.
This license, the GNU Lesser General Public License, applies to certain designated libraries, and is
quite different from the ordinary General Public License. We use this license for certain libraries in
order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination
of the two is legally speaking a combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the entire combination fits its criteria of
freedom. The Lesser General Public License permits more lax criteria for linking other code with the
library.

We call this license the "Lesser" General Public License because it does Less to protect the user's
freedom than the ordinary General Public License. It also provides other free software developers
Less of an advantage over competing non-free programs. These disadvantages are the reason we use
the ordinary General Public License for many libraries. However, the Lesser license provides
advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of
a certain library, so that it becomes a de-facto standard. To achieve this, non-free programs must be
allowed to use the library. A more frequent case is that a free library does the same job as widely
used non-free libraries. In this case, there is little to gain by limiting the free library to free software
only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number
of people to use a large body of free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU operating system, as well as its
variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure
that the user of a program that is linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close
attention to the difference between a "work based on the library" and a "work that uses the library".
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The former contains code derived from the library, whereas the latter must be combined with the
library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND
MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice
placed by the copyright holder or other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently
linked with application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under
these terms. A "work based on the Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with
modifications and/or translated straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term "modification".)

"Source code" for a work means the preferred form of the work for making modifications to it. For a
library, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of
the library.

Activities other than copying, distribution and modification are not covered by this License; they are
outside its scope. The act of running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based on the Library (independent of
the use of the Library in a tool for writing it). Whether that is true depends on what the Library does
and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive
it, in any medium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this
License and to the absence of any warranty; and distribute a copy of this License along with the
Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer
warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based
on the Library, and copy and distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.
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b) You must cause the files modified to carry prominent notices stating that you changed the files and
the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the
terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an
application program that uses the facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in the event an application does not
supply such function or table, the facility still operates, and performs whatever part of its purpose
remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-
defined independent of the application. Therefore, Subsection 2d requires that any application-
supplied function or table used by this function must be optional: if the application does not supply
it, the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are
not derived from the Library, and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those sections when you distribute them
as separate works. But when you distribute the same sections as part of a whole which is a work
based on the Library, the distribution of the whole must be on the terms of this License, whose
permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely
by you; rather, the intent is to exercise the right to control the distribution of derivative or collective
works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a
work based on the Library) on a volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License
to a given copy of the Library. To do this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a
newer version than version 2 of the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General
Public License applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not
a library.
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4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object
code or executable form under the terms of Sections 1 and 2 above provided that you accompany it
with the complete corresponding machine-readable source code, which must be distributed under
the terms of Sections 1 and 2 above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place satisfies the requirement to
distribute the source code, even though third parties are not compelled to copy the source along with
the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with
the Library by being compiled or linked with it, is called a "work that uses the Library". Such a work, in
isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a
derivative of the Library (because it contains portions of the Library), rather than a "work that uses the
library". The executable is therefore covered by this License. Section 6 states terms for distribution of
such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the
object code for the work may be a derivative work of the Library even though the source code is not.
Whether this is true is especially significant if the work can be linked without the Library, or if the
work is itself a library. The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then the use of the object file is
unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work
under the terms of Section 6. Any executables containing that work also fall under Section 6, whether
or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that uses the Library"
with the Library to produce a work containing portions of the Library, and distribute that work under
terms of your choice, provided that the terms permit modification of the work for the customer's own
use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the
Library and its use are covered by this License. You must supply a copy of this License. If the work
during execution displays copyright notices, you must include the copyright notice for the Library
among them, as well as a reference directing the user to the copy of this License. Also, you must do
one of these things:
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a) Accompany the work with the complete corresponding machine-readable source code for the
Library including whatever changes were used in the work (which must be distributed under Sections
1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-
readable "work that uses the Library", as object code and/or source code, so that the user can modify
the Library and then relink to produce a modified executable containing the modified Library. (It is
understood that the user who changes the contents of definitions files in the Library will not
necessarily be able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one
that (1) uses at run time a copy of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will operate properly with a modified
version of the library, if the user installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the
materials specified in Subsection 6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer
equivalent access to copy the above specified materials from the same place.

e) Verify that the user has already received a copy of these materials or that you have already sent this
user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and
utility programs needed for reproducing the executable from it. However, as a special exception, the
materials to be distributed need not include anything that is normally distributed (in either source or
binary form) with the major components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries
that do not normally accompany the operating system. Such a contradiction means you cannot use
both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library
together with other library facilities not covered by this License, and distribute such a combined
library, provided that the separate distribution of the work based on the Library and of the other
library facilities is otherwise permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined
with any other library facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same work.
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8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly
provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or
distribute the Library is void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under this License will not have their
licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else
grants you permission to modify or distribute the Library or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library
(or any work based on the Library), you indicate your acceptance of this License to do so, and all its
terms and conditions for copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient
automatically receives a license from the original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any further restrictions on the
recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you from
the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations
under this License and any other pertinent obligations, then as a consequence you may not distribute
the Library at all. For example, if a patent license would not permit royalty-free redistribution of the
Library by all those who receive copies directly or indirectly through you, then the only way you could
satisfy both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right
claims or to contest validity of any such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is implemented by public license practices.
Many people have made generous contributions to the wide range of software distributed through
that system in reliance on consistent application of that system; it is up to the author/donor to decide
if he or she is willing to distribute software through any other system and a licensee cannot impose
that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Library under this License may
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add an explicit geographical distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General
Public License from time to time. Such new versions will be similar in spirit to the present version,
but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this
License which applies to it and "any later version", you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Library does not specify a license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution
conditions are incompatible with these, write to the author to ask for permission. For software which
is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the
free status of all derivatives of our free software and of promoting the sharing and reuse of software
generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY,
TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS
TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHOMAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY
AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE
OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH
ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries
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If you develop a new library, and you want it to be of the greatest possible use to the public, we
recommend making it free software that everyone can redistribute and change. You can do so by
permitting redistribution under these terms (or, alternatively, under the terms of the ordinary
General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to the start
of each source file to most effectively convey the exclusion of warranty; and each file should have at
least the "copyright" line and a pointer to where the full notice is found.

<one line to give the library's name and a brief idea of what it does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if
not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-
1301 USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a
"copyright disclaimer" for the library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for tweaking
knobs) written by James Random Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

Apache License, Version 2.0

Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
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1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is
granting the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are
controlled by, or are under common control with that entity. For the purposes of this definition,
"control" means (i) the power, direct or indirect, to cause the direction or management of such entity,
whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding
shares, or (iii) beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a
Source form, including but not limited to compiled object code, generated documentation, and
conversions to other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by
name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition,
"submitted" means any form of electronic, verbal, or written communication sent to the Licensor or
its representatives, including but not limited to communication on electronic mailing lists, source
code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor
for the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."
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"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a
Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to
reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute
the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License.

Subject to the terms and conditions of this License, each Contributor hereby grants to You a
perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this
section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the
Work, where such license applies only to those patent claims licensable by such Contributor that are
necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the
Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity
(including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution
incorporated within the Work constitutes direct or contributory patent infringement, then any patent
licenses granted to You under this License for that Work shall terminate as of the date such litigation
is filed.

4. Redistribution.

You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium,
with or without modifications, and in Source or Object form, provided that You meet the following
conditions:

a. You must give any other recipients of the Work or Derivative Works a copy of this License; and

b. You must cause any modified files to carry prominent notices stating that You changed the files;
and

c. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those notices
that do not pertain to any part of the Derivative Works; and

d. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such NOTICE
file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of
the following places: within a NOTICE text file distributed as part of the Derivative Works; within the
Source form or documentation, if provided along with the Derivative Works; or, within a display
generated by the Derivative Works, if and wherever such third-party notices normally appear. The
contents of the NOTICE file are for informational purposes only and do not modify the License. You
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may add Your own attribution notices within Derivative Works that You distribute, alongside or as an
addendum to the NOTICE text from the Work, provided that such additional attribution notices
cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications, or
for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the
Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions.

Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the
Work by You to the Licensor shall be under the terms and conditions of this License, without any
additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify
the terms of any separate license agreement you may have executed with Licensor regarding such
Contributions.

6. Trademarks.

This License does not grant permission to use the trade names, trademarks, service marks, or
product names of the Licensor, except as required for reasonable and customary use in describing
the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty.

Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each
Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS
OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are
solely responsible for determining the appropriateness of using or redistributing the Work and
assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability.

In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise,
unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in
writing, shall any Contributor be liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a result of this License or out of the
use or inability to use the Work (including but not limited to damages for loss of goodwill, work
stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even
if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability.
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While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee
for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent
with this License. However, in accepting such obligations, You may act only on Your own behalf and
on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to
indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims
asserted against, such Contributor by reason of your accepting any such warranty or additional
liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work

To apply the Apache License to your work, attach the following boilerplate notice, with the fields
enclosed by brackets "[]" replaced with your own identifying information. (Don't include the brackets!)
The text should be enclosed in the appropriate comment syntax for the file format. We also
recommend that a file or class name and description of purpose be included on the same "printed
page" as the copyright notice for easier identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in
compliance with the License. You may obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is
distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express
or implied. See the License for the specific language governing permissions and limitations under the
License.

Advanced Authoring Format SDK Public Source License Agreement

AAF SDK PUBLIC SOURCE LICENSE AGREEMENT

Version 2.0

November 2008

THIS DOCUMENT IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR AN ENTITY) AND
THE CONTRIBUTORS TO THE ADVANCED AUTHORING FORMAT SOFTWARE DEVELOPMENT KIT ("AAF
SDK"). PLEASE READ THESE TERMS CAREFULLY BEFORE USING THE AAF SDK. THE CONTRIBUTORS ARE
WILLING TO LICENSE THE AAF SDK TO YOU ONLY UPON THE CONDITION THAT YOU ACCEPT ALL OF
THE TERMS AND CONDITIONS CONTAINED IN THIS LICENSE AGREEMENT. BY USING, INSTALLING, OR
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COPYING THE AAF SDK, YOU ARE CONSENTING TO BE BOUND BY ALL THE TERMS AND CONDITIONS
CONTAINED IN THIS LICENSE AGREEMENT. YOU AGREE THAT YOUR USE, INSTALLATION, OR COPYING
OF THE AAF SDK ACKNOWLEDGES THAT YOU HAVE READ THIS LICENSE, UNDERSTAND IT, AND AGREE
TO BE BOUND BY ITS TERMS AND CONDITIONS.

ANY SOFTWARE THAT MAY BE PROVIDED WITH THE AAF SDK BUT TO WHICH THIS AGREEMENT DOES
NOT APPLY IS INCLUDED FOR USE AT YOUR OPTION. IF YOU CHOOSE TO USE SUCH SOFTWARE, THEN
SUCH USE SHALL BE GOVERNED BY ANY LICENSE AGREEMENT ACCOMPANYING SUCH SOFTWARE.

WARNING: ALTHOUGH NO ADDITIONAL LICENSE IS REQUIRED FROM THE CONTRIBUTORS TO USE
THE SOURCE CODE IN THIS AAF SDK TO WHICH THIS AGREEEMENT APPLIES, THIS AGREEMENT DOES
NOT PROVIDE ALL LICENSES, UNDER INTELLECTUAL PROPERTY RIGHTS COVERING THE AAF
STANDARD, THAT MAY BE NECESSARY TO CREATE AND DISTRIBUTE AAF COMPLIANT PRODUCTS.
PLEASE CONTACT THE ADVANCED MEDIA WORKFLOW ASSOCIATION, INC. FOR MORE INFORMATION
ABOUT ANY ADDITIONAL LICENSES THAT MAY BE REQUIRED TO CREATE AND DISTRIBUTE AAF
COMPLIANT PRODUCTS (HTTP://WWW.AMWA.TV/POLICIES).

SOME FILES OF THE AAF SDK MAY BE USED TO IMPLEMENT STRUCTURED STORAGE. SOURCE CODE
IMPLEMENTING STRUCTURED STORAGE MAY INCORPORATE INTELLECTUAL PROPERTY OWNED BY
MICROSOFT CORPORATION. THE PROVISION OF THIS SOURCE CODE DOES NOT INCLUDE ANY
LICENSES OR ANY OTHER RIGHTS TO YOU UNDER ANY MICROSOFT INTELLECTUAL PROPERTY. IF YOU
WOULD LIKE A LICENSE FROM MICROSOFT (E.G., REBRAND, REDISTRIBUTE), PLEASE CONTACT
MICROSOFT DIRECTLY OR VISIT HTTP://WWW.MICROSOFT.COM/MSCORP/IP/STANDARDS/.

1. Definitions.

1.1. "AAF SDK" means the Original Code and any Modifications thereto. The term "AAF SDK" includes
but is not limited to Standard Versions of the AAF SDK.

1.2. "Affiliate" means an entity that directly or indirectly controls, is controlled by, or is under
common control with, another entity, so long as such control exists. "Control" means direct or
indirect beneficial ownership of or the right to exercise (a) more than fifty percent (50%) of the voting
stock or equity in an entity; or (b) more than fifty percent (50%) of the relevant ownership interest or
decision-making authority representing the right to make the decisions for the subject entity in the
event that there is no voting stock or equity.

1.3. "Agreement" means this document.

1.4. "Contributor" means any individual or entity (and its Affiliates) that is an Initial Developer or that
makes Modifications to the AAF SDK.

1.5. "Contributor Version" means the AAF SDK, including the Modifications made by that particular
Contributor, whether in Executable form or Source Code.

1.6. "Executable" means computer program code in any form other than Source Code.
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1.7. "Initial Developer" means the individual or entity (and its Affiliates) identified as the Initial
Developer in the notice set forth in Exhibit A.

1.8. "Larger Work" means a work that combines Original Code and/or Modifications, or portions
thereof, with computer program code not governed by the terms of this Agreement.

1.9. "Modification" means any addition to or deletion from the substance or structure of either the
Original Code or any other Modification, or any addition to or deletion from the contents of a file
containing Original Code or other Modification, or any new file that contains any part of the Original
Code or other Modification.

1.10. "Original Code" means Source Code containing the notice set forth in Exhibit A that is first
distributed under this Agreement by the Initial Developer and that is not a Modification.

1.11. "Source Code" means the preferred form of a computer program for making changes to it,
including all modules it contains, plus any associated interface definition files, or scripts used to
control compilation and installation of an Executable.

1.12. "Standard" means the Advanced Authoring Format (AAF) as defined in the AAF Specification, and
any Updates thereto, authored, adopted, and published by the Promoters of AAF and/or the
Members of the Advanced Media Workflow Association, Inc.. Information about the Standard is
available from the Standards Body.

1.13. "Standard Versions of the AAF SDK" means any and all versions of the AAF SDK which are
designated as a "Standard Version" by the Standards Body.

1.14. "Standards Body" means the Advanced Media Workflow Association, Inc., a corporation duly
formed under the laws of Delaware, with offices at 436 North Westfield Road, Madison, Wisconsin
53717, or its successor in interest, or any successor appointed by the Advanced Media Workflow
Association for the purpose of maintaining the Standard and the AAF SDK, and its Affiliates.

1.15. "You" (or "Your") means an individual or a legal entity, and its Affiliates, exercising rights under,
and complying with all of the terms of, this Agreement.

2. License Grants.

2.1. Subject to the terms and conditions of this Agreement, and subject to third party intellectual
property claims, each Contributor hereby grants You a worldwide, compensation-free, nonexclusive
license, subject to compliance with the Distribution and Production Use Requirements of Section 3
below:

2.1.1. under copyrights, to download, store, reproduce and display the AAF SDK, without alteration,
solely for the purpose of Your internal review and evaluation of the AAF SDK, and for no commercial
use whatsoever;
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2.1.2. under copyrights, to use, reproduce, modify, display, perform, prepare derivative works of the
AAF SDK (or portions thereof) with or without Modifications, and to combine the AAF SDK (or portions
thereof) with or without Modifications with other computer program code not governed by the terms
of this Agreement to create a Larger Work;

2.1.3. under copyrights to redistribute the AAF SDK (or portions thereof) in Source Code and
Executable form with or without Modifications or as part of a Larger Work under the terms and
conditions of this Agreement; and

2.1.4. under a claim of any patent or patent application licensable by the Contributor and necessarily
infringed by the making, practicing, using, selling, offering for sale, or importing of its Contributor
Version, to make, practice, use, sell, offer for sale, and import, and/or otherwise dispose of, the
Contributor Version of such Contributor. This patent license shall apply to a claim of a patent
licensable by a Contributor only if, at the time the Contributor should have delivered under Section
3.1 to the Standards Body its Contributor Version, the Contributor Version necessarily infringes the
claim. No license under any claim of any patent or patent application is granted to You: a) for code
that You delete from the AAF SDK; b) separate from the AAF SDK; or c) for infringements caused by: i)
Your Modifications of the AAF SDK or ii) the combination of the AAF SDK with other software or
devices, including but not limited to Your Modifications or any Larger Work.

2.1.5. No other rights. You neither grant nor receive any license or right to use any trademark, trade
name, or maskwork hereunder. Without limitation of the foregoing, You will use the terms "Advanced
Authoring Format" or "AAF" in Your Contributor Version and/or Your Modifications only if Your
Contributor Version and/or Modifications are designated as a Standard Version of the AAF SDK.
Except for the rights expressly provided by this Agreement, a) You shall not have any other rights in
the AAF SDK, and b) You neither grant nor receive, by implication, estoppel, or otherwise, any rights
to any patents, copyrights, or other intellectual property rights.

2.2. Reciprocal Patent License. As an express condition to the license grant in Section 2.1.4, and
subject to the terms and conditions of this Agreement and to third party intellectual property claims,
You agree to grant all Contributors and other licensees of this AAF SDK a worldwide, compensation-
free, and otherwise reasonable and nondiscriminatory nonexclusive license under a claim of any
patent or patent application licensable by You and necessarily infringed by the making, practicing,
using, selling, offering for sale or importing of this AAF SDK, to make, practice, use, sell, offer for sale,
and import, and/or otherwise dispose of, this AAF SDK. This patent license shall apply to a claim of a
patent licensable by You only if the AAF SDK You have been licensed (i.e., “this AAF SDK”) necessarily
infringes the claim. No license under any claim of any patent or patent application is granted by You:
a) for code that is deleted by another from this AAF SDK; b) separate from this AAF SDK; or c) for
infringements caused by: i) Modifications by another to this AAF SDK or ii) the combination by
another of this AAF SDK with other software or devices, including but not limited to Modifications or
any Larger Work.
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2.3. Defensive Suspension. If any Contributor, any licensee of the AAF SDK, or any of its Affiliates (“the
sued party”) is first sued for patent infringement by You or any of Your Affiliates, on account of the
sued party’s making, practicing, using, selling, offering for sale, or importing of the AAF SDK, then the
sued party may terminate all license grants and any other rights provided under this Agreement to
You. The foregoing shall not apply if the patent infringement suit that would otherwise trigger this
clause is solely based on a failure to comply with the scope of the license grants set forth in this
Agreement.

3. Distribution and Production Use Requirements.

3.1. Delivery of Source Code to Standards Body. You agree to deliver to the Standards Body Your
Modifications and/or Your Contributor Version in Source Code form within sixty (60) days after You
first distribute or use in production any AAF SDK (or portion thereof) with Your Modifications. If Your
Modifications and/or Your Contributor Version do not comply with all requirements of the Standard
and all other requirements set out by the Standards Body, You must also deliver to the Standards
Body a description of any deviation from the Standard resulting from Your Modifications.

3.2. Grant Back of Your Modifications to the Standards Body. Subject to the terms and conditions of
this Agreement, You hereby grant to the Standards Body a worldwide, nonexclusive, compensation-
free license to Your Contributor Version and Modifications, in whole and in part, and with and
without additional Modifications, in the same scope and for the same purposes as the licenses
granted to You in Section 2.1 above. Without limiting Your right to reproduce, use, and distribute
Your Contributor Version, the Standards Body may choose in its sole discretion to designate Your
Contributor Version a Standard Version of the AAF SDK, and/or may use any part of Your Contributor
Version, with or without other Modifications, to create and designate a Standard Version of the AAF
SDK. The Standards Body may redistribute a Standard Version of the AAF SDK under the terms of this
Agreement.

3.3. Required Notice in Source Code. The Source Code for the AAF SDK (or portion thereof), with or
without Modifications, may only be distributed under the terms of this Agreement, and, at a
minimum, within every copy of the AAF SDK (or portion thereof) that You distribute, You must include
a copy of this Agreement within a file called “AAFSDKPSL.TXT” in a sub-directory named “LEGAL” along
with the AAF SDK Source Code. You may not offer or impose any terms on any version of the AAF SDK
(or portion thereof) that alters or restricts this Agreement, or the recipients' rights hereunder. Your
license for shipment of the AAF SDK (or portion thereof) with or without Modifications is conditioned
upon Your full compliance with this Section 3. You must duplicate or retain the notice in Exhibit A in
each file of the Source Code for the AAF SDK. If You create Original Code to be distributed under this
Agreement, You must insert the notice in Exhibit A into the Source Code file for that Original Code,
and you may insert Your name as the Initial Developer. If You created one or more Modification(s),
You may add Your name as a Contributor to such a notice in any file containing such Modification(s).
If Your Contributor Version and/or Your Modifications do not comply with all requirements of the
Standard and all other requirements set out by the Standards Body that are in effect sixty (60) days
before distribution or production, You must provide a description with Your Contributor Version
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and/or Your Modifications of any deviation from the Standard resulting from Your Modifications; and,
unless Your Contributor Version has been designated a Standard Version of the AAF SDK, You must
prominently state that it is not a Standard Version. All Standard Versions of the AAF SDK must be so
labeled.

3.4. Required Notice for Larger Works. In any documentation for a Larger Work, you must include the
following notice:

“The Source Code version of the AAF SDK used herein is available from [INSERT YOUR NAME HERE]
and/or the Advanced Media Wokflow Association, Inc., under the terms of the AAF SDK Public Source
License Version 2.0. A copy of this license is available at www.amwa.tv/licenses.”

The notice must be conspicuously included in the Larger Work, related documentation, or collateral
in which You describe recipients' rights or ownership rights relating to the AAF SDK.

3.5. Licenses Granted by You for Larger Works. You may distribute a Larger Work under Section 2.1
under a license of Your choice, which may contain terms different from this Agreement, provided that
You are in compliance with the terms of this Agreement. If You distribute the Larger Work under a
different license, then You must make it absolutely clear that any terms which differ from this
Agreement are offered by You alone, not by any Contributor. You hereby agree to indemnify each
Contributor for any liability incurred by the Contributor as a result of any such terms You offer. You
may choose to offer, and to charge a fee for, warranty, support, indemnity, or liability obligations to
one or more recipients of a Larger Work. However, You may do so only on Your own behalf, and not
on behalf of any Contributor. You must make it absolutely clear that any such warranty, support,
indemnity, or liability obligation is offered by You alone, and You hereby agree to indemnify other
Contributors for any liability incurred by them as a result of warranty, support, indemnity, or liability
terms You offer.

4. Application of this Agreement. This Agreement applies to code to which a Contributor has attached
the notice in Exhibit A.

5. DISCLAIMER OF WARRANTY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE AAF
SDK (INCLUDING WITHOUT LIMITATION EACH STANDARD VERSION OF THE AAF SDK) IS PROVIDED "AS
IS" AND WITH ALL FAULTS, AND EACH CONTRIBUTOR AND THE STANDARDS BODY HEREBY DISCLAIM
ALL WARRANTIES AND CONDITIONS, EITHER EXPRESS, IMPLIED, OR STATUTORY, WITH RESPECT TO
THE AAF SDK (OR ANY ELEMENT THEREOF), INCLUDING BUT NOT LIMITED TO ANY (IF ANY) IMPLIED
WARRANTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NON-
INFRINGEMENT OF THIRD PARTY'S RIGHTS, TITLE, QUIET ENJOYMENT, QUIET POSSESSION, QUALITY,
LACK OF NEGLIGENCE, LACK OF WORKMANLIKE PERFORMANCE, LACK OF VIRUSES, ACCURACY OR
COMPLETENESS OR RESPONSES, RESULTS, OR PERFORMANCE. WITHOUT LIMITING THE FOREGOING,
EACH CONTRIBUTOR AND THE STANDARDS BODY HEREBY DISCLAIMS ANY (IF ANY) WARRANTY (A)
REGARDING THE ACCURACY OR COMPLETENESS OF THE AAF SDK, AND (B) THAT THE AAF SDK IS
APPROPRIATE FOR ANY PARTICULAR USE OR THAT USE OF THE AAF SDK WILL BE UNINTERRUPTED OR
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ERROR-FREE. THE ENTIRE RISK AS TO THE USE, QUALITY, AND PERFORMANCE OF THE AAF SDK IS
WITH YOU. THIS DISCLAIMER IS AN ESSENTIAL PART OF THIS AGREEMENT. NO DISTRIBUTION OF THE
AAF SDK, SPECIFICALLY INCLUDING ANY STANDARD VERSIONS OF THE AAF SDK, IS AUTHORIZED
EXCEPT UNDER THIS DISCLAIMER.

6. Termination. This Agreement and the rights granted hereunder will terminate automatically if You
fail to comply with terms herein and fail to cure such breach within 30 days of becoming aware of the
breach. Provisions which, by their nature, must remain in effect beyond the termination of this
Agreement under this Section 6 shall survive. Any license granted by You to any Contributor, any
licensee of the AAF SDK, or the Standards Body, and any end user license agreement for Larger
Works containing or linking to the AAF SDK in Executable form that have been validly granted by You
hereunder prior to termination shall continue in full force even after such termination.

7. LIMITATION OF LIABILITY. IN NO EVENT SHALL ANY CONTRIBUTOR AND/OR THE STANDARDS BODY
BE LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, GENERAL, ECONOMIC, INCIDENTAL,
PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT LIMITED TO DAMAGES FOR LOST
PROFITS, LOSS OF GOODWILL, OR BUSINESS INTERRUPTION), OR FOR ANY DAMAGES RESULTING
FROM LOSS OF USE, LOSS OF DATA, OR LOSS OF ANTICIPATED PROFITS, IN ANY WAY RELATED TO USE
OF OR INABILITY TO USE THE AAF SDK, OR OTHERWISE IN CONNECTION WITH ANY PROVISION OF
THIS AGREEMENT, EVEN IF THE CONTRIBUTOR AND/OR THE STANDARDS BODY HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE. THE SOLE AND EXCLUSIVE REMEDY FOR LACK OF
SATISFACTION WITH THE AAF SDK IS TO DISCONTINUE USING THE AAF SDK. THIS LIMITATION OF
LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY RESULTING FROM SUCH
PARTY'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. SOME
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THIS EXCLUSION AND LIMITATION MAY NOT APPLY TO YOU.

8. U.S. Government End Users. U.S. Government: If the AAF SDK is being acquired by or on behalf of
the U.S. Government or by a U.S. Government prime contractor or subcontractor (at any tier), then
the Government's rights in the AAF SDK and accompanying documentation shall be only as set forth
in this Agreement; this is in accordance with 48 C.F.R. 227.7201 through 227.7202-4 (for Department of
Defense (DoD) acquisitions) and with 48 C.F.R. 2.101 and 12.212 (for non-DoD acquisitions).

9. Miscellaneous. This Agreement shall constitute the complete and exclusive agreement concerning
the subject matter hereof. The Exhibit identified in this Agreement is incorporated herein by
reference and made a part hereof. If any provision of this Agreement is held to be unenforceable for
any reason in a jurisdiction, such provision shall be reformed only to the extent necessary to make it
enforceable, and such holding shall not affect the enforceability of such provision under other
circumstances or in other jurisdictions, or of the remaining provisions hereof under all
circumstances. None of the provisions of this Agreement shall be deemed to have been waived by any
act or acquiescence on the part of any Contributor and/or the Standards Body, their agents or
employees, but only by an instrument in writing signed by them. With respect to disputes in which at
least one party is a citizen of, or an entity chartered or registered to do business in the United States
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of America, any litigation relating to this Agreement shall be subject to the jurisdiction of the Federal
Courts of the Commonwealth of Massachusetts, with the losing party responsible for costs, including
without limitation, court costs and reasonable attorneys' fees and expenses. The application of the
United Nations Convention on Contracts for the International Sale of Goods is expressly excluded.
Any law or regulation which provides that the language of a contract shall be construed against the
drafter shall not apply to this Agreement.

10. Effective Date. The terms and conditions of this Agreement will become effective upon Your first
use, installation, or copying of the AAF SDK. You hereby represent and warrant that You have full
authority to enter into this Agreement and grant the licenses set forth herein.

EXHIBIT A - Required Notice.

The contents of this file are subject to the AAF SDK Public Source License Agreement Version 2.0 (the
"License"); You may not use this file except in compliance with the License. The License is available in
AAFSDKPSL.TXT, or you may obtain a copy of the License from the Advanced Media Workflow
Association, Inc., or its successor.

Software distributed under the License is distributed on an "AS IS" basis, WITHOUT WARRANTY OF
ANY KIND, either express or implied. See the License for the specific language governing rights and
limitations under the License. Refer to Section 3.3 of the License for proper use of this Exhibit.

WARNING: Please contact the Advanced Media Workflow Association, Inc., for more information
about any additional licenses to intellectual property covering the AAF Standard that may be required
to create and distribute AAF compliant products.

(http://www.amwa.tv/policies).

Copyright Notices:

The Original Code of this file is Copyright [date], licensor of the Advanced Media Workflow
Association. All rights reserved.

The Initial Developer of the Original Code of this file and the licensor of the Advanced Media
Workflow Association is [Initial Developer name].

All rights reserved.

Portions created by [Contributor name] are Copyright [year], [Contributor name]. All rights reserved.

Contributors and additional licensors of the Advanced Media Workflow Association: [Contributor
name]
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Avid DNxHD Codec Source EULA

Avid Technology, Inc.

Avid DNxHD Codec Source Code

End-User License Agreement (EULA) V1.0

NOTICE: THIS DOCUMENT IS A LEGAL AGREEMENT BETWEEN AVID TECHNOLOGY, INC., A DELAWARE
CORPORATION, HAVING ITS PRINCIPAL PLACE OF BUSINESS AT AVID TECHNOLOGY PARK, ONE PARK
WEST, TEWKSBURY, MASSACHUSETTS 01876 ("AVID") AND YOU (EITHER AN INDIVIDUAL OR AN ENTITY
THAT IS A REGISTERED AVID USER) REGARDING THE AVID DNxHD CODEC SOURCE CODE. PLEASE
READ THESE TERMS CAREFULLY BEFORE DOWNLOADING, USING OR COPYING THE AVID DNxHD
CODEC SOURCE CODE.

AVID IS WILLING TO LICENSE THE AVID DNxHD CODEC SOURCE CODE TO YOU ONLY UPON THE
CONDITION THAT YOU ACCEPT ALL OF THE TERMS AND CONDITIONS CONTAINED IN THIS LICENSE
AGREEMENT. BY DOWNLOADING, INSTALLING, USING OR COPYING THE AVID DNxHD CODEC
SOURCE CODE, YOU ARE CONSENTING TO BE BOUND BY ALL THE TERMS AND CONDITIONS
CONTAINED IN THIS LICENSE AGREEMENT. YOU AGREE THAT THROUGH YOUR DOWNLOADING,
INSTALLING, USING OR COPYING OF THE AVID DNxHD CODEC SOURCE CODE, YOU ACKNOWLEDGE
THAT YOU HAVE READ THIS LICENSE, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS. PLEASE REPORT ANY ERRORS YOU DISCOVER IN THE AVID DNxHD CODEC SOURCE
CODE TO AVID.

THIS LICENSE IS AN INTERNAL-USE-ONLY LICENSE AND DOES NOT PERMIT DISTRIBUTION OR
CREATION OF DERIVATIVE WORKS. IF YOU ARE A MANUFACTURER INTERESTED IN A ROYALTY-FREE
SOURCE CODE LICENSE THAT PERMITS DISTRIBUTION AND/OR CREATION OF DERIVATIVE WORKS,
PLEASE CONTACT AVID.

1. DEFINITIONS

1.1. "Affiliate" means any entity that directly or indirectly controls, is controlled by, or is under
common control with, another entity, so long as such control exists. "Control" means direct or
indirect beneficial ownership of or the right to exercise: (a) more than fifty percent (50%) of the voting
stock or equity in an entity; or (b) more than fifty percent (50%) of the relevant ownership interest or
decision-making authority representing the right to make the decisions for the subject entity in the
event that there is no voting stock or equity.

1.2. "Agreement" means this document.

1.3. "Avid DNxHD Codec Source Code" means C language Source Code delivered to You by Avid under
the terms and conditions of this Agreement.

APPENDIX C: EXTERNAL SOFTWARE | THIRD-PARTY LICENSES



187

1.4. "Executable" means computer program code in any form other than Source Code and that is
executable by a commercial, off-the-shelf operating system for a commercially-available general
purpose computer.

1.5. "Intellectual Property Rights" means all proprietary rights, including, but not limited to, computer
software source code, copyrights, trade secrets, know-how and patent rights, and all exclusive rights
thereunder.

1.6. "Internal Development" by You means development by You (if an individual), or development by
an employee of You (if an entity) acting within the scope of his or her employment and having a
written agreement consistent with the terms and conditions of this agreement, at Your secure
facilities where You have taken reasonable steps necessary to protect the security and confidentiality
of the Licensed Software.

1.7. "Internal Use" by You means installation and execution of an Executable on Your computers for
processing Your data, at Your secure facilities where You have taken reasonable steps necessary to
protect the security and confidentiality of the Licensed Software.

1.8. "Licensed Software" means the Avid DNxHD Codec Source Code, and any Modifications made to
the Licensed Software by You, and any Executable created from the Avid DNxHD Codec Source Code.

1.9. "Modification" means any addition, deletion, restructuring or other alteration by You to either the
Licensed Software or to the contents of a file containing Licensed Software and/or other
Modifications, or any new file created by You that contains any part of the Licensed Software and/or
other Modifications, or any new file created by You and combined by You with the Licensed Software
to produce an Executable that includes the Licensed Software.

1.10. "Source Code" means the preferred form of a computer program for making modifications to it,
including all modules it contains, plus any associated interface definition files, or scripts used to
control compilation and installation of an Executable.

1.11. "You" (or "Your") means an individual or a legal entity, and its Affiliates, that is a registered Avid
user.

2. LICENSE GRANTS

2.1. Internal Development License. Under Avidís Intellectual Property Rights in the Licensed Software,
subject to the terms and conditions of this Agreement and subject to third party intellectual property
claims, Avid hereby grants You, and You hereby accept, a compensation-free, perpetual, worldwide,
nonexclusive, non-transferable, non-assignable, and personal license, without the right to sublicense,
to access, download, store, reproduce and compile the Licensed Software, for the sole purpose of
Internal Development by You of an Executable of the Licensed Software. No Modification to the
Licensed Software is permitted except as is absolutely necessary to permit compilation of the
Licensed Software to make such an Executable. No other use of the Licensed Software is permitted,
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and the following uses (without limitation) of the Licensed Software are expressly forbidden, to the
extent such prohibition is permitted by applicable law:

a. distributing the Licensed Software, in either Source Code or Executable form;

b. porting the Licensed Software to another programming language;

c. optimizing the Licensed Software, including but not limited to assembly language optimization
and vector-based optimization, such as Altivec and SSE2 optimizations; and

d. reverse engineering or analysis of the Licensed Software to extract its ideas and concepts;

e. developing any other Source Code for a high definition video encoder or decoder that is not a
Modification that is necessary to permit compilation of the Licensed Software;

f. developing any hardware implementation of a high definition video encoder or decoder, including
but not limited any implementation in a field programmable gate array (FPGA) or other embedded
implementation.

2.2. Internal Use License. Under Avidís Intellectual Property Rights in the Licensed Software, subject to
the terms and conditions of this Agreement and subject to third party intellectual property claims,
Avid hereby grants You, and You hereby accept, a compensation-free, perpetual, worldwide, non-
exclusive, non-transferable, non-assignable, and personal license, without the right to sublicense, to
use Your Executable of the Licensed Software solely for Internal Use by You in the production, editing
and archiving of Your high-definition video data.

2.3. No Other Rights. Except for the rights expressly provided by this Agreement, Avid does not grant,
by implication, estoppel or otherwise, any other rights in the Licensed Software or any license or right
in any other of Avid's Intellectual Property Rights.

2.4. Reciprocal Intellectual Property License. As an express condition to the license grants in Sections
2.1 and 2.2, You agree to grant Avid and its other licensees of the Licensed Software a perpetual,
compensation-free, worldwide, non-exclusive, non-transferable, non-assignable, personal and
otherwise reasonable and nondiscriminatory license, without the right to sublicense, under a claim of
any patent or patent application, now or hereafter acquired by, owned by or assigned to You, and
which is necessarily infringed, directly or indirectly, by the making, practicing, using, selling, offering
for sale or importing of the Licensed Software, to make, practice, use, sell, offer for sale and import,
and/or otherwise dispose of, the Licensed Software.

2.5. Defensive Suspension. As an express condition to the license grants in Sections 2.1 and 2.2, You
agree that if Avid or any of its licensees of the Licensed Software is first sued for patent infringement
by You or any of Your Affiliates, on account of the manufacture, use, sale, offer for sale, importation
or other disposition or promotion of the sued partyís Licensed Software, then the sued party may
terminate all license grants and any other rights provided under this Agreement to You. The foregoing
shall not apply if the patent infringement suit that would otherwise trigger this Section 2.5 is solely
based on a failure to comply with the scope of the license grants set forth in this Agreement.

2.6. No Trademark Use. No right to use any of Avidís trademarks is provided under this Agreement.
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3. SUPPORT

Avid shall have no obligation under this Agreement to provide You with any maintenance or technical
support services with respect to the Licensed Software.

4. DISCLAIMER OF WARRANTY

THE LICENSED SOFTWARE PROVIDED UNDER THIS AGREEMENT IS PROVIDED "AS IS" AND WITH ALL
FAULTS, AND AVID HEREBY DISCLAIMS ALL WARRANTIES AND CONDITIONS, EITHER EXPRESS, IMPLIED
OR STATUTORY, AND MAKES NO REPRESENTATIONS WITH RESPECT TO THE LICENSED SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY (IF ANY) IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT OF THIRD PARTY'S
RIGHTS, TITLE, QUIET ENJOYMENT, QUIET POSSESSION, QUALITY, LACK OF NEGLIGENCE, LACK OF
WORKMANLIKE PERFORMANCE, ACCURACY OR COMPLETENESS. THE ENTIRE RISK AS TO THE USE,
QUALITY AND PERFORMANCE OF THE LICENSED SOFTWARE IS WITH YOU. THIS DISCLAIMER IS AN
ESSENTIAL PART OF THIS AGREEMENT.

5. LIMITATION OF LIABILITY

IN NO EVENT SHALL AVID BE LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, GENERAL,
ECONOMIC, INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT LIMITED
TO DAMAGES FOR LOST PROFITS, LOSS OF GOODWILL, OR BUSINESS INTERRUPTION), OR FOR ANY
DAMAGES RESULTING FROM LOSS OF USE, LOSS OF DATA OR LOSS OF ANTICIPATED PROFITS, IN ANY
WAY RELATED TO USE OF OR INABILITY TO USE THE LICENSED SOFTWARE, OR OTHERWISE IN
CONNECTION WITH ANY PROVISION OF THIS AGREEMENT, EVEN IF AVID HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE. THE SOLE AND EXCLUSIVE REMEDY FOR LACK OF SATISFACTION WITH
THE LICENSED SOFTWARE IS TO DISCONTINUE USING THE LICENSED SOFTWARE. THIS LIMITATION OF
LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY RESULTING FROM SUCH
AVID'S NEGLIGENCE TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION.

6. PROPRIETARY INFORMATION

6.1. Nondisclosure. The Licensed Software and all ideas and concepts embodied therein are
confidential and proprietary information of Avid. You agree that You will not disclose any part of the
Licensed Software to a third party.

6.2. Ownership. The Avid DNxHD Codec Source Code is and shall remain the property of Avid.

6.3. Irreparable Harm. You agree that the restrictions contained in this Agreement are necessary for
the protection of Avid, and consider them to be reasonable for such purpose. You agree that any
breach of this Agreement may cause Avid substantial and irreparable damage and therefore, in the
event of any such breach, You agree that Avid shall be entitled to specific performance and other
injunctive relief, in addition to such other remedies as may be afforded by applicable law.

7. TERMINATION
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7.1. For Cause. Either You or Avid may terminate this Agreement immediately upon written notice at
any time if the other party is in material breach of this Agreement.

7.2. Effect of Termination. Upon termination of this Agreement, Your license rights under Sections 2.1
and 2.2 shall immediately cease and You must destroy all full or partial copies of the Licensed
Software.

7.3. Survival. Sections 1, 2.3, 2.4, 2.5, 2.6, 4, 5, 6, 7 and 8 expressly survive Termination of this
Agreement.

8. MISCELLANEOUS

8.1. Government Rights. The Avid DNxHD Codec Source Code was developed at private expense and
with no government funds. Use, duplication or disclosure by the Government is subject to restriction
as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Science clause at
DFAR 252.227.7013 or FAR 52.227-19 if applicable.

8.2. Export Regulations. You agree that the Licensed Software, or any portion thereof, will not be
downloaded, transferred or otherwise exported or re-exported, directly or indirectly, into any country
prohibited by the United States Export Administration Act (the "Act") and the regulations thereunder,
or into any country to which the United States embargoes goods, or will be distributed to any persons
on the Table of Denial Orders, the Entity List or the List of Specially Designated Nationals, or will be
used for any purposes prohibited by the Act. By using the Licensed Software under this Agreement,
You agree to the foregoing and represent and warrant that (a) no agency of Government has
suspended, revoked or denied Your export privileges; (b) Your are not located in or under the control
of a national or resident of any such country or on any such list; and (c) You will not export or re-
export the Licensed Software or any portion thereof to any prohibited country, or to any prohibited
person, entity or end-user as specified by the Act and the regulations thereunder.

8.3. Choice of Law, Jurisdiction and Venue. This Agreement shall be governed by the laws in force in
the Commonwealth of Massachusetts excluding its conflicts of law rules. You and Avid hereby
consent to the exclusive jurisdiction of and venue in the state and federal courts sitting in the
Commonwealth of Massachusetts.

8.4. No Partnership or Joint Venture. This Agreement shall not create a principal-agent relationship
between Avid and You, nor shall anything herein be construed to cause the parties to be acting as
partners or as a joint venture. Neither You nor Avid shall have any power or authority to obligate or
bind the other in any manner and neither You nor Avid shall make any representation or warranty on
behalf of the other.

8.5. Force Majeure. Neither You nor Avid shall be liable for any delay or failure in the performance of
any obligation under this Agreement, except for payment obligations, if such delay or failure is due to
causes beyond its reasonable control, such as natural catastrophes, war or civil disturbances,
governmental acts or omissions, labor strikes, transportation stoppages and power failures.
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8.6. Severability. If any provision in this Agreement is held to be unenforceable for any reason, then
the provision shall be reformed only to the extent necessary to make it enforceable. Such a holding
shall not affect the enforceability of such provision under other circumstances or in other
jurisdictions and shall not affect the enforceability of any remaining provision of this Agreement;
provided, however, that no such reformation shall be effective if it materially changes the economic
benefit of this Agreement to either party.

8.7. Captions. The captions to the Sections of this Agreement are for convenience only, and are not a
part of this Agreement, and shall not be deemed to have any effect in construing this Agreement.

8.8. No Waiver. None of the provisions of this Agreement shall be deemed to have been waived by
any act or acquiescence on the part of Avid, its agents or employees, but only by an instrument in
writing signed by an authorized signatory of Avid.

8.9. Integration and Modification. This Agreement contains the entire agreement between the parties
pertaining to the licensing by You of the Licensed Software and supersedes all preexisting
agreements between the parties respecting its subject matter. Any Representation, promise, or
condition in connection with such subject matter, which is not incorporated in this Agreement, shall
not be binding upon either You or Avid. No modification, renewal or extension of this Agreement or
any of its provisions shall be

binding upon the party against whom enforcement of such modification, renewal or extension is
sought, unless made in writing and signed on behalf of such party by one of its executive officers.

8.10. Assignment. You may not assign Your rights under this Agreement without prior written consent
from Avid.
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Appendix D: Application
Dependencies
This appendix lists the supported applications used in Flix.

Applications Supported Versions

Adobe Photoshop CS6, CC, CC 2014, CC 2015, CC 2015.5

Adobe Premiere CS6, CC, CC 2014, CC 2015

Autodesk Maya 2014, 2015, 2016

Avid Media Composer 8.1, 8.2, 8.3, 8.4

Final Cut Pro 7

Toon Boom Storyboard Pro 4.1 (10.2.2.8608), 4.2 (10.2.2.10324), 5.0

TVPaint Animation 11

NOTE: Other versions of applications may work, but have not been fully tested. If you have
any problems with a particular application's version, please contact The Foundry Support
Team, refer to Contacting Customer Support.
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Appendix E: End User License
Agreement (EULA)

PLEASE READ THIS EULA CAREFULLY BEFORE ORDERING OR DOWNLOADING OR USING ANY
SOFTWARE PRODUCTS OF THE FOUNDRY. YOUR ATTENTION IS PARTICULARLY DRAWN TO CLAUSES
12 AND 13 WHERE WE LIMIT OUR LIABILITY TO USERS OF OUR SOFTWARE PRODUCTS.

IMPORTANT NOTICE TO ALL USERS: BY DOWNLOADING AND/OR USING THIS SOFTWARE YOU
ACKNOWLEDGE THAT YOU HAVE READ THIS EULA, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. IF YOU DO NOT AGREE TO THE TERMS OF THIS EULA DO NOT DOWNLOAD,
INSTALL, COPY OR USE THE SOFTWARE.

IMPORTANT NOTICE TO CONSUMERS WHO PURCHASE SOFTWARE PRODUCTS DIRECT FROM THE
FOUNDRY: YOU HAVE THE RIGHT TO WITHDRAW FROM YOUR TRANSACTION WITH THE FOUNDRY
WITHOUT CHARGE AND WITHOUT REASON AT ANY TIME BEFORE DOWNLOADING OUR SOFTWARE
PRODUCT(S). HOWEVER YOU WILL LOSE THIS RIGHT ONCE YOU BEGIN TO DOWNLOAD OUR
SOFTWARE PRODUCT(S). THIS DOES NOT AFFECT YOUR CONSUMER RIGHTS IN RELATION TO
DEFECTIVE PRODUCTS OR SERVICES.

This END USER LICENSE AGREEMENT ("EULA") is, in cases where you purchase our product(s) direct
from The Foundry, incorporated into the agreement between The Foundry Visionmongers Limited, a
company registered in England and Wales, ("The Foundry"), and you, as either an individual or a
single company or other legal entity ("Licensee") on the terms of which you will purchase the
products and services of The Foundry (the “Agreement”). In cases where you purchase our product(s)
from one of our resellers, the use of the term “Agreement” in this EULA refers to the arrangements
between The Foundry and Licensee on which Licensee is permitted to use The Foundry’s product(s),
including this EULA.

The Foundry reserves the right to refuse to grant a License (as defined in clause 1.1) to any Licensee
who has failed to pay any sum due either to The Foundry or to a reseller of The Foundry either in
connection with the Agreement or in connection with any other software license to use any Software
product(s) of The Foundry.

1. GRANT OF LICENSE

1.1 Subject to the limitations of clause 3 and all the other terms of the Agreement, The Foundry
grants to Licensee a limited, non-transferable (subject to clause 2.1(b) below) and non-exclusive
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license to download, install and use a machine readable, object code version (subject to clauses 3 and
4 below) of the software program(s) purchased by Licensee (the "Software") and any accompanying
user guide and other documentation (the "Documentation"), solely for Licensee's own internal
purposes (the "License"); provided, however, that Licensee's right to download, install and use the
Software and the Documentation is limited to those rights expressly set out in this EULA.

1.2 Some types of license models set out in clause 2.1 limit the installation and use of the Software to
the country in which Licensee is based at the date of purchase (the “Home Country”), unless
otherwise agreed in writing. Notwithstanding such limits, Licensee may still use the Software outside
the Home Country if traveling or working outside the Home Country on a temporary basis provided
that such use does not exceed 70 days in aggregate in any rolling twelve month period or, in the case
of any license which lasts for less than twelve months, does not exceed the number of days
representing 20% of the term of the license.

1.3 Only to the extent that is proportionate to, and reasonably necessary to support, Licensee’s
licensed use of the Software in accordance with the Agreement, Licensee may (provided valid license
keys have been obtained) install the Software on more than one computer, provided always that
Licensee’s concurrent use of different installations of the Software does not exceed the number of
valid Licenses that Licensee has paid for or licensed (as applicable).

2. LICENSE MODELS

2.1 For each Software product purchased from The Foundry, the License will be one of the following
types of license, and subject to the following terms and conditions. Please note that some licensing
models set out below do not apply to certain Software products of The Foundry. Whichever licensing
model applies, Licensee shall not at any one time use more copies of the Software than the total
number of valid licenses purchased or licensed by Licensee (as applicable).

(a) “Node Locked License”

If Licensee purchases a Node Locked License, Licensee will install and use only a single copy of the
Software on only one computer at a time, which may be located anywhere in the Home Country.

(b) “Individual License”

If Licensee purchases an Individual License, Licensee warrants and represents that Licensee is a
natural person and that only Licensee will use the Software. Licensee may transfer or assign
(“transfer”) the Individual License to another natural person (“Assignee”) subject to Licensee: (i)
notifying The Foundry of such transfer and obtaining The Foundry’s express written consent, (ii)
paying an administrative fee with respect to such transfer as may be required by The Foundry, and (iii)
after transferring a single copy of the Software to the Assignee, deleting any copies of the Software
that Licensee may have in Licensee’s possession, custody or power. An Individual License entitles
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Licensee to use the Software on only one computer at a time, which may be located anywhere and is
not restricted to the Home Country.

(c) “Floating License”

If Licensee purchases a Floating License, use of the Software may be at any site in the Home Country.

(d) “Login-Based License”

If Licensee purchases a Login-Based License, Licensee warrants and represents that Licensee is a
natural person and that only Licensee shall use the Software. Licensee will be issued with log in
details and may use the Software on any number of computers (but not simultaneously).

2.2 Some of the Software may be made available at concessionary rates or free of charge (as
applicable) as follows:

(a) “Educational License”

If Licensee has purchased the Software on the discounted terms of The Foundry’s Educational Policy
published on its website (the “Educational Policy”), Licensee warrants and represents to The Foundry
as a condition of the Educational License that: (i) (if Licensee is a natural person) he or she is a part-
time or full-time student at the time of purchase and will not use the Software for any commercial,
professional or for-profit purposes; (ii) (if the Licensee is not a natural person) it is an organization
that will use the Software only for the purpose of training and instruction, and for no other purpose,
and (iii) Licensee will at all times comply with the Educational Policy (as such policy may be amended
from time to time). Unless the Educational License is a Floating License, Licensee shall use the
Software on only one computer at a time.

(b) “Non-Commercial License”

If the License is a Non-Commercial License, Licensee warrants and represents that Licensee is a
natural person, that they will only access and/or use one copy of a Non-Commercial License for
personal, recreational and non-commercial purposes and that only Licensee will use the Software.
Under a Non-Commercial License, Licensee will not use the Software: (a) in conjunction with any
other copies or versions of the Software, under any type of License model; (b) for any commercial,
professional, for-profit and/or on-sale purpose or otherwise to provide any commercial service(s) to a
third party (whether or not for financial or other reward and including for education, instruction of or
demonstration to any third party for commercial purposes); (c) in the course of any employment or
business undertaking of Licensee; (d) on any commercial premises during business hours (except
where use of the Software is solely for a personal, recreational, educational or other non-commercial
purpose); and/or (e) to create any commercial tools or plug ins.

(c) “MODO Steam Edition”
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A version of MODO with limited functionality as described in the Documentation is available to
purchase on discount terms through Valve Corporation’s Steam store. If Licensee has purchased such
version, Licensee warrants and represents to The Foundry as a condition of the Agreement that: (i)
Licensee is a natural person; and (ii) Licensee will use the Software strictly through Steam and only for
personal, recreational and non-commercial use, except only that if Licensee uses the Software to
create assets and content Licensee may sell such assets and content through Valve’s Steam
Workshop.

(d) “MODO indie” and “MARI indie”

Variants of MODO and MARI with limited functionality as described in the Documentation are
available to purchase on discount terms through Valve Corporation’s Steam store. If Licensee has
purchased such a variant, Licensee warrants and represents to The Foundry as a condition of the
Agreement that: (i) Licensee is a natural person; or (ii) Licensee is an entity in the direct ownership of
a single natural person; (iii) Licensee will only access and/or use one copy of either variant; and (iv)
only Licensee will use the Software.

(e) “Trial License”

Licensee may register for a “Trial License” of the Software (not available for all products or in all
regions or markets). A Trial License lasts a limited specified period on the expiry of which the
Software will automatically cease to function. Licensee will use the Software on only one computer at
a time.

(f) “Free License”

Licensee may register for a “Free License” of selected Software from The Foundry (not available for all
Software products or in all regions or markets). A Free License lasts for a limited specified period on
the expiry of which the Software will cease to function. Usually, a replacement License to cover a new,
time limited, period will be issued by The Foundry. Licensee will use the Software under a Free
License on only one computer at a time.

(g) “Personal Learning Edition License”

If the Software is a Personal Learning Edition (“PLE”), it will not require a license key to be issued to
Licensee and will have limited functionality as described in the Documentation. Licensee may use it
only for the purpose of personal or internal training and instruction, and for no other purpose. PLE
versions of the Software may not be used for commercial, professional or for-profit purposes
including, for the avoidance of doubt, the purpose of providing training or instruction to third parties.
Licensee shall use the Software on only one computer at a time.

2.3 If Licensee has purchased a License that permits “non-interactive” use of the Software (“Headless
Rendering”), Licensee is authorized to use a non-interactive version of the Software for rendering
purposes only (i.e. without a user, in a non-interactive capacity) and shall not use such Software on
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workstations or otherwise in a user-interactive capacity. Headless Rendering is not available on all
products. In all cases except MODO (in respect of which there is no limit on the amount of Headless
Rendering allowed), Headless Rendering licenses are limited to one computer such that the number
of computers on which Headless Rendering can be carried out is limited to the number of valid
Licenses that have been purchased.

3. RESTRICTIONS ON USE

Please note that in order to guard against unlicensed use of the Software, a license key is
required to access and enable the Software (other than Software which is licensed under the
Personal Learning Edition model – see clause 2.2 (g) above). Licensee is authorized to use the
Software in machine readable, object code form only (subject to clause 4), and Licensee shall not: (a)
assign, sublicense, sell, distribute, transfer, pledge, lease, rent, lend, share or export the Software, the
Documentation or Licensee's rights under this EULA; (b) alter or circumvent the license keys or other
copy protection mechanisms in the Software or reverse engineer, decompile, disassemble or
otherwise attempt to discover the source code of the Software; (c) (subject to clause 4) modify, adapt,
translate or create derivative works based on the Software or Documentation; (d) use, or allow the
use of, the Software or Documentation on any project other than a project produced by Licensee (an
"Authorized Project") or to provide a service (whether or not any charge is made) to any third party;
(e) allow or permit anyone (other than Licensee and Licensee's authorized employees to the extent
they are working on an Authorized Project) to use or have access to the Software or Documentation;
(f) copy or install the Software or Documentation other than as expressly provided for in this EULA; or
(g) take any action, or fail to take action, that could adversely affect the trademarks, service marks,
patents, trade secrets, copyrights or other intellectual property rights of The Foundry or any third
party with intellectual property rights in the Software (each, a "Third Party Licensor"). For purposes of
this clause 3, the term "Software" shall include any derivatives of the Software.

Unless Licensee has purchased an Individual License or a Login-Based License, if the Software is
moved from one computer to another, the issuing of replacement or substituted license keys is
subject to and strictly in accordance with The Foundry’s License Transfer Policy, which is available on
The Foundry’s website and which requires a fee to be paid in certain circumstances. The Foundry may
from time to time and at its sole discretion vary the terms and conditions of the License Transfer
Policy.

4. SOURCE CODE

Notwithstanding that clause 1 defines “Software” as an object code version and that clause 3 provides
that Licensee may use the Software in object code form only:

4.1 if The Foundry has agreed to license to Licensee (including by way of providing SDKs, upgrades,
updates or enhancements/customization) source code or elements of the source code of the
Software, the intellectual property rights in which belong either to The Foundry or to a Third Party
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Licensor (“Source Code”), Licensee shall be licensed to use the Source Code as Software on the terms
of this EULA and: (a) notwithstanding clause 3 (c), Licensee may use the Source Code at its own risk in
any reasonable way for the limited purpose of enhancing its use of the Software solely for its own
internal business purposes and in all respects in accordance with this EULA; (b) Licensee shall in
respect of the Source Code comply strictly with all other restrictions applying to its use of the
Software under this EULA as well as any other restriction or instruction that is communicated to it by
The Foundry at any time during the Agreement (whether imposed or requested by The Foundry or by
any Third Party Licensor);

4.2 to the extent that the Software links to any open source software libraries (“OSS Libraries”) that
are provided to Licensee with the Software, nothing in the Agreement shall affect Licensee’s rights
under the licenses on which the relevant Third Party Licensor has licensed the OSS Libraries, as stated
in the Documentation. To the extent that Third Party Licensors have licensed OSS Libraries on the
terms of v2.1 of the Lesser General Public License issued by the Free Software Foundation (see
http://www.gnu.org/licenses/lgpl-2.1.html) (the “LGPL”), those OSS Libraries are licensed to Licensee
on the terms of the LGPL and are referred to in this clause 4.2 as the LGPL Libraries. The Foundry will
at any time during the three year period starting on the date of the Agreement, at the request of
Licensee and subject to Licensee paying to The Foundry a charge that does not exceed The Foundry’s
costs of doing so, provide Licensee with the source code of the LGPL Libraries (the “LGPL Source”) in
order that Licensee may modify the LGPL Libraries in accordance with the LGPL, together with certain
object code of the Software necessary to enable Licensee to re-link any modified LGPL Library to the
Software (the “Object”); and

4.3 notwithstanding any other term of the Agreement, The Foundry gives no express or implied
warranty, undertaking or indemnity whatsoever in respect of the Source Code, the OSS Libraries
(including the LGPL Libraries), the LGPL Source or the Object, all of which are licensed on an “as is”
basis, or in respect of any modification of the Source Code, the OSS Libraries (including the LGPL
Libraries) or the LGPL Source made by Licensee (“Modification”). Licensee may not use the Object for
any purpose other than its use of the Software in accordance with this EULA. Notwithstanding any
other term of the Agreement, The Foundry shall have no obligation to provide support, maintenance,
upgrades or updates of or in respect of any of the Source Code, the OSS Libraries (including the LGPL
Libraries), the LGPL Source, the Object or any Modification. Licensee shall indemnify The Foundry
against all liabilities and expenses (including reasonable legal costs) incurred by The Foundry in
relation to any claim asserting that any Modification infringes the intellectual property rights of any
third party.

5. BACK-UP COPY

Licensee may store one copy of the Software and Documentation off-line and off-site in a secured
location within the Home Country that is owned or leased by Licensee in order to provide a back-up
in the event of destruction by fire, flood, acts of war, acts of nature, vandalism or other incident. In no
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event may Licensee use the back-up copy of the Software or Documentation to circumvent the usage
or other limitations set forth in this EULA.

6. OWNERSHIP

Licensee acknowledges that the Software (including, for the avoidance of doubt, any Source Code that
is licensed to Licensee) and Documentation and all related intellectual property rights and other
proprietary rights are and shall remain the sole property of The Foundry and the Third Party
Licensors. Licensee shall not remove, or allow the removal of, any copyright or other proprietary
rights notice included in and on the Software or Documentation or take any other action that could
adversely affect the property rights of The Foundry or any Third Party Licensor. To the extent that
Licensee is authorized to make copies of the Software or Documentation under this EULA, Licensee
shall reproduce in and on all such copies any copyright and/or other proprietary rights notices
provided in and on the materials supplied by The Foundry hereunder. Nothing in the Agreement shall
be deemed to give Licensee any rights in the trademarks, service marks, patents, trade secrets,
confidential information, copyrights or other intellectual property rights of The Foundry or any Third
Party Licensor, and Licensee shall be strictly prohibited from using the name, trademarks or service
marks of The Foundry or any Third Party Licensor in Licensee's promotion or publicity without The
Foundry's prior express written approval.

Subject to clause 4.3, The Foundry undertakes (the “Undertaking”) to defend Licensee or at The
Foundry’s option settle any claim brought against Licensee alleging that Licensee’s possession or use
of the Software or Documentation in accordance with the Agreement infringes the intellectual
property rights of a third party in the same country as Licensee (“Claim”) and shall reimburse all
reasonable losses, damages, costs (including reasonable legal fees) and expenses incurred by or
awarded against Licensee in connection with any such Claim, provided that the Undertaking shall not
apply where the Claim in question is attributable to possession or use of the Software or
Documentation other than in accordance with the Agreement, or in combination with any hardware,
software or service not supplied or specified by The Foundry. The Undertaking is conditional on
Licensee giving written notice of the Claim to The Foundry as soon as reasonably possible,
cooperating in the defence of the Claim and not making any admission of liability or taking any step
prejudicial to the defence of the Claim. If any Claim is made, or in The Foundry's reasonable opinion
is likely to be made, against Licensee, The Foundry may at its sole option and expense (a) procure for
Licensee the right to continue using the Software, (b) modify the Software so that it ceases to be
infringing, (c) replace the Software with non-infringing software, or (d) terminate the Agreement
immediately by notice in writing to Licensee and refund the License Fee (less a reasonable sum in
respect of Licensee's use of the Software to the date of termination) on return of the Software and all
copies by Licensee. The Undertaking constitutes Licensee's exclusive remedy and The Foundry's only
liability in respect of any Claim.
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7. LICENSE FEE

7.1 Licensee acknowledges that (subject to clause 7.2) the rights granted to Licensee under this EULA
are conditional on Licensee's payment in full of the license fee payable in connection with the
Agreement or, as the case may be, payable to The Foundry’s reseller (the "License Fee").

7.2 In the cases of Non-Commercial NUKE, Trial Licenses and Free Licenses, for the avoidance of
doubt, the fact that no License Fee may be payable shall not be construed as a waiver by The Foundry
of any right or remedy available to it in relation to any breach by Licensee of this EULA or the
Agreement, or of any other right or remedy arising under applicable law, all of which are expressly
reserved.

8. UPGRADES/ENHANCEMENTS

If the Licensee has paid an annually renewable fee for access to support, upgrades and updates for
the Software ("Annual Upgrade and Support Programme"), this Agreement is subject to the terms
and conditions for the Annual Upgrade and Support Programme available on The Foundry's website.
The Foundry may from time to time and at its sole discretion vary the terms and conditions of the
Annual Upgrade and Support Programme. The Annual Upgrade and Support Programme is not
available for all Software license types and variations.

9. TAXES AND DUTIES

Licensee agrees to pay, and indemnify The Foundry from claims for, any local, state or national tax
(exclusive of taxes based on net income), duty, tariff or other impost related to or arising from the
transaction contemplated by the Agreement.

10. LIMITED WARRANTY

10.1 Subject to clause 10.3, The Foundry warrants that, for a period of ninety (90) days after Licensee
first downloads the Software (“Warranty Period”): (a) the Software will, when properly used on an
operating system for which it was designed, perform substantially in accordance with the functions
described in the Documentation; and (b) that the Documentation correctly describes the operation of
the Software in all material respects. If, within the Warranty Period, Licensee notifies The Foundry in
writing of any defect or fault in the Software as a result of which it fails to perform substantially in
accordance with the Documentation, The Foundry will, at its sole option, either repair or replace the
Software, provided that Licensee makes available all the information that may be necessary to
identify, recreate and remedy the defect or fault. This warranty will not apply to any defect or fault
caused by unauthorised use of or any amendment made to the Software by any person other than
The Foundry. If Licensee is a consumer, the warranty given in this clause is in addition to Licensee’s
legal rights in relation to any Software or Documentation that is faulty or not as described.
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10.2 The Foundry does not warrant that the Software or Documentation will meet Licensee's
requirements or that Licensee's use of the Software will be uninterrupted or error free.

10.3 If Licensee purchases a license of the Software that is of a fixed term duration, the Warranty
Period in clause 10.1 shall apply only to Licensee’s first purchase of such license and not to any
subsequent renewal(s) even if a renewal involves another download.

11. INDEMNIFICATION

Licensee agrees to indemnify, hold harmless and defend The Foundry, the Third Party Licensors and
The Foundry's and each Third Party Licensor’s respective affiliates, officers, directors, shareholders,
employees, authorized resellers, agents and other representatives from all claims, defence costs
(including, but not limited to, legal fees), judgments, settlements and other expenses arising from or
connected with any claim that any authorised or unauthorised modification of the Software or
Documentation by Licensee or any person connected with Licensee infringes the intellectual property
rights or other proprietary rights of any third party.

12. LIMITATION OF LIABILITY TO BUSINESS USERS

This clause applies where Licensee is a business user. Licensee acknowledges that the Software has
not been developed to meet its individual requirements, and that it is therefore Licensee’s
responsibility to ensure that the facilities and functions of the Software as described in the
Documentation meet such requirements. The Software and Documentation is supplied only for
Licensee’s internal use for its business, and not for any re-sale purposes or for the provision of the
Software (whether directly or indirectly) to third parties. The Foundry shall not under any
circumstances whatever be liable to Licensee, its affiliates, officers, directors, shareholders,
employees, agents or other representatives, whether in contract, tort (including negligence), breach of
statutory duty, or otherwise, arising under or in connection with the Agreement for loss of profits,
sales, business, or revenue, business interruption, loss of anticipated savings, loss or corruption of
data or information, loss of business opportunity, goodwill or reputation or any indirect or
consequential loss or damage. In respect of any other losses, The Foundry’s maximum aggregate
liability under or in connection with the Agreement whether in contract, tort (including negligence) or
otherwise, shall in all circumstances be limited to the greater of US$5,000 (five thousand USD) and a
sum equal to the License Fee. Nothing in the Agreement shall limit or exclude The Foundry’s liability
for death or personal injury resulting from our negligence, fraud or fraudulent misrepresentation or
for any other liability that cannot be excluded or limited by applicable law. This EULA sets out the full
extent of our obligations and liabilities in respect of the supply of the Software and Documentation.
Except as expressly stated in this EULA, there are no conditions, warranties, representations or other
terms, express or implied, that are binding on The Foundry. Any condition, warranty, representation
or other term concerning the supply of the Software and Documentation which might otherwise be
implied into, or incorporated in, the Agreement, whether by statute, common law or otherwise, is
excluded to the fullest extent permitted by law.
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13. LIMITATION OF LIABILITY TO CONSUMERS

This clause applies where Licensee is a consumer. Licensee acknowledges that the Software has not
been developed to meet Licensee’s individual requirements, and that it is therefore Licensee’s
responsibility to ensure that the facilities and functions of the Software as described in the
Documentation meet such requirements. The Software and Documentation are only supplied for
Licensee’s domestic and private use. Licensee agrees not to use the Software and Documentation for
any commercial, business or re-sale purposes, and The Foundry has no liability to Licensee for any
loss of profit, loss of business, business interruption, or loss of business opportunity. The Foundry is
only responsible for loss or damage suffered by Licensee that is a foreseeable result of The Foundry’s
breach of the Agreement or its negligence but The Foundry is not responsible for any loss or damage
that is not foreseeable. Loss or damage is foreseeable if they were an obvious consequence of a
breach or if they were contemplated by Licensee and The Foundry at the time of forming the
Agreement. Our maximum aggregate liability under or in connection with the Agreement, whether in
contract, tort (including negligence) or otherwise, shall in all circumstances be limited to a sum equal
to the greater of US$5,000 (five thousand USD) and a sum equal to the License Fee. Nothing in the
Agreement shall limit or exclude The Foundry’s liability for death or personal injury resulting from
our negligence, fraud or fraudulent misrepresentation or for any other liability that cannot be
excluded or limited by applicable law.

14. TERM; TERMINATION

14.1 The Agreement is effective upon Licensee's download of the Software, and the Agreement will
remain in effect until termination or expiry. Licensee may terminate the Agreement on written notice
to The Foundry if The Foundry is in breach of this Agreement and fails to cure the breach within 10
(ten) working days of receiving notice of such breach. If Licensee breaches the Agreement, The
Foundry may terminate the License immediately by notice to Licensee.

14.2 If the Agreement expires or is terminated, the License will cease immediately and Licensee will
immediately cease use of any Software and Documentation and either return to The Foundry all
copies of the Software and Documentation in Licensee's possession, custody or power or, if The
Foundry directs in writing, destroy all such copies. In the latter case, if requested by The Foundry,
Licensee shall provide The Foundry with a certificate confirming that such destruction has been
completed.

14.3 The Foundry reserves the right to terminate and/or suspend the License as it deems reasonable
in its sole discretion by notice to Licensee if it becomes aware that Licensee has failed to pay any sum
due either to The Foundry or to a reseller of The Foundry either in connection with the Agreement or
in connection with any other Software license to use any product(s) of The Foundry or the Licensee is
otherwise in breach of or fails to comply with any term of the Agreement.
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14.4 The Foundry may also terminate this EULA if Licensee becomes subject to bankruptcy
proceedings, becomes insolvent, or makes an arrangement with Licensee’s creditors. This EULA will
terminate automatically without further notice or action by The Foundry if Licensee goes into
liquidation.

15. CONFIDENTIALITY

Licensee agrees that the Software (including, for the avoidance of doubt, any Source Code that is
licensed to Licensee) and Documentation are proprietary to and the confidential information of The
Foundry or, as the case may be, the Third Party Licensors, and that all such information and any
related communications (collectively, "Confidential Information") are confidential and a
fundamental and important trade secret of The Foundry and/or the Third Party Licensors. If Licensee
is a business user, Licensee shall disclose Confidential Information only to Licensee's employees who
are working on an Authorized Project and have a "need-to-know" such Confidential Information, and
shall advise any recipients of Confidential Information that it is to be used only as expressly
authorized in the Agreement. Licensee shall not disclose Confidential Information or otherwise make
any Confidential Information available to any other of Licensee's employees or to any third parties
without the express written consent of The Foundry. Licensee agrees to segregate, to the extent it can
be reasonably done, the Confidential Information from the confidential information and materials of
others in order to prevent commingling. Licensee shall take reasonable security measures, which
measures shall be at least as great as the measures Licensee uses to keep Licensee's own confidential
information secure (but in any case using no less than a reasonable degree of care), to hold the
Software, Documentation and any other Confidential Information in strict confidence and safe
custody. The Foundry may request, in which case Licensee agrees to comply with, certain reasonable
security measures as part of the use of the Software and Documentation. This clause shall not apply
to any information that is in or comes into the public domain, or was in Licensee’s lawful possession
before receipt or which Licensee develops independently and without breach of this clause. Licensee
acknowledges that monetary damages may not be a sufficient remedy for unauthorized disclosure of
Confidential Information, and that The Foundry shall be entitled, without waiving any other rights or
remedies, to such injunctive or other equitable relief as may be deemed proper by a court of
competent jurisdiction.

16. INSPECTION AND INFORMATION

16.1 Unless Licensee is a consumer, Licensee shall advise The Foundry on demand of all locations
where the Software or Documentation is used or stored. Licensee shall permit The Foundry or its
authorized agents to audit all such locations during normal business hours and on reasonable
advance notice.

16.2 The Software may include mechanisms to collect limited information from Licensee’s computer
(s) and transmit it to The Foundry. Such information (the “Information”) may include details of
Licensee’s hardware, details of the operating system(s) in use on such hardware and the profile and
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extent of Licensee’s use of the different elements of the Software. The Foundry may use the
Information to (a) model the profiles of usage, hardware and operating systems in use collectively
across its customer base in order to focus development and support, (b) to provide targeted support
to individual customers, (c) to ensure that the usage of the Software by Licensee is in accordance with
the Agreement and does not exceed any user number or other limits on its use, and (d) to advise
Licensee about service issues such as available upgrades and maintenance expiry dates. To the extent
that any Information is confidential to Licensee it shall be treated as such by The Foundry when so
notified or identified by Licensee when the Information is first provided to The Foundry (whether
verbally or in written form). To the extent that any Information constitutes personal data for the
purposes of the Data Protection Act 1998 it shall be processed by The Foundry in accordance with
that Act and with The Foundry’s Privacy Policy (see http://www.thefoundry.co.uk/privacy/). Licensee
undertakes to make all of users of the Software aware of the uses which The Foundry will make of the
Information and of the terms of The Foundry’s Privacy Policy.

17. U.S. GOVERNMENT LICENSE RIGHTS

All Software, including all components thereof, and Documentation qualify as “commercial items,” as
that term is defined at Federal Acquisition Regulation (“FAR”) (48 C.F.R.) 2.101, consisting of
“commercial computer software” and “commercial computer software documentation” as such terms
are used in FAR 12.212. Consistent with FAR 12.212 and DoD FAR Supp. 227.7202-1 through 227.7202-
4, and notwithstanding any other FAR or other contractual clause to the contrary in any agreement
into which this Agreement may be incorporated, a government end user will acquire the Software and
Documentation with only those rights set forth in this Agreement. Use of either the Software or
Documentation or both constitutes agreement by the government that all Software and
Documentation are “commercial computer software” and “commercial computer software
documentation,” and constitutes acceptance of the rights and restrictions herein. The Software is the
subject of the following notices:

* Copyright © 2001 - 2017 The Foundry Visionmongers Limited. All Rights Reserved.

* Unpublished-rights reserved under the Copyright Laws of the United Kingdom.

18. SURVIVAL.

Clause 6 and clauses 9 to 20 inclusive shall survive any termination or expiration of the Agreement.

19. IMPORT/EXPORT CONTROLS

To the extent that any Software made available under the Agreement is subject to restrictions upon
export and/or re-export from the United States, Licensee agrees to comply with, and not act or fail to
act in any way that would violate, applicable international, national, state, regional or local laws and
regulations, including, without limitation, the U.S. Export Administration Act and the Export
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Administration Regulations, the regulations of the U.S. Department of Treasury Office of Foreign
Assets Control, and the International Traffic in Arms regulations (collectively, “U.S. Export Laws”), and
the United States Foreign Corrupt Practices Act, as those laws may be amended or otherwise
modified from time to time, and neither The Foundry nor Licensee shall be required under the
Agreement to act or fail to act in any way which it believes in good faith will violate any such laws or
regulations. Without limiting the foregoing, Licensee agrees that it will not export or re-export,
directly or indirectly, The Foundry’s Software or related products and services, or any commodity,
technology, technical data, software or service that incorporates, contains or is a direct product of
The Foundry’s Software, products and/or services, (i) in violation of the U.S. Export Laws; (ii) to any
country for which an export license or other governmental approval is required at the time of export,
without first obtaining all necessary export licenses or other approvals; (iii) to any country, or national
or resident of a country, to which trade is embargoed by the United States; (iv) to any person or firm
on any government agency’s list of blocked, denied or barred persons or entities, including but not
limited to the U.S. Department of Commerce’s Denied Persons List and Entities List,  and the U.S
Treasury Department’s Specially Designated Nationals List; or (v) for use in any nuclear, chemical or
biological weapons, or missile technology end-use unless authorized by the U.S. Government by
regulation or specific license.

20. MISCELLANEOUS

Unless Licensee is a consumer, the Agreement is the exclusive agreement between the parties
concerning its subject matter and supersedes any and all prior oral or written agreements,
negotiations, or other dealings between the parties concerning such subject matter. Licensee
acknowledges that Licensee has not relied upon any representation or collateral warranty not
recorded in the Agreement inducing it to enter into the Agreement. The Agreement may be modified
only in writing, by The Foundry, at any time. The failure of either party to enforce any rights granted
under the Agreement or to take action against the other party in the event of any such breach shall
not be deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions
in the event of future breaches. The Agreement and any dispute or claim arising out of or in
connection with it or its subject matter or formation (including, unless Licensee is a consumer, non-
contractual disputes or claims) shall be governed by, and construed in accordance with English Law
and the parties irrevocably submit to the non-exclusive jurisdiction of the English Courts, subject to
any right that a consumer may have to bring proceedings or to have proceedings brought against
them in a different jurisdiction.

If The Foundry fails to insist that Licensee performs any obligation under the Agreement, or delays in
doing so, that will not mean that The Foundry has waived its rights.

Unless Licensee is a consumer, Licensee agrees that The Foundry may refer to Licensee as a client or
a user of the Software, may display its logo(s) for this purpose and may publish quotations and
testimonials from Licensee, its directors, partners, officers or employees. The Foundry agrees to
promptly cease any such use on Licensee’s written request.
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The Foundry and Licensee intend that each Third Party Licensor may enforce against Licensee under
the Contracts (Rights of Third Parties) Act 1999 (the “Act") any obligation owed by Licensee to The
Foundry under this EULA that is capable of application to any proprietary or other right of that Third
Party Licensor in or in relation to the Software. The Foundry and Licensee reserve the right under
section 2(3)(a) of the Act to rescind, terminate or vary this EULA without the consent of any Third Party
Licensor.

21. COMPLAINTS & ONLINE DISPUTE RESOLUTION PLATFORM

We hope that you are satisfied with any Software purchase made or service received from The
Foundry, but if you have a complaint, in the first instance, please contact us on
info@thefoundry.co.uk or through our Support Portal: https://supportportal.thefoundry.co.uk/hc/en-
us (for technical support and bug reports), or you can request a call back from the Sales team here:
https://www.thefoundry.co.uk/about-us/contact-us/. We will do our best to resolve the issue but if you
are still not happy with our response, you may seek to resolve it using the Online Dispute Resolution
Platform at www.ec.europa.eu/consumers/odr/.

Last updated March 30, 2016.

Copyright © 2017 The Foundry Visionmongers Limited.

All Rights Reserved. Do not duplicate.
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